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APT stands for "AstroPhotography Tool" and it is like Swiss army knife for your astro imaging sessions. No matter what are
imaging with - Canon EOS, Nikon, CCD or CMOS astro camera, APT has the right tool for planning, collimating, aligning,
focusing, framing, controlling, imaging, synchronizing, scheduling, meridian flipping, analyzing and monitoring. All its features
are packed in an easy and comfortable to use interface with design that had no alternative back in 2009 when it was released.
Since then APT is constantly being improved and refined by the real experience of many astro photographers from all over the
world including one of the APT authors. Currently APT works on MS Windows XP, Vista, 7, 8, 8.1 and 10.

APT has time unlimited "demo" version with almost all features of the full one. In fact this "demo" is one of the most loaded
astro applications available for free.
If you like APT you can support the future development with a small fee!

About this document

The approach to this document is minimalistic. A description of all features in APT and the related information in the short and
easy to use form. The two main sections are Application Interface and APT Features. In the first one you can find explanation
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for everything you see in APT. The second one is a kind of index of the main APT functions. There are few more sections that
are focused on important areas like Dithering, PointCraft and SessionCraft.

This guide is designed to use the full power of the hyper-links and to give possibility to track easily all the linked information
without text duplication. In the same time is used common naming of the sections in order to make easier for reading if one
decide to print it (PDF version here). The User's Guide is not book in its classic form and there is no proper or right way to read
it :) You can read it page-by-page or in random order. Every topic contains a focused information and links to all related topics.

Special tanks to Dennys Turcotte for his work to make this document better and more clear to read!

Support

APT has a dedicated forum - www.aptforum.com. It is a place where you can ask or search specific questions. Also it is
a growing source of information related to astro-photography in all of its aspects - imaging, automation, processing and etc.
It is the preferred way to discuss everything around APT because your questions, answers, suggestions or ideas can be in
help to others. The registration is more than easy!

There is also a group in Facebook - APT Group. It is mainly focused on sharing news and images taken with APT. You can
find help there too, but because of the Facebook nature it is harder to find previously asked questions...

If you prefer or need more private communication then you can use support@astroplace.net.

All feedback, suggestions and ideas are highly appreciated!
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Installation

Open the ZIP archive downloaded from APT site and execute the contained executable file. Follow the simple installation
wizard and you are ready to start using APT with a Canon EOS camera or in most cases with your CCD/CMOS camera (you
may need a driver and/or few more components).

If you are using more hardware or want to use some of the special APT features you may need some additional components.
Take a look of the list below and make sure that you have installed and tried indoors everything needed in order to save
precious time under the sky!

* If you are using ASCOM compatible CCD/CMOS camera, Mount, Filter Wheel, Focuser, Rotator you have to install
also the ASCOM platform and the corresponding ASCOM and Native drivers for your devices.

* If you are using INDIGO / INDI compatible CCD/CMOS camera, Mount, Filter Wheel, Focuser, you have to
configure access to your INDIGO / INDI server.

« If you use Canon EOS camera with Digic 2 processor you will need a Bulb (Serial) cable and possibly a driver.

« If you use older Nikon camera you will need a Bulb (Serial) cable and possibly a driver.

* If you are using QSI camera install the latest camera drivers from QS site.

* If you are using SBIG camera install the latest camera drivers from SBIG site.

* If you are using Altair Astro camera install the latest camera drivers from Altair Astro site.

* If you want to use guiding and dithering, refer to the section Guiding and Dithering and download the needed
applications like PHD, MetaGuide, MGEN drivers and etc.

« If you want to use plate-solving, refer to the section PointCraft and Plate-Solving and download PS2 and/or ASPS
in combination with the needed indexing files.

« If you want to use an integration with planetarium application, refer to the section Planetarium and download the
needed applications and their components like plug-ins and catalogs.

« If you want to use AstroTortilla download it with the needed indexing files.

On Windows 8 and newer depending on the installation in some cases there is need to enable .NET 2.0. It is included
in .NET 3.5 and the steps to follow are described in this article in the Microsoft site:

https://docs.microsoft.com/en-us/dotnet/framework/install/dotnet-35-windows-10

Starting APT (DSLR or CCD/CMOS)

APT has two modes of operation depending on the camera you are using - DSLR (Canon EOS, Nikon) or CCD/CMOS
(ASCOM / INDIGO/ INDI compatible, QSI, SBIG or Altair Astro). Here are the instructions how to make the initial connection
to your camera depending on its type.

In rare cases there is need to start APT using the "Run As Administrator" option in order to resolve camera connection problems.
When it is started this way, you have to use the same option for PHD, Planetarium and the other applications that APT can
communicate with.

If Shift key is pressed during APT start, the automatic connections to devices like camera, mount and etc. will not be made.

1. Starting with Canon EOS camera:

On the first start APT starts in EOS mode. If you use EOS model with processor Digic 3, 4, 5, 5+ you can simply
connect your camera to the computer, turn it on and click on Connect button in Camera Tab. If you use Digic 2, 6, 7, 8
or 4+ camera, hold the Shift key and click on Connect button in Camera Tab to open the Camera Selection dialog box
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and select the corresponding Digic generation. Click on OK, connect your camera and turn on your camera, then click
again on Connect button. APT will remember your selection, so next time you can simply click on Connect button. If
you use more than one imaging camera at the same time see Multi-Camera Operation section.

Generation: Digic 3, 4, 5, 5+

Information about the Canon EOS models including the built-in processor can be found in the Canon EOS Matrix
page on the APT site.

Note: For EOS 1300D (T6, X80) select the option Digic 6, 7, 8, 4+!

2. Starting with Nikon camera:

Connect and turn on your camera. After that hold the Shift key and click on Connect button in Camera Tab to open the
Camera Selection dialog box. Select the Nikon Camera option, then select model from the Models list box and click
OK. APT will remember your selection, so next time you can simply click on Connect button. If you use more than one
imaging camera at the same time see Multi-Camera Operation section.

D5300

Information about the Nikon models can be found in the Nikon Matrix page on the APT site.

Note: Make sure auto-focusing is set the MF (manual focus) in the camera menu.
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3. Starting with ASCOM compatible CCD/CMOS camera:

Connect and turn on your camera. After that hold the Shift key and click on Connect button in Camera Tab to open
the Camera Selection dialog box. From the dropdown list named CCD select the option "ASCOM Camera". Click on
OK and you will see the standard ASCOM dialog box for selecting the driver for your camera. APT will remember your
selection, so next time you can simply click on Connect button in order to use the previously selected driver. If you
want to change the driver or the camera type use again Shift+Connect. If you use more than one imaging camera at
the same time see Multi-Camera Operation section.

If your ASCOM compatible camera is color and you want to see color preview of the images, enable "Color FITS
Preview" and select the corresponding Bayer matrix configuration. You can enable/disable this feature later from

CCD Settings tab.
Note: Both, the ASCOM platform and the camera ASCOM dive, have to be installed!

Note: If you have filter wheel and want to define gain value per filter, describe the used filters in Filter Wheel
settings tab.

4. Starting with QSI CCD camera:

Connect and turn on your camera. After that hold the Shift key and click on Connect button in Camera Tab to open
the Camera Selection dialog box. From the dropdown list named CCD select the option "QSI Camera". Leave the
"Serial #" blank unless you want to use more than one QS| camera at the same time. Click on OK. APT will remember
your selection so, next time you can simply click on Connect button. If your camera has built-in filter wheel it will be
connected when the camera connection is made. If you use more than one imaging camera at the same time see
Multi-Camera Operation section.




If your QSI camera is color and you want to see color preview of the images, enable "Color FITS Preview" and
select the corresponding Bayer matrix configuration. You can enable/disable this feature later from CCD Settings
tab.

5. Starting with SBIG CCD camera:

Connect and turn on your camera. After that hold the Shift key and click on Connect button in Camera Tab to open the
Camera Selection dialog box. From the dropdown list named CCD select the option "SBIG Camera". From the "Port"
list box select the port where your camera is connected. If you use SBIG filter wheel then select the model form the
"Wheel" list box. Click on OK. APT will remember your selection, so next time you can simply click on Connect button.
If you use more than one imaging camera at the same time see Multi-Camera Operation section.

If you have filter wheel, make sure to describe the used filters in Filter Wheel settings tab.

If your SBIG camera is color and you want to see color preview of the images, enable "Color FITS Preview" and
select the corresponding Bayer matrix configuration. You can enable/disable this feature later from CCD Settings
tab.

6. Starting with Altair Astro CCD camera:



Connect and turn on your camera. After that hold the Shift key and click on Connect button in Camera Tab to open
the Camera Selection dialog box. From the dropdown list named CCD select the option "Altair Astro Camera". If you
use more than one imaging camera at the same time see Multi-Camera Operation section.

Note: If you have filter wheel and want to define gain value per filter, describe the used filters in Filter Wheel
settings tab.

If your Altair Astro camera is color and you want to see color preview of the images, enable "Color FITS Preview"
and select the corresponding Bayer matrix configuration. You can enable/disable this feature later from CCD

Settings tab.

7. Starting with INDIGO/ INDI CCD camera:

Connect the camera to the INDIGO/ INDI device and turn it on. Make sure that you have connection to the INDIGO /
INDI server. After that hold the Shift key and click on Connect button in Camera Tab to open the Camera Selection
dialog box. From the dropdown list named CCD select the option "INDIGO/ INDI Camera". Click on OK and you will
see a dialog box for selecting the driver for your camera. APT will remember your selection, so next time you can
simply click on Connect button in order to use the previously selected driver. If you want to change the driver or the
camera type use again Shift+Connect. If you use more than one imaging camera at the same time see Multi-Camera
Operation section.




Note: If you have filter wheel and want to define gain value per filter, describe the used filters in Filter Wheel
settings tab.

If your INDIGO/ INDI camera is color and you want to see color preview of the images, enable "Color FITS Preview"
and select the corresponding Bayer matrix configuration. You can enable/disable this feature later from CCD

Settings tab.

8. Starting with ZWO CCD camera:

Connect and turn on your camera. After that hold the Shift key and click on Connect button in Camera Tab to open the
Camera Selection dialog box. From the dropdown list named CCD select the option "ZWO Camera". If you use more
than one imaging camera at the same time see Multi-Camera Operation section.

Note: If you have filter wheel and want to define gain value per filter, describe the used filters in Filter Wheel
settings tab.

If your ZWO camera is color and you want to see color preview of the images, enable "Color FITS Preview" and
select the corresponding Bayer matrix configuration. You can enable/disable this feature later from CCD Settings
tab.

Application Interface

In this section are described all the elements of APT the user interface. You can use it to find information for every element
that you are seeing on the screen.

Here are some general notes.

* The color (skin) of the interface can be changed from Main Settings tab.

* The buttons that have small plus sign "+" in the upper right corner (like - ) has additional functionality when
Shift key is pressed.

* There is one special control named Ringy Thingy. It helps to change/enter numeric data only with the mouse or
touch pad. Here as it looks in the Tools tab. It is included in many places in APT and can be connected to multiple
edit boxes. Once an edit box gets the input focus (by clicking on it) if Ringy Thingy is connected a small star will blink
once in its center to show you that connection. To change the edit box value click and hold on the Ringy Thingy, move
away from the center - farther you move more accurate the changes will be, then start to move the mouse in circle.
Clockwise direction increases the value, counter clockwise direction decreases the value.



) Camera

|4.54
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What makes Ringy Thingy smart and unique is not the design (its idea is not totally new) but the way it handles the
different value types. When you are changing ISO it will work with the ISO values. Exposures will give the expected
values for camera exposure. It can work with whole numbers and with decimal numbers. If the number is decimal
you can click in left or right of the decimal point and change that part of the number using the Ringy Thing. In the
image below object size can have up to 4 sections controlled just with mouse - the left and right of the X value and
left and right of Y value. If your targets are in the Object Browser it is possible to drive the whole imaging session
without touching the keyboard!

Here is an animation how it works (visible only in the CHM help file and in the on-line help):

If you are reading the PDF version of this document you can see the animation at:
https://ideiki.com/RingyThingy.GIF

Or by scanning the code with your mobile phone:

 Another interesting feature is named Keys Thingy. It also designed to help to change/enter numeric data with the
mouse, touch pad but also for use on tablets. It gives big buttons that allow entering the correct data for selected text
box. To open it just double click on the edit box you want to edit. Depending on the data type you are entering Keys
Thingy will provide a different set of available keys.
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Main Screen

This is the main screen of APT. It is divided in several areas - Status Panel, LiveView / Image Preview Panel, Log Panel and
control tabs (Camera, Gear, Tools, Image Browser).

There are some differences in the appearance in DSLR and CCD/CMOS modes in order to cover the specific properties and
features of the Canon/Nikon and CCD/CMOS cameras. These differences are described in details in the following sections
Camera Battery / CCD Power, Storage Card space / CCD Temperature, Plan Editor, Histogram Panel and Camera Tab. All
other features are common for both DSLR and CCD/CMOS modes.

Tooltips Help Mininfi¥edow / Full Screen

Status Panel o LiveView / Image Preview Panel Target - Cross/Object Size Shoot
: @ @ O O O
NG 2 Live View On/Off e Zoom + n Zoom - a o a N T ), y,
Current Status Monitor 0_ - AN A \ / /

Laptop Battery
or AC Power

Camera Battery
or CCD Power

Storage Card space a T~

or CCD Temperature
Current Filter a e
Guiding State a’

Sky Quality —
and Calculator

Moon Phase a, /,/
Darkness Clock a’ ’,)/"//
Meridian Flip Clock a/’
Log Panel e —

Img - Image Browser Tab
Disconnect

- | Plan : No selected plant = Tools Tab
Gear Tab

Camera Tab

USB Manitor a

o Status Panel

E 171m W

This panel contains various status information.

Note: When the laptop screen is with 4:3 aspect ratio (not "wide-screen") the Status panel is placed between the
"LiveView / Image Preview" and "Log" panels.

o LiveView / Image Preview Panel
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In this panel you can see the image that comes from LiveView, the last taken image or a loaded image using the
Image Browser.

In the top left corner there is a small rectangle which is visible for every even image displayed and is hidden for the
odd images. This makes easier to see when the picture on the screen is changed when you are using LiveView or
you are loading similar images when small differences like such taken without dithering.

Log Panel
-

In this panel is displayed logging information for the current session since the APT start. This includes details about
the camera like shutter count, imaging plan execution progress, errors, warnings and etc.

o Camera Tab

Makes active the Camera tab. There are two layouts of the Camera tab depending on the selected mode - DSLR
mode or CCD/CMOS mode. This tab gives access to the camera control and image acquisition features. See Camera
Tab (DSLR mode) or Camera Tab (CCD/CMOS mode) sections for details.

When there is asterisk symbol (*) that means that there is active connection to a camera.

When multiple cameras are used at the same time the tab name changes to "Camera [n]" where "n" is the APT
instance number. See Multi-Camera Operation section for more information.

° Gear Tab

Makes active the Gear tab. It gives access to features for Telescope, Focuser, Filter Wheel and Rotator control as
well as to PointCraft. See Gear tab section for details.

When there is asterisk symbol (*) that means that there is active connection to one or more devices like Telescope,
Focuser, Filter Wheel and Rotator.

o Tools Tab

Makes active the Tools tab. It gives access to various additional features including the Settings dialog box. See Tools
tab section for details.
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o Img - Image Browser Tab

Makes active the Img tab - this is the images browser of APT. See Img tab section for details.

o Live View On/Off

Turns On/Off the LiveView feature. See the LiveView section for details.

o Zoom +

Available only in DSLR mode. Increase the LiveView zoom level to 5x (or 10x of it is clicked two times). For most
EOS cameras Zoom x5 is very close to the representation "1:1" - "one pixel from the image, represents one sensor
pixel". It is a valuable feature when planetary astro-photography.

The CCD/CMOS cameras have no hardware supported Zoom. In order to make a software zoom you can use Tools-
>Magnifier feature.

o Zoom -

Available only in EOS mode. Decrease the LiveView zoom level to 5x (or disable zoom if it is clicked two times).

o Target - Cross/Object Size

It is a tri-modes button. The modes toggle in the flow OFF -> Crosshair mode -> Object Scale mode -> OFF. These
modes use the preview area and work without camera connection, during LiveView or over a previously taken image.
Crosshair mode is designed to help in alignment tasks like: Drift Alignment, GoTo Alignment, Precise mode checks
for Meade mounts and everything else that you can think of.

Crosshair Mode:
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Hold the Shift + Left Mouse Button and move mouse to change the place of the cross center.
Hold the Control + Left Mouse Button and move the mouse horizontally to rotate the cross.
Shift or Control + Double Click with the left mouse button will restore the initial centered cross position.

See the Crosshair section for more screenshots.

“Object scale mode” will show oval-shaped outline of defined object in exact scale for your camera and telescope/
lens. See Object Calculator section.

Object scale mode:

@ Shoot

Takes one image using the exposure parameters set in Camera tab. If Image destination is set to PC, the stored file
will have prefix "Single_". It is useful to take test images when you are framing an object or determining the optimal
exposure.
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For actual imaging use the Plan Editor to create an imaging plan.

o Sounds

Enables/Disables the sounds

0 Tooltips

Enables/Disables the Tooltips (balloon) help. When enabled you can point a button, list, label and etc. to get a short
help.

Sample:

@ Help

Opens this User's Guide.

M|n|m|ze

Minimize the main APT windows and if it is configured shows Minimized mode.

o Window / Full Screen

Toggles between "Full Screen" and "Window" modes for the main APT window. "Full Screen" mode covers the whole
screen and doesn't allow window resizing.

o Close
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Closes APT.

o Current Status Monitor

Shows the current status.

NC

C

D 0000”
A 0000~
E 0000”
P 0000”
BUSY
PAUSE
DITHER
SYNC
DARV
Scheduled

No camera connection

Camera connected, but it is in idle mode, no plan in progress

In Delayed plan execution (See Advanced Settings)

In Anti-vibration pause and the count of the seconds passed

In Exposure and the count of the seconds passed

In "after exposure" Pause and the count of the seconds passed

The camera and/or APT are busy at the moment

The plan is paused

Dithering in progress (see Dithering and Guiding)

Multi-cameras synchronization is in progress (see Multi-camera Dithering / Synchronizing)
DARV in progress

Plan execution is scheduled (See DSLR Start or CCD/CMQOS Start buttons in Camera Tab)

Once a plan is started the Status monitor becomes like :

On first line is the number of the image that is in progress, the total count of the images that will be taken, the current
status and the seconds since the start of the current image, pause and etc.

On the second line is the estimated remaining time for the plan execution followed by the expected time for the plan
completion. APT monitors the transfer and saving times, so these values can be revaluated during the plan execution.

Laptop Battery
0 or AC Power

Show the laptop battery percent and the remaining time to batter depletion (when not charging). It can be configured
to flash when critical level is reached. See Advanced Settings.

Camera Battery
e or CCD Power

In DSLR mode shows the remaining camera battery power. It can be configured to flash when critical level is reached.
See Advanced Settings.

In the CCD/CMOS mode shows the cooling power load.

Storage Card space
e or CCD Temperature
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In DSLR mode shows the remaining free space on the camera storage card. It can be configured to flash when critical
level is reached. See Advanced Settings.

In CCD/CMOS mode shows the current temperature of the camera sensor.

@ Current Filter

Shows the name of the current filter. See Gear tab.

@ Guiding State

Shows the status of the guider. See Dithering and Guiding.

NC — No connection to guiding program or device.
C — Connected and distance to the star is 0.
0.00 - distance to the guiding star.

You can use Graphs to see the changes in the distance to the guiding star during the imaging sessions.

Sky Quality
@ and Calculator

Shows the current sky quality value. Sky quality can be tracked by devices like SQM (Sky Quality Meters) or evaluated
by the imager and manually entered. In order to see this section you have to enable it from Temperature & Sky
settings tab.

Double click on this section or use the Alt+Q shortcut to open the Sky Quality calculator where you can convert value
between MPSAS (magnitude per square arc-second) and NELM (naked eye limiting magnitude). Also if you have
selected manual entry in the settings you can enter the measured sky quality value here.

21.28
6.27

Sky Quality value can be used as part of the image file names and to be stored in the FITS keys when CCD/CMOS
camera is used. See Main Settings Tab.
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@ Moon Phase

Shows the current Moon Phase

Darkness Clock

The Darkness Clock shows various information in a compact form - Sun set/rise, Moon set/rise and Civil, Nautical,
Astronomical twilights and the full darkness. See Darkness Clock

Double click on this section will open the Deep Sky Darkness calculator where can see data for various events, to

see how much imaging time you have for a given night or to search for night with needed dark hours. See Deep
Sky Darkness calculator.

In order for Darkness Clock and Deep Sky Darkness calculator to make accurate calculations you have to enter your
site geographic location in the Location settings tab.

@ Meridian Flip Clock

The Meridian Flip Clock show information related to Meridian. How much time there is till flip, or passed after the flip
and the exact flip time. See Meridian Flip Clock.

This feature needs an active connection to telescope - See Gear Tab. It can be hidden from Main Settings Tab.

a USB Monitor

Opens the USB Monitor Aid to show the connected USB devices and the logged events of connection/
disconnection.

Camera Tab

In order to provide better control and a more clean user interface, the Camera tab has different look in DSLR and CCD/CMOS
modes.

Camera Tab (DSLR mode)

This is how Camera Tab looks like when APT is in DSLR mode (when connected is Canon EOS or Nikon camera). If you want
to change the camera type use Shift + Click on Connect button to open the Select Camera Type dialog box.
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Connect/Disconnect o

"

o

Imaging Plans list e_______
Current plan e

. Plan : No s

“Exp: Bulb

Lens Aperture m'"'__ =
Camera info @'

o Connect/Disconnect

Connect or disconnects the camera. Shift + Click on Connect button opens the Select Camera Type dialog box where
you can change the default camera type, to change the Digic generation of Canon camera or to change the Nikon

camera model. APT uses different type of communications with the camera depending on the Canon Digic generation
or Nikon model, so make sure that you are using the right one.

Information about the Canon EOS models including the built-in processor can be found in the Canon EOS Matrix
page on the APT site.

Information about the Nikon models can be found in the Nikon Matrix page on the APT site.

o Start / Pause / Resume

Starts execution of the selected imaging plan. Once it is started the button is replaced with Pause button that will

pause the plan after the current exposure is finished. If a plan is paused it can be resumed by pressing the Resume
button that will become visible.

Shift + Click on Start button opens the Start options dialog box.
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Imaging Plans list

00:00:00

You can loop a plan to be executed several times (or unlimited times if you enter 0 in "# of execution) or to schedule
the plan execution start at a defined time or event.

The following scheduling options works in combination with Darkness Clock:
- Deep Sky Darkness (DSD) - the moment when full darkness starts
- Astro Night - the moment when astro twilight finished
- Night - the moment when Sun sets

If the starting event has already passed for the current night you will be asked if you want to start the plan immediately
or you want to wait for the event in the next night.

If you combine Loop and one of the options DSD, Astro Night or Night, APT will stop the next iteration of the plan if
the scheduling event is no longer valid - for example no more full darkness.

If you set Loop to 0 and one of the options DSD, Astro Night or Night, APT will pause the next iteration of the plan till
the scheduling event becomes valid again on the next night. It is useful for unattended operation for all sky cameras or
meteor hunting. Scripts and Commands feature can be used for advanced functionality like remote images uploading.

Tips&Tricks. You can turn off the camera display before plan execution. This will save some battery energy that can
be used for more exposures and more importantly will lead to lower noise in the images!

See Plan Editor section.

Stop

Stops the execution of the running plan.

The running exposure is stored with prefix "Incomplete '

List of the saved imaging plans. There are different type of plans that has specific features. See Plan Editor for
information about the plans, how to create and manage them.

When a plan is selected the expected execution duration will be printed in the Log panel. If the plan is from Light type
also will be calculated the actual total light exposure.
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Plan Editor

Opens the Plan Editor. Double click in the plan table does the same.

a Rlngy Thingy

Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

Current plan

Shows the lines of the selected imaging plan.

The columns are:
* Order
* Exposure duration
+ISO
 Pause duration
* Count of the exposures
* Quality
* Lens Aperture (visible when A button is checked)
» Filter (visible when F button is checked)

During the execution the current line is selected and under it there is a small progress bar to show the line execution
percentage.

B
B

Doubile click in the table opens the Plan Editor for the selected plan.
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o AV and Filter columns control

A button shows/hides the lens aperture (AV) column in the current plan list.
F button shows/hides the filter name (F) column in the current plan list.

o Object Name

Defines a name part that to be added to the image file names stored on PC. For example if you enter “M11” the
image name stored will be:*M11_ IMG_5034.JPG”. In order to use this feature select "Object Name" as "Name Part"

in Main Settings Tab. In Advanced Settings Tab you can define if APT have to remember the entered name between
the sessions.

The name is automatically populated when an object is selected from Object Browser.

m Exposure

Defines the exposure to be used when Shoot button is used. It doesn't affect the settings of the selected imaging
plan. If Bulb is selected then duration should be entered in "Bulb exposure duration".

The Digic 2 cameras need additional cable in order to make Bulb exposures. For more information see the section
EQOS Shutter Cables and “Long exposure control”.

o Bulb exposure duration

Defines how long the bulb exposure to be when "Bulb” is selected from "Exp." list and when Shoot button is used.
12 Iy
Defines the ISO to be used when Shoot button is used. It doesn't affect the settings of the selected imaging plan.

o Quality

Defines the image quality to be used when Shoot button is used. It doesn't affect the settings of the selected imaging

plan.

R+L Raw + Large JPG
L Large JPG

M Medium JPG

S Small JPG

Raw Raw only

R1L Raw1 + Large JPG
R2L Raw2 + Large JPG
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S1 Small 1 JPG
S2 Small 2 JPG

The options in italic are not supported by all Canon EOS models and are not available in Nikon mode!

o Lens Aperture

Defines the lens aperture to be used if there is a lens mounted on the camera.

@ Image Preview

Image Preview : On (Fit)

Controls the preview of the last taken or loaded image in the "LiveView / Image Preview" panel.

On (Fit) Shows the image in the preview area after every exposure. The image will be scaled
to fit in the area

Off No preview

On (1:1) Shows un-scaled part from the loaded image that fits in the preview area

On (1:1) Scroll  Shows scrolling buttons to select the image area that you want to see in mode “On
(1:1)". Click on the central rectangle to view the center of the image

To scroll the image smoothly in “On (1:1)” or “On (1:1) Scroll” modes, hold the Shift key and drag with the mouse.
You can also use the right mouse button to drag the image.

To switch quickly between “On (Fit)” and “On (1:1)” modes double click on the image. This allows to center the part
of the image without scrolling.

If you double click on a scroll arrow, position will be moved to the corresponding border.

o Image Destination

Defines where to store the images. The supported options are:

Camera Store the images only on the camera memory card

Camera + PC Store the images on the camera memory card and on the PC disk in folder set in
Main Settings tab

PC Store the images only on the PC disk in folder set in Main Settings tab

It is recommended to use the PC or Camera+PC options because they provide flexible naming and organizing of the
image files - useful during the processing and archiving.

Camera option is not supported for Nikon at this stage.

o Anti Vibration Pause

Not supported for Nikon at this stage.
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Long Exposure Control

Anti Vibration Pause is used within exposures plan or bulb Shoot exposures. It defines how many seconds to wait after
the camera mirror is flipped before starting the exposure. This is a valuable option for short exposures when mirror
flipping is causing vibrations into your setup. During long exposures the size of the bright stars became much bigger
than the artifacts from mirror move, so in such cases you can skip the use of anti-vibration pause. Recommended
is to experiment to find how long it has to be. Keep in mind that in some positions of your telescope the vibrations
can be bigger/longer than in others.

Here are the requirements for making mirror lock with the different models:

Processor Mirror Lock C.Fn. Mirror Lock needs shutter cable
Digic 2 Manual Yes

Digic 3 Automatic Yes or simulation

Digic 4 and later Automatic No

If the camera has Digic 3 processor and “Long exposure control” to “Virtual”’, APT will simulate Mirror Lock using
LiveView. Note that simulated “Mirror lockup” leads to amp glow when is used in long exposures!

The Digic 2 and Digic 3 cameras need an additional PC operated shutter cable in order to make mirror lockup. Some
options for such cable are listed in the section EOS Shutter Cables.

For Digic 2 cameras you have to enable/disable manually the "Mirror Lock C.Fn." function from the camera menu.
Enable it with Anti-Vibration Pause is greater than Os. Disable it when Anti-Vibration Pause is 0s.

Note that in order to manage automatically the "Mirror Lock C.Fn." function from the camera menu, you have to enable
the option "Mirror Lock Automation" from Main Settings tab.

Long Exp. Control : Virtual w

Defines how the camera shutter is controlled. The list contains the options:

Virtual Commands the camera only through the USB cable connected to your camera.
NOTE: This feature works only for Canon EOS models after 2006 and
Nikon models after 2012.

COM port Uses the selected COM port to control the shutter and the mirror lockup. Still
needs the USB cable.

DSUSB / DSUSB2 Uses the attached DSUSB or DSUSB2 controller to control the shutter and the
mirror lockup. Still needs the USB cable.

Biula Audio Trigger  |Use the audio output connector and special cable to control the shutter and

the mirror lockup. Still needs the USB cable.

For more information about the shutter cables see the section Canon/Nikon Shutter Cables.

Tips & Tricks. If you connect the camera and shutter cable to the same USB ports you will have same COM port
number between the sessions.

White Balance

White Balance: Auto

Defines the white balance to be used (for preview or JPG). Note that this setting has no effect on the data saved in
the RAW file, so it is not critical what you will select here.
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m Camera info

Shows information about the connected camera.

For Canon:

In the first line is the camera model. In the second is the Digic processor generation and the current setting
in the camera menu for the Mirror Lock custom function.

For Digic 2 cameras you have to enable/disable manually the "Mirror Lock C.Fn." function from the camera
menu.

For Nikon:
Displays the model of the connected camera.

Camera Tab (CCD/CMOS mode)

This is how Camera Tab looks like when APT is in CCD/CMOS mode (when connected is ASCOM/INDIGO / INDI, QSl or SBIG
camera). If you want to change the camera type use Shift + Click on Connect button to open the Select Camera Type dialog box.

Connect / Disconnect o

Plans List o- — Plan : M78
Current Plan oh
Object Name °=

Exposure oh\

8 Exp: Bulb _ 13
Binning @ 1 !

S

Camera Info @,

° Settings
Cooling Aid

o Connect / Disconnect

25



Connect or disconnects the camera. Shift + Click on Connect button opens the Select Camera Type dialog box
where you can change the default camera type or to change ASCOM/ INDIGO / INDI driver or QSI/SBIG connection
parameters.

Start / Pause / Resume

Starts execution of the selected imaging plan. Once it is started the button is replaced with Pause button that will
pause the plan after the current exposure is finished. If a plan is paused it can be resumed by pressing the Resume
button that will become visible.

Shift + Click on Start button opens the Start options dialog box.

00:00:00

You can loop a plan to be executed several times (or unlimited times if you enter 0 in "# of execution) or the schedule
the plan execution for a defined time or event.

The following scheduling options work in combination with Darkness Clock:
- Deep Sky Darkness (DSD) - the moment when full darkness starts
- Astro Night - the moment when astro twilight finished
- Night - the moment when Sun sets

If the starting event has already passed for the current night you will be asked if you want to start the plan immediately
or you want to wait for the event in the next night.

If you combine Loop and one of the options DSD, Astro Night or Night, APT will stop the next iteration of the plan if
the scheduling event is no longer valid - for example no more full darkness.

If you set Loop to 0 and one of the options DSD, Astro Night or Night, APT will pause the next iteration of the plan till
the scheduling event becomes valid again on the next night. It is useful for unattended operation for all sky cameras or
meteor hunting. Scripts and Commands feature can be used for advanced functionality like remote images uploading.

See Plan Editor section.

Stop

Stops the execution of the running plan.
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o Plans List
' Plan : M78

List of the saved imaging plans. There are different type of plans that has specific features. See Plan Editor for
information about the plans, how to create and manage them.

When a plan is selected the expected execution duration will be printed in the Log panel. If the plan is from Light type
also will be calculated the actual total light exposure.

° Plan Editor

Opens the Plan Editor. Double click in the plan table does the same.
Ringy Thingy

Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

Current Plan

Shows the lines of the selected imaging plan.

The columns are:
* Order
* Exposure duration
* Binning
* Pause duration
+ Count of the exposures
* Filter

During the execution the current line is selected and under it there is a small progress bar to show the line execution
percentage.
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Double click in the table opens the Plan Editor for the selected plan.

o Object Name

Defines a name part that to be added to the image file names stored on PC. For example if you enter “M78” the
image name stored will be:"M78_ IMG_5034.JPG”. In order to use this feature select "Object Name" as "Name Part"
in Main Settings Tab. In Advanced Settings Tab you can define if APT have to remember the entered name between
the sessions.

The entered value will be stored in the FITS keywords header.

The name is automatically populated when an object is selected from Object Browser.

o Exposure
. Exp: Bulb

Contains the list of the predefined exposure durations to be used for making single images by Shoot button or for
LiveView. If you want to make exposures longer than 30s or shorter than 1s select the “Bulb” option and enter the
desired duration "Bulb exposure duration".

It doesn't affect the settings of the selected imaging plan.

o Bulb Exposure Duration

Defines how long the bulb exposure to be when "Bulb" is selected from "Exp." list and when Shoot button is used.

° Gain

Defines what gain value to use for LiveView or Shoot image. Empty value leaves the gain control to the camera
driver and driver settings. If Remember Gain is enabled this value will be saved between the session and will be
automatically set on camera connection.

If there are no gain values defined per filter in Filter Wheel settings tab the value in this field will be used during
imaging plan.

Note: If Manage Gain is disabled, all gain values entered in APT are ignored and the gain control is left to the
camera driver and driver settings.

o Binning
' Bin: 1x1

Defines the Binning to be used when Shoot button is used. It doesn't affect the settings of the selected imaging plan.

28



Image Preview

Controls the preview of the last taken or loaded image in the "LiveView / Image Preview" panel.

On (Fit) Shows the image in the preview area after every exposure. The image will be scaled
to fit in the area

Off No preview

On (1:1) Shows un-scaled part from the loaded image that fits in the preview area

On (1:1) Scroll  Shows scrolling buttons to select the image area that you want to see in mode “On
(1:1)". Use the central rectangle to view the center of the image

To scroll the image smoothly in “On (1:1)” or “On (1:1) Scroll” modes, hold the Shift key and drag with the mouse.
You can also use the right mouse button to drag the image.

To switch quickly between “On (Fit)” and “On (1:1)” modes double click on the image. This allows to center the part
of the image without scrolling.

If you double click on a scroll arrow, position will be moved to the corresponding border.

Region Of Interest

Allows speeding up the image download, by selecting just small part of the image. Provided are several options that
are fraction of the sensor size for easier selection. If Center ROl is is active (high-lighted), APT automatically uses
the center of the sensor where usually is the focusing star. If Center ROl is not is active (high-lighted) then the area
of ROI can be selected by left clicking in the "LiveView / Image Preview" panel which in this case contains a thin
frame that represents the CCD/CMOS sensor. Note that in order to see the data for the new ROI there is need to
download a new image from the camera.

Center ROI

Enables/Disables the ROI centering.

Cooler

Turns ON/OFF the camera cooler.

Coollng Aid

Allows controlling the camera cooling to a "Target CCD T" in small "Cooling Steps" making "Pause" between every
step. This way the cooling is smoother and prevents thermal shock.

If the "Cooling Step" is set to 0 (zero), APT sends one command to the camera with the desired temperature and
leaves the camera driver to manage cooling process. It is an option set the wanted temperature in one step.
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Cooling Aid turns the cooler on automatically.

Required is camera with temperature control.

o Warming Aid

Allows controlling the camera warming to a "Target CCD T" in small "Warming Steps" making "Pause" between every
step. This way the warming is smoother and prevents thermal shock.

If there is available external Temperature sensor, the Warming Aid will use it to suggest the end point of the warming.

If the "Warming Step" is set to 0 (zero), APT sends one command to the camera with the desired temperature and
leaves the camera driver to manage warming process. It is an option set the wanted temperature in one step.

Required is camera with temperature control.

@ Settings
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Opens the Settings dialog box of the CCD/CMOS driver (if such is available). For Altair Astro, ZWO and INDIGO /
INDI cameras is opened a custom dialog box to tune parameters like offset/black level, USB Speed, Dew Heater
control and etc.

@ Camera Info

Shows information about the connected camera like name and if the sensor is mono or color. The information is
provided by the camera driver.

Select Camera Type
This dialog box allows selecting the camera type you want to use. To open it use Shift+Click on Connect button in Camera Tab
In rare cases there is need to start APT using the "Run As Administrator" option in order to resolve camera connection problems.

When APT is started this way, you have to use the same option for PHD, Planetarium and the other applications that APT
can communicates with.

Camera Number R Digic Generation °\
.

N \

Canon EOS Camera o\

Nikon Camera e_
CCD Camera o'"'_-__

o
-

Color Preview °
Bayer Filter °

o Canon EOS Camera

Switches APT in Canon EOS DSLR mode.

o Camera Number

If you use only one camera leave this to "Auto". If you use more than one camera at the same time select the number
of the EOS camera that you want to use into this instance of APT. The number is defined by the order of EOS camera
connected to the computer. The first camera is #1, the second #2 and etc.

See Multi-Camera Operation for more information on how to use in such configuration.
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D|g|c Generation

APT uses different type of communications with the camera depending on the Digic generation. Select the generation
of the Digic processor of the current camera.

Information about the EOS models including the built-in processor can be found in the EOS Matrix page on the APT
site.

Note: For EOS 1300D (T6, X80) select the option Digic 6, 4+!

o Nikon Camera

Switches APT in Nikon DSLR mode

o Camera Number

If you use only one camera leave this to "Auto". If you use more than one camera at the same time select the number
of the camera that you want to use into this instance of APT. The number is defined by the order of Nikon camera
connected to the computer. The first camera is #1, the second #2 and etc.

See Multi-Camera Operation for more information on how to use in such configuration.

o Camera model

APT uses different type of communications with the camera depending on the Nikon model. Select the model of the
current camera.

Information about the EOS models including the built-in processor can be found in the Nikon Matrix page on the
APT site.

CCD Camera
Switches APT in CCD/CMOS mode. Depending on the CCD/CMOS type there are different parameters.

See Multi-Camera Operation for more information if you want to use more than one camera at the same time.

Select "ASCOM Camera" if you have ASCOM compatible CCD/CMOS camera. When you click on OK button you
will see the standard ASCOM dialog box for selecting the camera driver. APT will remember your selection, so if you
want to change the driver use again Shift+Connect.

Note: Both, the ASCOM platform and the camera ASCOM diver, have to be installed!
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Select "QSI Camera" if you have QSI camera. Leave the "Serial #" blank unless you want to use more than one QSI
camera at the same time. If you use more than one QS| camera at the same time enter the serial number of the
camera you want to use into this instance of APT. If your camera has built-in filter wheel it will be connected when
the camera connection is made.

Select "SBIG Camera" if you have SBIG camera. From the "Port" list box select the port where your camera is
connected. If you use SBIG filter wheel then select the model form the "Wheel" list box. Click on OK. APT will remember
your selections, so if you want to change the any of the parameters use again Shift+Connect.

If you have a filter wheel, make sure to describe the used filters in Filter Wheel settings tab.

Select "Altair Astro Camera" if you have Altair Astro camera. If you use only one camera leave the Camera # to
"1". If you use more than one Altair Astro camera at the same time (i.e. one for imaging other for guiding) select
the number of the camera that you want to use into this instance of APT. Try the different numbers till you find the
corresponding number of your imaging camera. Connect all Altair Astro cameras before starting APT in order to
preserve the numbering.

Select "INDIGO / INDI Camera" if you have CCD/CMOS camera connected to INDIGO / INDI server (make sure that
you have active connection to the server). When you click on OK button you will see a dialog box for selecting the
camera driver.

Click on OK. APT will remember your selections, so if you want to change the any of the parameters use again Shift
+Connect.

o Color Preview

Enables / disables the color FITS preview in the "LiveView / Image Preview" panel. There is need to select the
corresponding Bayer matrix configuration from the list Bayer Filter.

Note - this affects only the image preview and is not altering the saved images.

This feature can be also controlled from CCD Settings tab.

o Bayer Filter

Defines the Bayer matrix configuration to be used by the de-bayering algorithm.

This feature can be also controlled from CCD Settings tab.

Gear Tab

33



The Gear tab is the control center for the additional devices of your imaging kit - Telescope/Mount, Focuser, Filter Wheel,
Rotator. If you don't need or don't use a section click on the small button in the upper right corner to collapse it and to save
screen space.

Mount / Telescope

Meade Specific o

Focuser o

Rotator o

o Mount / Telescope
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Controls the Telescope/Mount. For detailed information see the section Telescope.

o Meade Specific

Gives access to Meade specific features. For detailed information see the section Meade Specific.

o Focuser

Controls the Focuser. For detailed information see the section Focuser.

o Filter Wheel
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Controls the Filter Wheel. For detailed information see the section Filter Wheel.

o Rotator

Controls the Rotator. For detailed information see the section Rotator.

Telescope (Gear Tab)

This section gives control over the telescope/mount. In this document telescope and mount will be considered as same thing
- the device that points the optical tube.

The mount connection is used or can be used by the following APT features:
* PointCraft
+ Dithering - direct mount control when there is no guiding - APT Dithering
* Meridian Flip Clock
+ Imaging plans - Scripts and Commands
 Use current position to create Custom item in Object Browser.

PointCraft Park / Unpark

o Connect / Disconnect
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Connects / Disconnects telescope. When Connect button is used for the first time you will see the ASCOM or INDIGO /
INDI telescope chooser dialog box where to select the driver for your mount. APT remembers the selection and next
time will use the same driver without need to select it. If you want to change the driver or to tune its settings, hold
the Shift key when you click on Connect button.

To control a telescope via ASCOM simultaneously from several programs use one of the hubs that are installed by
the ASCOM platform. The mount connection is made in the hub, then all applications make connection to that hub
in order to use the shared mount connection. The POTH hub is preferred choice, but sometimes the Generic hub
is the only option.

Note: Some ASCOM drivers works better with APT when the connection is made through POTH hub. If you have
mount connection or control problems try this solution.

o Guide control

Opens the Guide Settings dialog box. APT can communicate with various guiding applications and devices. See
Dithering and Guiding section.

The text on the button varies:

Guide No dithering and Auto-Cancel enabled
Guide [C] Dithering disabled, Auto-Cancel enabled
Guide [D] Dithering enabled, Auto-Cancel disabled

Guide [D+C] Both Dithering and Auto-Cancel enabled

Dithering is making small mount movements between the imaging exposures. This technique combined with at least
10 exposures and "sigma-clip" (or equivalent) staking method gives very good control over the noise, dark / hot pixels,
satellite and plane tracks.

Auto-Cancel is an APT feature that allows stopping a running exposure if the distance to the guiding star becomes
bigger than a defined limit, in order to save imaging time or to save the already gathered data. For example - there
is no need to wait 10 minutes if guiding ruined the exposure in the first minute.

Use Shift+Click on Guide button to close/reopen connection to the guiding application or device.

RA | Dec

The Right Accession and Declination coordinates reported by mount. The values are changing in real time.

Az | Alt

The Azimuth and Altitude coordinates reported by mount. The values are changing in real time.
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o JNow
The coordinates in Object Browser or these returned from PointCraft are in J2000 epoch while some mounts are

working in JNow epoch. When JNow buttons is active (high-lighted) APT will convert the coordinates from J2000 to
JNow before sending them to the mount. This action is made on GoTo, GoTo++, Sync and #GoTo APT command.

o GoTo Ra/Dec

The coordinates that you want to use for next GoTo. Accepted is any format and you can paste a value stored in
the clipboard.

o GoTo
Goes to the coordinates entered in the GoTo RA/Dec fields. If any of these fields are empty APT will take the current
coordinate from the mount and will use it. For example if you want to make move only by Right Accession enter the

new value and leave Declination empty.

Use Shift+Click on GoTo button or Alt+V shortcut to open the Advanced GoTo dialog box.

The first section allows making GoTo to Az/Alt coordinates.

The second section allows making GoTo to an offset from the current Az/Alt coordinates. Useful if you want to move
the scope by few minutes without need to calculate the exact coordinates.

The last section allows making GoTo to an offset from the current RA/Dec coordinates. Useful if you want to move
the scope by few minutes without need to calculate the exact coordinates.

If the mount is not supporting movements by Alt/Az coordinates APT will convert them to RA/Dec for current time
and for the current Location.

o Speed

38



Changes the speed of the mount moves when any direction button are used. m' - will move the mount with 1 arc-
minute per second, s" - with one arc-second per second.

o Directions / Stop

Move the mount with the selected speed in the corresponding direction. The center button will stop the current mount
slew / GoTo action.

Ringy Thingy
Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

o PointCraft

PointCraft is one of the most important features of APT. It uses the power of plate-solving to give way for easy
and accurate object framing and centering during different nights, after meridian flipping and many other exciting
possibilities.

Using blind solving in PointCraft you can synchronize your mount without need to center any star and to avoid the
GoTo alignment procedure.

See PointCraft and Plate-Solving section.

@ Object Browser

Opens Object Browser to select an object and populate its coordinates in the GoTo RA/Dec.

If you use Shift+Click APT will get the current coordinates from the running Planetarium application rather than opening
the Object Browser. See Planetarium section.

o Park / Unpark

Parks the telescope. If the mount is parked the button will become UnPark.
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The actions park and unpark should be supported by the mount and by the driver.

If you use Shift+Click APT will set the current position as park position.

12
Synchronize the mount with the coordinates entered in GoTo RA/Dec. This is the equivalent to make "One-Star GoTo

Alignment" through your hand-controller.

You can use LiveView and Cross to center one of the stars listed in the Stars tab of Object Browser then using Sync
button to synchronize the telescope. A message will be printed in the Log panel when command is completed.

Note that you can use Blind solving in PointCraft to synchronize your mount without need to center a star.

G Track

Enables / Disables the mount tracking.

Meade Specific (Gear Tab)

This section becomes available when Meade mount with AutoStar hand-controller is connected. It gives way to use the
AutoStar features directly from APT.

Made

Enter o

Mumbers / Up / Down

o Enter

Equal to pressing Enter on the hand-controller.

Shift+Click on Enter enables/disable "High Precision mode".
Ctrl+Click on Enter is equal to hold the Enter key on the hand-controller.
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o Mode

Equal to pressing Mode on the hand-controller.

GoTo
& [ coro |

Equal to pressing GoTo on the hand-controller.

o Numbers / Up / Down

Equal to pressing the corresponding number, Up or Down key on the hand-controller.

o Meade Focuser Control

This section becomes available when:

+ AutoStar controller is connected
» "Meade Focuser" is enabled in the Scope & Focuser settings tab

It allows controlling the focuser attached to the AutoStar in four speeds and to stop a running focuser move.

Focuser (Gear Tab)
This section gives ASCOM and INDIGO / INDI compatible focuser control.

There are two types of focusers Absolute and Relative. The Absolute use servo motor to drive the telescope focuser and can
measure every move in steps and to give the exact position of the focuser in every moment. The Relative use DC motor and
can't measure the exact position. APT can make emulation and make Relative focuser to look like Absolute. To enable the
emulation use the options in Scope & Focuser settings tab.

APT is capable to apply temperature focus compensations and focuser backlash compensations. For details on configuring
them see Scope & Focuser settings tab. Note that temperature compensations will not be applied when Focusing Aid, Auto
Focus Aid or Bahtinov Aid are open.

Some focuser has built-in temperature sensor. Also there are some DIY (Do-It-Yourself) projects based in the Arduino platform
that has both temperature and humidity sensors. For more information on how such sensors can be used see the section
Temperature /Humidity Sensors.

If you have Meade focuser connected to the AutoStar hand-controller see Meade Specific section.
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The focuser connection is used or can be used by the following APT features:
* Auto Focusing Aid
* Filter Wheel - Adjust Focuser
« Imaging plans (Scripts and Commands)

Connect / Disconnect o
Position o
Position Bookmarks 0 —
In x5 0'

Connect | Disconnect

When you connect a focuser for the first time you will be asked to select the connection parameters from ASCOM or
INDIGO / INDI selector dialog. APT will remember your selection and when you click again on the “Connect” button
it will use the previous settings automatically. If you want to change the connection parameters, use “Shift+Click” on
the Connect button.

o Position

If the focuser is of type Absolute shows the current position of the focuser. If the focuser is Relative the position is not
available, unless emulation is enabled in Scope & Focuser settings tab.

Posmon Bookmarks

Allows storing and using of three focuser position values.

To store the current focuser position use Shift+Click. To use stored position, just click on the button and the value
will be populated into the GoTo field.

o Settings

Opens the settings dialog of the ASCOM driver. If this action is not supported by the driver, use Shift+Click on Connect
button and then click Properties in the driver selector dialog box.

o GoTo section

42



This section allows to move the focuser to particular position. Enter the position (or use the Position Bookmarks)
and click on GoTo button. This requires Absolute focuser or enabled positions emulation (Scope & Focuser settings
tab).

If position emulation is enabled Shift+Click on the Goto button will set the entered GoTo value as current position of
the focuser.

o Step Size

Defines how many positions to change on every move step. The button "..." allows creation/selection of different step
size profiles. When Step size control is focused you can use arrow up/down keys to scroll through the profiles you
have defined.

Out x5

Move the focuser in outward direction with five times the defined step size.
Out
Move the focuser in outward direction with the defined step size.

Stop

Stops the running focuser move.

In

Move the focuser in inward direction with the defined step size.
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o In x5

Move the focuser in inward direction with five times the defined step size.

Filter Wheel (Gear Tab)

APT is able to control filter wheels via ASCOM drivers, INDIGO / INDI as well as QSI and SBIG filter wheels through their
native interfaces. To describe the filter names and offsets in APT rather than in the wheel driver see Filter Wheel settings tab.

This section gives manual wheel control. Note that imaging plans can be configured to change the filters during the plan
execution. See Plan Editor section.

The filter wheel connection is used or can be used by the following APT features:

 Imaging plans
« Imaging plans (Scripts and Commands)
* CCD Flats Aid

Connect / Disconnect o
Current Filter e .
Previous { Next e,.»

o Connect / Disconnect

When you connect an ASCOM / INDIGO / INDI filter wheel for the first time you will be asked to select the connection
parameters from ASCOM or INDIGO / INDI selector dialog. APT will remember your selection and when you click
again on the “Connect” button it will use the previous settings automatically. If you want to change the connection
parameters, use “Shift+Click” on the Connect button.

To connect SBIG filter wheel see Select Camera Type. Note that for SBIG wheel you have to use the Filter Wheel
settings tab to describe the installed filters.

The QSl internal wheel is connected automatically on camera connection.

To "connect" a manual filter wheel or filter drawer you have to enable the option in the Filter Wheel settings tab.

o Settings
==
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Opens the settings dialog of the ASCOM driver. If this action is not supported by the driver, use Shift+Click on Connect
button and then click Properties in the driver selector dialog box.

o Current Filter

Shows the current filter name.

This information can be also found in the Status section in the Main screen in order to save you tab switching just
to see the current filter.

o Go to filter

List box with all installed filters that allows selecting directly the desired filter instead of scrolling. Note that Moravian
Instruments filter wheels will make the actual movement before the next exposure.

When manual wheel or drawer is used, it just changes the select filter name after the filter is changed manually.

o Previous / Next

Goes to the Previous / Next filter. Note that Moravian Instruments filter wheels will make the actual movement before
the next exposure.

When manual wheel or drawer is used, these buttons just change the select filter name after the filter is changed
manually.

o Adjust focuser

When is active (high-lighted) if there are entered focus offset for the filters in Filter Wheel settings tab or in the ASCOM/
QSI properties and if there is connection to Focuser, then APT will adjust the focuser position on every filter change.

This option could be used even with manual wheel or drawer.

o Applied Offset

Shows the applied focus offset on the last filter change. Needs Adjust focuser to be enabled, connection to a
Focuser and defined focus offset.

Rotator (Gear Tab)

This section gives rotator control.
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Connect / Disconnect

Position e-______

Connect | Disconnect

When you connect a rotator for the first time you will be asked to select the connection parameters by the standard
ASCOM dialog. APT will remember your selection and when you click again on the “Connect” button it will use the

previous settings automatically. If you want to change the connection parameters, use “Shift+Click” on the Connect
button.

o Settings

Opens the settings dialog of the ASCOM driver. If this action is not supported by the driver, use Shift+Click on Connect
button and then click Properties in the driver selector dialog box.

o Position

The current position reported by the driver.

o Go to
Goes to the desired position. Enter the wanted degrees and click on GoTo.

Move 10

Move the rotator by 10 degrees in one direction. The direction depends on the driver settings.
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Move

Move the rotator by one degree in one direction. The direction depends on the driver settings.

Stop

Stops the running movement.

o Move
Move the rotator by one degree in the opposite direction. The direction depends on the driver settings.

Move 10

Move the rotator by 10 degrees in the opposite direction. The direction depends on the driver settings.

Tools Tab

This tab gives access to many interesting features. Here you can find short note about every one and link to a dedicated
section where the feature is described in details.
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Histograms n

Framing Masks o’
Pixel Aid o/ pd
- - /
e /
CCD Flats Aid o/
Session Craft 0/

Object Calculator @'

Hlstograms

Opens/Closes the Histogram Aid. It can be used to see if the image is properly exposed or the make Screen
Stretch or Levels of the image to see fainter details. This is "on screen" operation and the saved image is not
altered.

See Histogram section.

APT Settings

Opens the Settings dialog box where you can handle most of the APT settings. Some APT features has their local
settings which are described the corresponding sections.

See Settings section.

Graphs
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Opens/Closes the Graphs aid. It shows graphs for various data collected during the imaging session like EXIF
temperature, CCD/CMOS temperature and etc.

See Graph section.

Focus Aid

Opens/Closes the Focus Aid. This is an aid to achieve the best focus by using FWHM (Full Width Half Maximum) or

HFD (Half Flux Diameter) metrics for measuring the focus quality. This aid is also used by the Auto-Focus Aid and
EOS Lens Auto-Focus.

See Focusing Aid section.

Bahtlnov Aid

Opens/Closes the Bahtinov Aid. This aid analyzes the spikes made by a Bahtinov mask on sub-pixel level and
allows achieving better focus than the one made by eye.

See Bahtinov Aid section.

Auto Focus Aid

Opens/Closes the Auto-Focus Aid. Using a motorized focuser and Focus Aid the Auto-Focus Aid analyze and tune
the focus automatically.

See Auto-Focus Aid section.

Frammg Masks

Opens/Closes the Framing Masks aid. This is an aid to frame object by same way during different nights or after

a meridian flip. It allows creating a reference mask from an image and to show it over other image with just a few
clicks.

Itis an alternative to PointCraft when there is no telescope/mount connection.

See Framing Masks section.

Plxel Aid

Opens/Closes the Pixel Aid. It allows to inspect the signal in various metrics for a small part of the image (or the
whole image).

See Pixel Aid section.
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CCD Flats Aid

Opens/Closes the CCD Flats Aid. Use this aid to determine the exposure duration needed to get the best flat
frames. It can evaluate multiple filters and create automatically Flats type imaging plan.

See CCD Flats Aid section.

Sessmn Craft

Opens/Closes the Session Craft Panel. It allows to control the Automated Meridian Flip.

See Session Craft section.

Magnlfler

Opens/Closes the Magnifier aid. It allows making software image zoom.

See Magnifier section.

Set Focus Mark

Sets a focus mark for the current temperature. The mark is used in order to determine when to notify you that there
is need to refocus because of temperature change.

Shift+Click on this button prints the last set temperature mark in Log panel.

See External Sensors section.

Lens Control

Opens/Closes the EOS Lens Control aid. It gives control over the attached EOS lens and allows to make precise
auto-focus using FWHM (Full Width Half Maximum) or HFD (Half Flux Diameter) metrics. This method is better
than camera built-in auto-focus which is not optimized for astro-photography.

See EOS Lens Control and Auto-Focus section.

DARV
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Opens/Closes the DARV aid. DARYV is Drift Alignment by Robert Vice method. DARV Aid helps with the mount
movement and exposure control.

See DARV section.

Colllmatlon Aid

Opens/Closes the Collimation Aid. It helps to make easier collimation.

See Collimation Aid section.

Planetary

Opens/Closes the Planetary Panel. It provides a way to take planetary images using the EOS LiveView.

See Planetary Panel section.

o Check Lists

Opens/Closes the Check Lists Panel. It provides to store and preview checklists of steps and reminders for various
aspects of preparation for imaging session or step to follow. Like "Don't forget the USB cables"...

See Check Lists Section.

Extra Devices

Opens/Closes the Extra Devices Panel that gives control over additional devices.

See Extra Devices Section.

@ INDIGO / INDI

Opens/Closes the INDIGO / INDI Panel gives control over connection to INDIGO / INDI server.

See INDIGO / INDI Section.

m Object Calculator
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CD I/ CMOS Camera

1000

This is the built-in APT calculator that allows computing the FOV (Field Of View) size, resolution and etc.

See Object Calculator section.

Img Tab

Img Tab is the image browser of APT. It allows fast previewing and deletion of images. It has some features that are related
to astro-photography. For example if you image in RAW+L quality mode APT will group the two files (CR2/NEF and JPG)
to show one thumbnail. If you use the Delete button it will remove both files at once. When Preview mode is set to 1:1 the

scrolled position will remain allowing to inspect same region in series of images.
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Image Center Thumbnails

Freview Effects n q 0 Image Preview : On (Fit)
\ Y, "___,-"
AN
First Image °‘=
- HH""
Previous Image o' . o Last Image

Upper folder (Back) 6

Current Folder f Browse

Images (and Folders) a

/0 Delete

Refresh oi /

e
-

Go to Last Taken e/

~_
o Infa
o Preview Effects

Opens/Close the Preview Effects dialog box which allows applying various effects on the loaded image or LiveView
stream. The saved images are not affected. If there is asterisk after "Preview Effect" it means that one or more
effects are activated.
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LV++ Tries to intensify the EOS LiveView stream. Note that EOS Histogram has LiveView auto-stretching
option that can give better results. In CCD/CMOS mode the LiveView can be intensified by CCD
Histogram stretching or auto-stretching

LV Stack |Stacks number of frames from the EOS LiveView stream. The count is configurable from Advanced
settings tab

FlipHor Flips the image horizontally

FlipVer Flips the image vertically

Sharp Applies sharpening filter

Negative |Makes the image negative

Gamma Increases the gamma with +0.25 on every click till +3.00. Double-click disables the effect

Rotate Rotates the image with +90 degrees clock-wise on every click. Double-click disables the effect

Brightness |Increases the image brightness with +25% on every click till +200%. Double-click disables the
effect

Note that performance can get slow (especially on a weak computer) if you are using Preview Effects over big
images in combination with Preview Modes "1:1" and "1:1 Scroll"

o Image Preview : On (Fit)

Image Preview : On (Fit)

Controls the preview of the loaded image in the "LiveView / Image Preview" panel. It duplicates the functionality of
the same control in Camera tab in order to save tab switching.

On (Fit)

Off
On (1:1)

Shows the image in the preview area after every exposure. The image will be scaled
to fit in the area

No preview
Shows un-scaled part from the loaded image that fits in the preview area

On (1:1) Scroll  Shows scrolling buttons to select the image area that you want to see in mode “On

(1:1)”. Use the central rectangle to view the center of the image

To scroll the image smoothly in “On (1:1)” or “On (1:1) Scroll” modes, hold the Shift key and drag with the mouse.
You can also use the right mouse button to drag the image.

To switch quickly between “On (Fit)” and “On (1:1)” modes double click on the image. This allows to center the part
of the image without scrolling.

If you double click on a scroll arrow, position will be moved to the corresponding border.

o First Image
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Loads the first image in the current folder.

Prewous Image

Loads the previous image in the current folder.

Next Image

Loads the next image in the current folder.

Last Image

Loads the last image in the current folder.

o Image Center Thumbnails

Enables/disables the Image Center Thumbnails (ICT) mode. The ITC mode shows in the thumbnail the center of
the image in 1:1 scale. Is is very handful to evaluate the guiding quality without need to load and scroll the image.
The bad images can be deleted easily with the Delete button.

In left is a thumbnail of the whole image, in right is the thumbnail of the image center.

It is possible to toggle both modes for one image only with right click on it.

o Upper folder (Back)

Goes to the upper folder - the parent folder of the current one.
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o Current Folder / Browse

Shows the current folder. Click on this button to open the folder selection dialog box.

Shift+Click on it to open the folder in Windows Explorer.

m Images (and Folders)

List of thumbnails. Double click on image thumbnail loads the image in the "LiveView / Image Preview" panel.
Click with the right mouse button toggles between full image thumbnail (in left image) and image center thumbnail

(right).

Shift + Double Click loads the CR2/NEF/FITS image into the associated application.

Shift + Ctrl + Double Click loads the JPG image into the associated application.
Double click on folder thumbnail opens the selected folder and makes it current one.

If the setting "Hide folders in Image Browser" in Main settings tab is enabled, the list contains only image
thumbnails. If the option is disabled the list will include also thumbnails for the sub-folders of current folder.

Sample folder thumbnail:
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In the lower right corner of image thumbnail are printed image types (files) represented by this thumbnail The
possible values are:

JPG One file only in JPG format.
CR2 and JPG Two files - CR2 and JPG formats
NEF and JPG Two files - NEF and JPG formats

CR2, TIFF and JPG Three files - CR2, TIFF* and JPG formats
NEF, TIFF and JPG Three files - NEF, TIFF* and JPG formats
FITS One file only in FITS format.

*TIFF file is generated when the option "Convert CR2/NEF to TIFF" option is enabled in the Advanced settings tab.

Note that changing the current folder in the Img Tab has not effect on the folder where the images are stored.

Refresh

Refresh the list of the current folder and re-generates the thumbnails.

Go to Last Taken

Goes to the folder where is saved the last taken image during the current imaging session (or previous session
before new image is taken).

o Info

If the file is in FITS format opens the FITS Header viewer. The information in it is updated if other image is loaded.
The shortcut for this dialog box is Alt+I.
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e Delete

Deletes the selected file (or files if the thumbnail represents more than one). The file(s) are moved in the Recycle
Bin, so they can be restored in case you change your mind.

APT Features

In this section are described almost all APT features. You can use it find information about a feature and how to use it.

There are some major features that are explained in separate sections:
* Dithering and Guiding
* PointCraft and Plate-Solving
* Multi-Camera Operation

Credits
In order to provided all described APT features are used several external components:

» Canon EOS SDK

* Nikon SDKs

* SBIG SDK

* QSI API

* Freelmage library

» Bahtinov analysis technology by Neils Noordhoek
* NASA FITS/IO library

LiveView

LiveView is controlled by the button "LiveView" in the main screen or with Alt+L shortcut.
It has different behavior in DSLR and CCD/CMOS modes.

« Canon EOS mode
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In EOS mode LiveView is a feature provided by the camera to get real time images. It is affected by settings ISO and
Exposure that can be controlled from Camera Tab (DSLR Mode). By default APT will use for LiveView the highest
ISO and Exposure settings in order to provide high sensitivity suitable for deep space objects. This feature is named
LiveView Automation and can be disabled/enabled from Main Settings Tab.

Using "Zoom +" and "Zoom -" you can increase/decrease the LiveView zoom level to 5x (or 10x if it is clicked two times).
For most EOS cameras Zoom x5 is very close to the representation "1:1" - "one pixel from the image, represents
one sensor pixel". It is valuable feature for planetary astro-photography.

Troubleshoot: If the Zoom+ is not working, then go to the camera menu and disable the Face Detection feature.
It is not compatible with LiveView zoom.

Tips & Tricks: To place the zoom window in the center of the image, use Shift+Double click.

Tips & Tricks: When Zoom x5 or x10 is enabled APT shows small cross to mark the exact center of the camera
sensor. It is useful when precise star alignment is needed.

* Nikon mode
In Nikon mode LiveView is a feature provided by the camera to get real time images. It not is affected by settings ISO
and Exposure that can be controlled from Camera Tab (DSLR Mode). For Nikon cameras you can disable the feature
LiveView Automation from Main Settings Tab.

Using "Zoom +" and "Zoom -" you can increase/decrease the LiveView zoom level to from 0% to 100%. For most
Nikon Zoom 100% is the representation "1:1" - "one pixel from the image, represents one sensor pixel". However the
poor quality of the LiveView stream doesn't allow it usage for planetary astro-photography.

Tips & Tricks: To place the zoom window in the center of the image, use Shift+Double click.

* In CCD/CMOS mode
In CCD/CMOS mode LiveView takes endless series of images that are not stored on the hard disk. The Binning, Gain
and Exposure settings can be controlled from the Camera Tab (CCD/CMOS mode). If the feature LiveView Automation
is enabled APT will select automatically the biggest supported Binning settings to maximize the sensitivity. This feature
can be disabled/enabled from Main Settings Tab.

The CCD/CMOS cameras have no hardware supported Zoom. In order to make a software zoom you can use Tools-
>Magnifier feature.

The LiveView works in this mode for the cameras connected via ASCOM driver, SBIG, QSI, INDIGO/INDI. Sometimes
is also reffered as "Images LiveView"

* In native ZWO mode

When a native connection is made to a ZWO camera (coming soon for Altair Astro), the following dialogue box will
be opened on LiveView activation.

It gives possibility to enable "Video LiveView" which give much faster transfer , shorter exposures and possibility to
use automatic exposure duration and gain value (depends on the camera model). Un-checking the option "Video
LiveView" switches to "Images LiveView" where the exposure parameters are controlled from the Camera Tab (CCD/

CMOS mode)

Histogram
The Histogram is accessible from Tools tab or with Alt+H shortcut.
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The Histogram Aid is an important and powerful feature that can be used to see ifimage is properly exposed or to make Screen
Stretch or Levels over image to see fainter details. This is "on screen" operation and the saved image is not altered!

The histogram is a graphical representation of the tonal distribution in the image. It shows the number of pixels for each tonal
value. The horizontal axis of the graph represents the tonal variations, while the vertical axis represents the number of pixels
in that have this particular tone. The left side of the horizontal axis represents the black and dark areas, the middle represents
medium bright areas and the right hand side represents bright and pure white areas.

You can set one black and one white point. The black point defines the left part of the histogram that you want to exclude (dark
areas). The white point defines the right part of the histogram that you want to exclude (bright areas). The range between the
black and the white points is the one that is showed on the screen. When this range is smaller than the original one stored
in the image the remaining tones are intensified. This action is known as Screen Stretching or Levels filter. When the back
point is in the very left and the white point is in the very right, the image is un-stretched and all tones are showed as they
are stored in the image.

In order to provide better control and more clean user interface, the Histogram Aid has different look in DSLR and CCD/CMOS
modes.

DSLR Mode

The Histogram is accessible from Tools tab or with Alt+H shortcut.

This is how Histogram Aid looks like when APT is in DSLR mode (Canon or Nikon). It shows the histograms of R, G and B
channels as well as the combined L (luminance) channel. The histogram area is divided in 5 logical sectors. For astro imaging
is good to inspect the all the channels and to select exposure / ISO combination that places the peaks in the second or/and
third sector. This gives images that after stacking allow easier post-processing. If the peaks are in the left most sector this
means that the image is under exposed. If the peaks are in the last two sectors the image is over exposed. Both case will lead
to information lost and less options for post-processing. The right exposure / ISO combination depends on various factors like
sky glow, object size, object brightens, sensor sensitivity and etc.

APT allows defining separate black/white points for the different R, G and B channels (by highlighting the RGB button) or for
the L channel. The RGB mode is very useful when modified DSLR camera is used because gives possibility to make on-screen
color balance and to get idea how the post-processed image will look like. It is recommended to use this mode even to un-
modified cameras because it takes the most of the signal per every channel.

Black point o White point
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The "Auto Stretching" is a powerful feature. It makes automatic selection of the optimal black and white points (per L or per
RGB) and by this boosting the weak signal. Here is an un-stretched image (black point in very left, white point in very right)
taken with modified Canon EOS camera.

60


/wiki/Lightness_(color)

This is the same image with "Auto Stretching" feature enabled in RGB mode. The stretching is made per each channel
separately in order to get the best from every one. As you can see the object can be seen much better and the image has
better color balance.

o Channels

Shows the histograms of per R, G and B channels and for the combined L (luminance) channel.
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o Logarithmic

When is active (high-lighted) it shows a logarithmic representation of the data.

3 =
When is active (high-lighted) it allows defining separate black and white points per R, G and B plans. When not is
active (high-lighted) the black and white points are only for the L channel.

It also defines if the Auto Stretching works per L or per RGB.

o Auto Stretch

When is active (high-lighted) it makes automatic selection of the black and white points. If the RGB mode is
enabled the black/white points are determined per every channel. If RGB mode is disabled black/white points are
determined per L channel only.

You can control how aggressive the automatic stretching needs to be by the option "DSLR Histogram Auto-Stretch
Factor" in Advanced setting tab.

o Clear

Disables the Auto Stretching mode (if it is enabled) and clears all set black/white points.

o LiveView

When is active (high-lighted) the histogram will be calculated for the LiveView stream. Also it applies the Auto
Stretching mode or the manually defined black/white points (per L or RGB depending on the RGB mode) on the
stream.

Note that it can affect the frames-per-second rate of the LiveView stream when used on slower computer.

o Black point

Shows where the black point is set. When Auto Stretching is disabled you can set the point manually using the
following combinations. Shift+Double Left click set the black point. Shift+Double Right click clears the black
point.
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o White point

Shows where the white point is set. When Auto Stretching is disabled you can set the point manually using the
following combinations. Double Left click set the white point. Double Right click clears the white point.

CCD/CMOS Mode

The Histogram is accessible from Tools tab or with Alt+H shortcut.

This is how Histogram Aid looks like when APT is in CCD/CMOS mode. Usually the CCD/CMOS sensors have 16bits dynamic
range which is hard to be displayed on screen. Because of that there is need to make a signal compression and boost
(stretching) in order to see more details from the raw data. APT makes one automatic compression by determining the lowest
and highest tones on every image and working with this Range. This is similar to defining black/white points that bounds the
recorded signal and excluding the left and right areas without data. In the sample below the Range is from 914 to 47786 which
means that there is no pixels with ADU less than 914 and bigger than 47786, so there are set hidden black/white points at
these borders. Also very left point of the graph shows the tine 914, the very right shows 47786.

This approach works well for bright frames (light, flats, framing), but sometimes lead to different screen representation of
"similar" dark and bias (sometimes flat) frames. Random hot pixels can change the Range and as result two bias frames

can have different brightness on the screen. There are no problems because the stored data is fine and this is only screen
representation.

Auto-5Str Right Clear Range

Auto-Str Left o 9 o

ShowHide

¢ @@ o0 o

Log Black Point Coarse/Fine White Paint

The screen below shows how defined black/white point looks like. The dark area is the range between the black and the
white point that will be used for manual or automatic screen stretching. When Auto Stretching is disabled you can set the
point manually using the following combinations. Shift+Double Left click set the black point. Shift+Double Right click
clears the black point. Double Left click set the white point. Double Right click clears the white point. Below are described
and other way to move the points.
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Powerful feature is the "Auto Stretching". It makes automatic selection of the optimal black and white points in order to show
the faint signal. In CCD/CMOS mode there are two options for automatic stretching - Left and Right. The left one works with
the most left peak in the histogram and gives better results when there are many saturated areas in the image. The right one
works better when there are several signal peaks that you wan to use or just one peak and when there are no many saturated
areas. You can easily change between the two modes with the "Auto-Str L" and "Auto-Str R" buttons to see which one you

like more for the current image.

Here is a sample of un-stretched image. As you see, only few stars are visible.

This is the same image after applying the "Auto-Str R". The M78 nebula becomes obvious and it is easier to evaluate the
image.
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Auto Str Left

Enables/Disables the "Left" automatic stretching. This methods works with the most left peak in the histogram and
gives better results when there are many saturated areas in the image.

Auto Str Right

Enables/Disables the "Right" automatic stretching. This methods works better when there are several signal peaks
that you want to use or just one peak and when there are no many saturated areas.

o Clear

Disables "Auto-Str L", "Auto-Str R" and clears the set black and white points
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o Range

Shows the image signal range. The weakest and strongest tones stored in the current image.

Log

When is active (high-lighted) it shows the logarithmic representation of the data.

o Show/Hide

Show/Hides the section for "by step" black/white points moving.

Black Point

Moves the black point in left or right with the selected step (Coarse/Fine)

Coarse/Flne

Switches between the Coarse and Fine fine step modes.

Wh|te Point

Moves the white point in left or right with the selected step (Coarse/Fine)

Plan Editor
The Plan Editor is accessible from Camera tab.
The imaging plan defines a set of exposures that you want APT to take.
In order to provide better control and more clean user interface, the Plan Editor has different look in DSLR and CCD/CMOS

modes. Also APT keeps separate sets of plans for the two modes. See Select Camera Type section to see how to change
the mode.

DSLR Mode

Plan Editor can be opened from Camera tab by using the Edit button
or by double click in the table for the current plan.
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If a plan is loaded the editor will be initialized.

There are six different plan types that have different properties:

Type Short Long Dithering |Note
prefix Prefix

Light L_ Light_ Yes

Light Auto LA_ LightAuto |Yes Uses AV dial mode to determine the exposure. Useful for eclipses
imaging.

Dark D_ Dark_ No

Bias B Bias__ No If Advanced Bias/Flats is disabled uses the shortest supported exposure

Flat F_ Flat_ No If Advanced Bias/Flats is disabled uses AV dial mode to determine the
exposure; Lacerta FBC, Pegasus Astro - FlatMaster, ArteSky - Flat Box
USB could be used during plan execution

Dark Flat DF_ DarkFlat_ |No

Frame/Focus No Doesn't store images on the disk/card

What prefix type will be used is selected form Name Parts in Main Settings tab.

Important Nikon note: Some of the Nikon models (D5000, D5100, D5200, D5300, D5500, D5600, D90, D80, D60, D40, Df)
doesn't allow to use the AV dial mode without attached lens. For these models Light Auto is useless and also for Flats there is
need to enable the option Advanced Bias/Flats and enter exposure duration. You can use the Shoot button the Histogram to
find the right exposure. The histogram peak should be in the send section from left to right.

If you have a Nikon model that can handle AV mode without lens, in the camera menu go to section Setup -> option "Non-CPU
Lenses", enter the focal length and the focal ratio of the telescope, then disable the option Advanced Bias/Flats disable the
option Advanced Bias/Flats and let APT to do the automation.

Import/Export a No Dithering
Delete plan a .

Plan : Select/Create n ) Vertical plan
-~
| Plan : Plan for M65 - o Claone plan
Plan Name e ) P -
Plan for ME5 : Clone As v 0 Ringy Thingy

Plan List o

@
Down o
Up o : : \‘\\ m Add as new button

l I .
\\ a Script or Command
Plan duration °
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o Plan : Select/Create

Here you can select for editing one of the existing plans or create a new one.
To create a new plan select from the list one of the options:

* Add New Light Frames Plan

* Add New Light Auto Frames Plan

» Add New Dark Frames Plan

» Add New Flat Frames Plan

» Add New Bias Frames Plan

» Add New Focusing / Framing Plan

» Add New Dark Flats Plan

This will create the corresponding plan and will give possibility to edit it.

Plan Name
o

Allows entering the name you want to use for the selected plan.

Delete plan

Deletes the currently selected plan.

o Clone plan

Makes a copy of the current plan with possibility to change the type and loads the new one for editing. This is an
easy way to create matching light and dark plans.

o Plan List



List of the defined exposures. Click on the line that you want to edit, move or delete. The parameters of the
selected line are loaded in "Add / Edit Exposure" section.

The columns are:
* Order
* Exposure duration
+ISO
» Pause duration
* Count of the exposures
* Quality
* Lens aperture (AV)
* Filter

o Down

Down

Moves the selected line one position Down.

U
.

Moves the selected line one position Up.

o Plan duration

Shows the expected plan duration. If the current plan is Light type it will show the total light duration that will be
gathered.




0,
Deletes the selected line from the plan.

Ringy Thingy
Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

o Exposure

Defines the duration for every exposure that will be executed by this plan line. Use a duration supported by your
camera. The duration is in seconds or fraction of a second.

If you are not sure about the speeds less than a second, make a connection to the camera and check the values
available in the Exp list in Camera Tab.

If the exposure duration is 0, the line will make just pause and/or will execute defined Script or Command.

12
Defines what ISO to use for the exposures in this plan line. Use an ISO supported by your camera. If you are not
sure, make a connection to the camera and check the values available in the ISO list in Camera Tab.

o Pause
Defines the pause in seconds that have to be made between every exposure from this line of the imaging plan.

Tips&Tricks Longer pauses between exposures reduce the noise in your images.

0 Count

Defines how many images to take by this line of the imaging plan using the defined parameters.

@ Quality

Defines the image quality setting to use for the exposures taken by this line of the imaging plan.

R+L Raw + Large JPG
L Large JPG
M Medium JPG
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S Small JPG

Raw Raw only

R1L Raw1 + Large JPG
R2L Raw?2 + Large JPG
S1 Small 1 JPG

S2 Small 2 JPG

The options in jtalic are not supported by all Canon EOS models and not available for Nikon models!

Using quality that doesn't include RAW file, speedups the downloading and is useful for focusing an framing.

a Lens AV

Defines the lens aperture (AV) to use for the exposures taken by this line of the imaging plan. Use the option "No
Change" if you don't use EOS lens or don't want to change the aperture.

e Filter

The filter to use for this line of the imaging plan. Use the option "No Change" if you don't use Filter Wheel or don't
want to change the filter.

In order to change filters a connection is required to the Filter Wheel during the plan execution.

If the filters are described in Filter Wheel settings tab or if there is active connection to a wheel then this list will show
the filter names. In other case the list will contain only position numbers like "Filter 1", "Filter 2"...

o Update current button

Updates the selected line with the parameters set in section "Add / Edit Exposure".

@ Add as new button

Adds a new plan line after the selected one using the parameters set in section "Add / Edit Exposure".

@ Script or Command

Allows executing an internal APT command or external script / application. See the Scripts and Commands section.

o Wait script end
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When selected APT will wait the external script or application to finish before continuing the execution of the plan.
For the internal commands APT always wait the execution to complete.

See the Scripts and Commands section.

a No Dithering

If the current plan is Light Plan, allows disabling the Dithering for this plan only.

@ Vertical plan

Allows controlling the plan execution order. When it is unchecked, APT will take all exposures for the first line and
then will continue with the next line. When it is checked the execution order will be:

Line1->Exposure1, Line2->Exposure1... LineN->Exposure1
Line1->Exposure2, Line2->Exposure?... LineN->Exposure2
Line1->Exposure3, Line2->Exposure3... LineN->Exposure3

Line1->ExposureX, Line1->ExposureX... LineN->ExposureX

The vertical mode is useful if you want to make HDR eclipse images, or when filter wheel is used and you are not
sure that weather will permit to gather all channels one after another.

@ Import/Export

Export allows to save one or more imaging plans in new file, while Import gives possibility to add saved plans in
addition to the current set or overwrite all plans.

CCD/CMOS Mode

Plan Editor can be opened from Camera tab by using the Edit button
or by double click in the table for the current plan.
If a plan is loaded the editor will be initialized.

There are seven different plan types that have different properties:

Type Short |Long Dithering |Shutter |Note
prefix |Prefix

Light L_ Light_ Yes Opened

Dark D_ Dark_ No Closed

Bias B_ Bias_ No Closed |If Advanced Bias/Flats is disabled uses the shortest supported
exposure

Flat F_ Flat_ No Opened|Lacerta FBC, Pegasus Astro - FlatMaster, ArteSky - Flat Box USB
could be used during plan execution

Dark Flat DF_ DarkFlat_ |No Closed

Frame/Focus No Opened|Doesn't store images on the disk
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Mixed L ,D_ |Light_, Yes Opened|Allows creation of one plan that takes light, dark and bias frames.
orB Dark_ or or Requires mechanical shutter.
Bias_ Closed

What prefix type will be used is selected from Name Parts in Main Settings tab.
Shutter column shows how the shutter is controlled when there is mechanical shutter available.

Delete Plan Import/Export @ Mo dithering

Plan : Select / Create n

.

Plan Mame °

Plan list o-____

Plan duration ° '

o Plan : Select / Create

Here you can select for editing one of the existing plans or create a new one.
To create a new plan select from the list one of the options:

» Add New Light Frames Plan

* Add New Dark Frames Plan

* Add New Flat Frames Plan

* Add New Bias Frames Plan

» Add New Focusing / Framing Plan
* Add New Dark Flats Plan

This will create the corresponding plan and will give possibility to edit it.

o Plan Name
M78



Allows entering the name you want to use for the selected plan.

Delete Plan

Makes a copy of the current plan with possibility to change the type and loads the new one for editing. This is an
easy way to create matching light and dark plans.

° Plan list

List of the defined exposures. Click on the line that you want to edit, move or delete. The parameters of the
selected line are loaded in "Add / Edit Exposure" section.

The columns are:
* Order
» Exposure duration
* Binning
 Pause duration
» Count of the exposures
* Filter

a Down

Down

Moves the selected line one position Down.
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0,

Moves the selected line one position Up.

o Plan duration

Shows the expected plan duration. If the current plan is Light type it will show the total light duration that will be
gathered.

0,
Deletes the selected line from the plan.
Ringy Thingy

Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

o Exposure

Defines the duration for every exposure that will be executed by this plan line. Use a duration supported by your
camera. The duration is in seconds or fraction of a second.

If the exposure duration is 0, the line will make just pause and/or will execute defined Script or Command.

e Binning

Defines what binning to use for the exposures in this plan line. Use an binning supported by your camera. If you are
not sure, make a connection to the camera and check the values available in the Bin list in Camera Tab.

Tips & Tricks: Most likely you are using symmetric binning - 1x1, 2x2, 3x3, so you can enter only 1, 2 or 3 in the
Binning field. APT will fill automatically the other dimension.

o Pause

Defines the pause in seconds that have to be made between every exposure from this imaging plan line.
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a Count

Defines how many images to take by this line of the imaging plan using the defined parameters.

@ Filter

The filter to use for this line of the imaging plan. Use the option "No Change" if you don't use Filter Wheel or don't
want to change the filter.

In order to change filters a connection is required to the Filter Wheel during the plan execution.

If the filters are described in Filter Wheel settings tab or if there is active connection to a wheel then the list will show
the filter names. In other case the list will contain only position numbers like "Filter 1", "Filter 2"...

o Update current button

Updates the selected line with the parameters set in "Add / Edit Exposure" section.

o Add as new button

Adds a new plan line after the selected one using the parameters set in "Add / Edit Exposure" section.

o Script or Command

Allows executing an internal APT command or external script / application. See the Scripts and Commands section.

@ Wait script end

When selected APT will wait the external script or application to finish before continuing the execution of the plan.
For the internal commands APT always wait the execution to complete.

See the Scripts and Commands section.

@ No dithering

If the current plan is Light Plan, allows to disable the Dithering for this plan only.
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a Vertical plan

Allows controlling the plan execution order. When it is unchecked, APT will take all exposures for the first line and
then will continue with the next line. When it is checked the execution order will be:

Line1->Exposure1, Line2->Exposure1... LineN->Exposure1
Line1->Exposure2, Line2->Exposure2... LineN->Exposure2
Line1->Exposure3, Line2->Exposure3... LineN->Exposure3

Line1->ExposureX, Line1->ExposureX... LineN->ExposureX

The vertical mode is useful if you want to make HDR eclipse images, or when filter wheel is used and you are not
sure that weather will permit to gather all channels one after another.

e Import/Export

Export allows to save one or more imaging plans in new file, while Import gives possibility to add saved plans in
addition to the current set or overwrite all plans.

Scripts and Commands

The Plan editor provides advanced control over the imaging session. It is possible to execute internal APT commands or
external scripts and programs after exposure end. Enter the command that you want to be executed in the field “Script”. If you
check the box “Wait script to end” the execution of the script/program will be synchronous and APT will not continue with the
next exposure until the end of the external operation. Leaving it unchecked APT will execute the command asynchronously
and will continue with the plan as soon as the script/program is started. The internal APT commands are executed always
synchronously.

In order easily to see which lines in a imaging plan has advanced behavior, they are marked with apostrophe (') character. You
can see this in both Plan Editor and in Camera Tab.

You can combine the scripts/commands with 0s exposures. This allows executing a script/program or command without taking
an image for example - to rotate to dome or to close the roof in the plan end.

In this example the lines 2 and 4 are set to execute internal commands without making exposures:

APT has a dedicated editor for Scripts and Commands which saves the need to format manually the required parameters.
It also gives a short information about every command. To open this editor click on the button "Script or Command" in Plan
Editor. The screenshot below shows a formatted command for GoTo with Ra/Dec populated using the Object Browser.
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Here is the list of the supported internal APT commands and their parameters. Note that hash (#) is required in order to
determine that you want to execute internal command

* #CCDGain - changes the CCD/CMOS Gain to a new integer value.
Syntax: #CCDGain Number

* #CCDCool - Cools the CCD/CMOS. Without parameter or with Auto uses the settings set in Cooling Aid. XX.X
sets the target cooling temperature. The parameter A-XX.X will sets cooling to XX.X below the ambient temperature.
Requires a temperature sensor to detemine the ambient temperature.

Syntax: #CDCool XX.X/auto/A-XX.X

* #CCDWarm - Warms the CCD/CMOS. Without parameter uses the settings set in Warming Aid. XX.X sets the
target warming temperature. Auto uses a temperature sensor to set the target.
Syntax: #CCDWarm XX.X/auto

* #CCDOffset - changes the CCD/CMOS Offset or Black Level to a new integer value. Works only when native
ZWO or AltairAstro connection is used.
Syntax: #CCDOffset Number

* #GoTo++ - Goes to the given coordinates using PointCraft and GoTo++. If Guide Control is enabled will command
completion the guiding will be re-engaged. The first parameter defines how many seconds to be the exposures for
the GoTo++. Auto will use the exposure defined in the Camera Tab or the default exposure set in PointCraft settings.
The second parameter defines what solving to use for the first exposure. If the scope is not aligned you can select
Blind solving for the first step of GoTo++, next steps will use Near solving (if PlateSolve2 is installed). Follows the
RA and Dec which can be in any valid format (XX.X or hh:mm:ss/dd:mm:ss).

Syntax: #GoTo++ XX/Auto Blind/Near RA Dec

* #GoTo - Goes to the given coordinates. RA and Dec can be in any valid format (XX.X or hh:mm:ss/dd:mm:ss). If
Guide Control is enabled will command completion the guiding will be re-engaged.
Syntax: #GoTo RA Dec

* #GoToOffset - Goes to an offset from current position. The offset is in arc-minutes from current RA/Dec position. If
Guide Control is enabled will command completion the guiding will be re-engaged.
Syntax: #GoToOffset RAoffset DecOffsed

* #GoToAltAz - Goes to the given Altitude/Azimuth coordinates. Alt and Az are in degrees. If Guide Control is
enabled will command completion the guiding will be re-engaged.
Syntax: #GoToAltAz Alt Az
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* #GuideControl - Stops or starts guiding (currently PHD only). When the guiding is starting, define a pause in the
imaging plan line to give some time the guiding to stabilize.
Syntax: #GuideControl Start/Stop

* #Loadlmage - Loads an image. The parameter is the image full path and file name or the word "Auto". Use "Auto"
to load the last take image. If no image is taken in this session yet, will be loaded the last take image from the
previous session.

Syntax: #Loadlmage PathName/Auto

* #NextPlan - Defines plan that the be executed after completion of the current plan. This command just defines
next plan, it will not be executed before current plan completion, so there is no problem to use the command in
Vertical plans. Note that if there are more than one plan with same name, will be executed the first one found in the
plans list.

Syntax: #NextPlan PlanName

* #Park - parks the scope.

* #Pause - Makes pause shows defined message and waits for resuming the plan execution.
Syntax: #Pause Message

 #RotatorPos - Sets the rotator position to the given angle in degrees.
Syntax: #RotatorPos X.XX

» #SetObjName - change the object name. Affects the storage folder name if Object Name is part of the naming.
Syntax: #SetObjName NewName

* #SolveSync - Uses PointCraft to make Near or Blind plate-solving and then Sync the mount to the found
coordinates.
Syntax: #SolveSync Near/Blind

* #SolveGoTo - Uses PointCraft to make Near or Blind plate-solving and then go to the found coordinates without
making synchronization. Useful in combination with #Loadlmage command. If Guide Control is enabled will
command completion the guiding will be re-engaged.

Syntax: #SolveGoTo Near/Blind

* #Shutdown - Without parameter shutdowns the computer. If there is optional parameter makes the one of the
desired action.
Syntax: #Shutdown restart/standby/hibernate

* #Tracking - Enables or disables mount tracking
Syntax: #Tracking On/Off

* #UnPark - unparks the scope.

If the mount is not supporting movements by Alt/Az coordinates APT will convert them to RA/Dec for current time and for the
current Location.

Tips&Tricks To make easier the use of #GoTo in combination with Object Browser, use Shift+Click on the OK button
in the browser. This will store in the clipboard ready to use #GoTo with the coordinates of the selected object.

In case you want to execute external script or a program there are some parameters that you can send:

%L astFile% - the path and file name of the last saved image
%CurrExp% - the number of the current exposure

%TotalCount% - the total count of exposures to make in a plan
%EDuration% - the expected remaining duration (00X’ or 00X”)
%ETime% - the expected time when the plan will end

%PCBat% - the PC battery percent

%CamBat% - the Camera battery percent

%CamSpace% - the free space on the camera card

%EXifT% - the temperature reported by EOS Exif or by the CCD/CMOS
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%Temp% - the temperature reported by external sensor
%Hum% - the humidity reported by external sensor
%DewP% - the dew point reported by external sensor
%RA% - the right accession reported by telescope
%DEC% - the declination reported by telescope
%O0bj% - the entered object name

%FocalLen% - the entered focal length

%FilterPos% - the current position of the filter wheel
%FocusPos% - the current position of the focuser
%ImageY % - the image height

%lmageX% - the image width

%Pixel% - the pixel size

%Lat% - the site Latitude

%Long% - the site Longitude

%SQM% - the Sky Quality value

%ALT% - the altitude reported by telescope

%AZ% - the azimuth reported by telescope

Example : test.vbs %LastFile% %CurrExp%
This will try to execute the script test.vbs (if there is no path the script has to be located in the APT folder) and will pass path

is file name of the last take image as first parameter and the number of the exposure as second one.

Tips&Tricks If a pause is defined it will be executed after execution of the command or script.

Settings
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.
The settings are grouped in tabs for easier location.
Main
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.
The Main settings tab contains the most general settings related to APT behavior.

,° Live View Automation

Automation Max 150

Skin color n-_,__ .
Status Position e" -
0Old Style Interface a
Tooltips °" P
/’/ /
7
No Tumbs e
e
s
Mo Folders °/ /
Sample Path a /

Sample Name

. n° Mirror Lock Automation
\\
\\

. n KMTronic shutter cable
.

o Skin color

APT has six skins :
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Red

Green

00:13

Light Grey

White
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Astro Photography Tool - APT v3.57

© Incanus Ltd. 2009-2018

Astro Photography Tool - APT v3.57

& Incanus Ltd. 2009-2018

Status —Status —LiveView /
C C
Ea .o, Ea .o
=¥ TA o= P
@ & : 119.84 GB free ¥ 5 : 119.84 GB free
Filter: M/A Filter: N/A
PHD2 State: NC PHD2 State: NC
Sky Quality: N/A ... Sky Quality: N/A ...

Moon Phas Moon Phase: ()

00:15 w

Note that after skin change there is need to restart APT.

o Status Position

Status Panel Position ; Auto

Depending on the screen aspect ratio APT can place the Status Panel on different places in order to use the screen
place better and show bigger preview image. When Auto option is selected on wide screens the Status is vertical in
left of Image Preview like it is in the Main Screen image, On 4:3 screens it is horizontal under Image Preview. The
other options defines the desired position no matter the screen ratio.

This option can useful when APT is running on one computer and remote connection is made on other with
different screen ratio. Or when APT is running mainly in window mode and you want different arragment.
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E 171m W

e Old Style Interface

When enabled APT will use the old approach of interface which includes total control over screen that doesn't allow

to see taskbar and also use small floating screen when is minimized (see Minimized mode). This mode has some
problems under Windows 10.

o Tooltips

Enables/Disables the Tooltips (balloon) help. When enabled you can point a button, list, label and etc. to get a short
help.

Sample:

Plan : M78

Exposures in Plan

f the
that are defined in the
Plan. Double click open
Editor.

o No Tumbs

When enabled APT will not generate/show thumbnail images in Img Browser Tab.

o No Folders

When enabled APT will show in Img Browser Tab only the names of the image and will hide the folders. When
disabled the list will contain both the images and the folder.
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o Mirror Lock Automation
When enabled APT will take care managing the state of Mirror Locking custom function in EOS camera menu.
Note: Magic Lantern takes control over the Mirror Locking function and makes it un-accessible for APT. You will

have to uninstall Magic Lantern or will have to enable/disable Mirror Locking function manually from the camera
menu.

o Live View Automation

When enabled and LiveView is activated APT sets some parameters in Camera Tab (depends on the APT mode) in
order to get maximum sensitivity.

DSLR mode:
Sets ISO to maximum (or the defined Automation Max ISO)
Sets Exposure to 30s

CCD/CMOS mode:
Sets binning to maximum

When LiveView is stopped the parameters in Camera Tab are restored to their previous values.

Disable this option if you don't want APT to change the Camera Tab settings on LiveView start.

o Automation Max ISO

Defines the maximum ISO to set for LiveView Automation. Some modern DSLRs support extremely high 1ISO
values which are useless for astro needs. Using this option you can limit the ISO. Empty value or 0 defines to use
the maximum supported by the camera.

o Images Path

Defines the folder where image files are to be stored. Any existing local or network folder can be used.

o KMTronic shutter cable

Defines that the selected Long Exposure serial/shutter cable is based on the KMtronic USB Relay board. This cable
is very easy to be made. Instructions can be found here

a Select Folder
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Opens a dialog box that allows selecting an existing Images Path folder.

e Files Grouping

Defines how you want to group the image files. It opens a dialog box where you can include and exclude the sub-
folder to be used to organize image files.

The button "->" includes an item, "<-" excludes an item. Up/Down change the order.
The items marked with * are mandatory.

When you click on OK take a look on "Sample Path" to see how the folder structure will look like.

0 Name Parts

Defines what you want to include in the name the image files. It opens a dialog box where you can include and
exclude name parts.
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The button "->" includes an item, "<-" excludes an item. Up/Down change the order.

The items marked with * are mandatory and at least one item with ** should be used.

When you click on OK take a look on "Sample Name" to see how the image names will look like.

o Sample Path

Shows how the folder structure will look like depending on the items selected in Files Grouping dialog box.

o Sample Name

Shows how the image filename will look like depending on the items selected in Name Parts dialog box.

Export Log File

APT logs various information about the program behavior and usage. In case of problem use this button to save the
Log file somewhere and then send it to the APT support.

Backup Settings

Backups all APT settings. The file can be used to setup identical configuration on other machine or just for backup.
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Restore Settings

Restores the settings previously saved to a file.

Import Tooltips

Allows easily importing translated to other language tooltips help. Starting from version 3.40, during the installation
APT will not overwrite the applied tooltips translations so you have to re-apply them only when there is a new
edition of the translated help.

CCD
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.

The CCD/CMOS settings tab contains options related to CCD/CMOS mode.

Color Fits Preview ° a Red Channel Color Balance
Bayer Filter a_

TT— — -G Blue Channel Color Balance

Auto Connect Camera ei,
Higher Compatibility °—_,_ _
QHY LiveView Fix o— —
Disable Min Exposure G""_

Auto CCD Prafile 0
Remember binning °

Remember Gam
Manage Gain a/

Hide Locatmn gy
e Disable Auto Orientation Camera name Check Camera Temperature

Apply BZERO

e a
Stop Initial Coall
/ m op Initial Caoling

-
,

o Color Fits Preview

Enables / disables the color FITS preview in the "LiveView / Image Preview" panel. There is need to select the
corresponding Bayer matrix configuration from Bayer Filter list.

Note - this affects only the image preview and is not altering the saved images.

o Bayer Filter

Defines the Bayer matrix configuration to be used by the de-bayering algorithm.

o Auto Connect Camera
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When enabled, upon starting APT will try to make a connection to the last used CCD/CMOS camera.

o Higher Compatibility

Enable this option if you have problems in using your CCD/CMOS camera.

o QHY LiveView Fix

Enable this option if you are experiencing problems with LiveView using QHY camera.

o Disable Min Exposure

Disables the usage of the minimal exposure duration value reported by the ASCOM driver or INDIGO / INDI . This
is work-around for some cameras which report wrong value that doesn't allow flats making.

o Auto CCD Profile

If enabled, on CCD/CMOS camera connection, APT will read and calculate the pixel size, sensor with and height
from the camera driver. The value will be populated in the Tools tab for usage in the Object Calculator, Object
Browser and PointCraft.

o Remember binning

If enabled the binning set in the Camera tab will be remembered between the APT sessions.

o Remember Gain

If enabled the Gain value entered in Camera tab will be remembered between the sessions and will be set
automatically on camera connection.

m Manage Gain

If enabled the Gain value in Camera tab and per filter values defined in Filter Wheel setting tab will be set in the
camera before every taken image. During LiveView or Shoot image will be used the value Camera tab. During plan
execution if there are values defined in Filter Wheel setting tab they will be used with higher priority.

If disabled the Gain value in Camera tab and per filter values defined in Filter Wheel setting tab will be ignored.
The Gain value control is left completely to the camera driver and driver settings.
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o Hide Location

If enabled the site location entered in Location Settings tab will not be stored in the FITS files.

a Apply BZERO

In very rare cases is possible to need enabling this option. Don't enable it without a reason!

@ Disable Auto Orientation

Disables the auto-orientation of the FITS files. Some cameras like QHY 10 MkIl need this option to be enabled in
order APT to save the images correctly.

a Red Channel Color Balance

Defines the how to scale the red channel in order to color balance the color FITS data. For example 0.5 will divide
the red channel values in half. After changing this value you have to reload the current FITS file to see the effect.
The Green channel is constant, so to color balance the images you have to find the suitable for your camera red
and blue channel scaling factors.

Value 1.0 means no scaling.

@ Blue Channel Color Balance

Defines the how to scale the blue channel in order to color balance the color FITS data. For example 1.5 will
multiply the blue channel values by 1.5. After changing this value you have to reload the current FITS file to see the
effect. The Green channel is constant, so to color balance the images you have to find the suitable for your camera
red and blue channel scaling factors.

o Auto Stretch Factor

Defines the factor that is used by the Automatic Histogram stretching in CCD/CMOS Histogram mode. The values
are between 0.000 and 1.000. The bigger value means more aggressive stretching. The default value is 0.150

o Binning limit

Defines the maximum usable binning value to be available for LiveView Automation and for imaging. Some
cameras support high binning options that are rarely used and by this option you can hide the values that are not
used. There is need to reconnect the camera in order changes to be applied.
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Leave the value empty to use the full range of supported by the camera binning options.

o Cooling Delta

Defines the acceptable difference between the camera and target temperatures in Cooling/Warming Aids.

Some cameral/drivers have difficult times with sub-degree values and require Delta 1.0 or more in order Cooling/
Warming Aids to work correctly. Don't change this value if you don't have problems.

@ Stop Initial Cooling

When enabled APT will stop the automatic CCD/CMOS cooling that most cameras make on connection time. This
allows using the Cooling Aid in Camera tab to make smooth cooling.

Note that cooler will remain turned ON, but will not make cooling.

a Open Cooling Aid

When enabled APT will open the Cooling Aid on camera connection for easier cooling start.

a Check Camera Temperature

Enables / Disables checking if the camera temperature is above the defined limit on imaging plan start. Helps to
avoid imaging with un-cooled camera.

@ Camera name

Replaces the camera name reported by the camera driver with the given value. The name will be used in the FITS
header, Filename and Camera tab.

Temperature & Sky
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.

The Temperature & Sky settings tab contains options related to temperature and sky quality tracking.
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o Sky Quality Tracking

o Temperatures in C/F

Defines how to show the temperature values — in Celsius or Fahrenheit.

o Refocus Notification

Defines when you want to be notified that there is need to refocus. When your telescope or lens is focused, click on
the button Set Focus Mark in Tools Tab to set focus mark on the temperature that focus was achieved. For example
if 4° is selected, when APT detects change of 2° (half of the defined value), the temperature reading in top of the
APT main screen will start flashing to show that soon there will be need to refocus (in minimized mode there will be
flashing “F” letter). When APT detects change of 4°, the temperature will be displayed with bright font and message
will be printed in the Log panel than there is need to refocus (in minimized mode there will be non-flashing “F”
letter). The value 0° disables this feature. Required is external Temperature / Humidity Sensor.

Tips & Tricks. Don'’t forget to click on the “Set Focus Mark” button every time you focused to place the “Focus Mark”
on the right temperature reading.

o Dew point Notification

Defines when you want to be notified for closing the dew point. There is no need to heat your optics when the
dew point is not even close. For example if 4° is selected, when APT detects that dew point is on 2° or less from
the current temperature, the DewP reading in top of APT main screen will start flashing (in minimized mode there
will be flashing “D” letter). When APT detects that temperature dropped under the dew point, the DewP reading
will displayed with bright font and message will be printed in the Log panel (in minimized mode there will be non-
flashing “D” letter). The value 0° disables this feature. Required is external Temperature / Humidity Sensor that is
able to measure the humidity.

Tips & Tricks. To get more accurate readings, place the sensor close the objective, but not on the heating strips.

You have to experiment when you have to start the heating. It depends on your heating solution, telescope size and
etc.

91



o T Calibration

Allows entering a calibration value that to be added or subtracted from sensor readings.

o Humidity Calibration

Allows entering a calibration value that to be added or subtracted from sensor readings.

o APT Focuser

Hardware project that has temperature and humidity sensors. Not available yet.

o Temper(Hum)

Instructs APT to use the readings from the attached Temper or TemperHum sensor. For more information see
Temperature / Humidity Sensors.

o USB Dewpoint

Instructs APT to use the readings from the attached USB_Dewpoint sensor. For more information see
Temperature / Humidity Sensors.

o No Sensor

Instructs APT that there is no additional external sensor. APT will still use the readings from the ASCOM / INDIGO /
INDI compatible focuser if they are available.

For more information see Temperature / Humidity Sensors.

o Sky Quality Tracking

Defines if you want to use the Sky Quality Tracking system in APT. The sky quality tracking can be made automatically
by using the Unihedron SQM or compatible devices and manually by observer's estimation of the limiting magnitude
or by using the SQM-L manual device. More information about supported devices see Sky Quality Meters

When the Sky Quality Tracking system is enabled you can use Graphs to monitor the value changes through the
imaging session, to use the readings as part of the image file name - see Name Parts in Main Settings tab. Also the
readings will be stored in the FITS files.
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MPSAS

Defines MPSAS (magnitudes per square arc second) as default sky quality metrics to use in Status panel, for the

value entered in Sky Quality Calculator when SQM-L or manual entry is selected and for storing in FITS files.

NELM

Defines NELM (naked eye limiting magnitude) as default sky quality metrics to use in Status panel, for the value

entered in Sky Quality Calculator when SQM-L or manual entry is selected and for storing in FITS files.

SQM-L

Defines that you want to use your estimation, SQM-L or compatible device to measure and track the sky quality.
After that you have to use the Sky Quality Calculator enter the value you have determined.

More information about supported devices see Sky Quality Meters.

SQM-LU
Defines that you want to use SQM-L, SQM-LU-DL or compatible device to measure and track the sky quality.

When this option is selected there is need to define how often to read the sky quality value and to which port is
connected the device in the section that will become visible.

If you are using mySQM or other device that needs slower COM port speed, enable the option "Slow COM Port"

More information about supported devices see Sky Quality Meters.

SQM-LE

Defines that you want to use SQM-LE or compatible device to measure and track the sky quality.

When this option is selected there is need to define how often to read the sky quality value and the IP/Port of the
device in the section that will become visible.
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More information about supported devices see Sky Quality Meters.

Location
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.

The Location settings tab contains the options related to your site coordinates and possibilities to synchronize them. It is

important to define the coordinates because they are used by Darkness Clock, Deep Sky Darkness Calculator, the filter of
visible objects in Objects Browser and checking if object is above horizon on GoTo.

Hemisphere o\
.,
\\\
s @

~ N
Location a e
Site Name o_ .
Latitude o -
Longitude e -
Elevation °’ -

Time Zone °'

o Hemisphere
The hemisphere you are in.
- -

Is daylight time saving currently in effect. If "Auto" is selected APT will manage the "DST" setting using the
Windows settings

o Location

List with the stored locations. Supported are up to five locations. Select the site you want to use/edit.

o Site Name

The site name.
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o Latitude

The site Latitude. Accepted is any format. The GPS format of the entered value is displayed in italics.

o Longitude

The site Longitude. Accepted is any format. The GPS format of the entered value is displayed in italics.

o Elevation

The site elevation in meters.

o Time Zone

The site time zone.

o No Sync

The current site coordinates will be used only in APT.

o Import

The current site coordinates will be updated with the coordinates provided by the telescope as soon as it is
connected.

o Export

The current site coordinates will be used to set the coordinates of the telescope as soon as it is connected.

Note: If you want to export location information to EQMOD/EQASCOM you have to enable the option "Allow Site
writes". To open the EQMOD settings panel use either:

APT > Gear tab > Shift-Click Connect Scope > ASCOM Telescope Chooser > EQMOD ASCOM HEQ5/6 >
Properties

or
Windows Menu > EQMOD Toolbox > Driver Setup
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o Export Time

When enabled will export the current time the PC clock to the ASCOM driver synchronizing telescope time.

Scope & Focuser
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.

The scope and focuser settings tab contains options related to telescope mount and focuser.

Auto Connect Scope e /° Inwards backlash
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.
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TP Backiash Aid Averagiﬂﬁa/ Reading fr
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Inwards move Reverse maves

o Auto Connect Scope

When enabled on starting, APT will try to make connection to the last used telescope/mount.

Hide Meridian
Flip Clock

When enabled the Meridian Flip clock will be visible only when there is active connection to telescope in Gear tab

o Above Horizon

When enabled before any GoTo command, APT will make a check if the target coordinates are above horizon. If
the object is below horizon you will be asked to confirm the move.

o LX200 Mount

When enabled will force APT to use the LX200 communication protocol over the ASCOM connection.
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o Force GoTo Flip

Some mounts support command to change the side of the scope according to the tripod/pier. This command is
handy during Automated Meridian Flip, however sometimes the mount refuse the change the side. If such problem
occurs, enable this option and SessionCraft will use appropriate GoTo command to complete the task.

o Fast Speed

Defines the fast speed of telescope moving (degrees per second) when N/S/E/W buttons are used in the Gear tab.
Leave empty to use the default speed. Note that some value may not be supported by the mount or by the driver.

o Slow Speed

Defines the slow speed of telescope moving (degrees per second) when N/S/E/W buttons are used in the Gear tab.
Leave empty to use the default speed. Note that some value may not be supported by the mount or by the driver.

o Auto Connect Focuser

When enabled on starting, APT will try to make connection to the last used focuser.

o Meade Focuser

When enabled will show the special section in the Gear tab for using Meade focuser. In this case you don’t need to
make a connection using “Connect Focuser” button. Requires APT restart.

m Arduino Focuser

Enable this option if you are using an Arduino based focuser which has integrated humidity sensor. Requires APT
restart.

o Inwards move

When enabled, every focuser position change will be finished with a move in inwards direction in order to minimize
the influence of the backlash or the mirror flopping. To achieve that if the move is outwards, APT makes a bigger
move and after that gets back to the desired position from inwards direction. The amount of that move is defined by
"Final inwards move steps".

o Backlash Aid
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Opens the Backlash Aid. It helps to measure the backlash of Crayford / Rack & Pinion focusers.

@ Reverse moves

When enabled the will send reversed Inward/Outward commands.

0 Inwards backlash

Defines now many position steps is the inwards backlash of the focuser that has to be compensated when focuser
changes the move direction from outwards to inwards. 0 means no backlash.

o Outwards Backlash

Defines now many position steps is the outwards backlash of the focuser that has to be compensated when focuser
changes the move direction inwards from to outwards. 0 means no backlash.

a Internal Counter

Enable this option if you want to hide the backlash compensation moves from the focuser position. In this case APT
will use its own position counter and its value will be visible in the Gear tab. When is disabled position value will
include the backlash moves.

o Flop Correction

When enabled the inward and/or outward backlash define what moves are needed to compensate the mirror flop of
Schmidt-Cassegrain / Maksutov telescopes when focuser changes the move direction.

o Emulate Positions

Enable this option if you have focuser that doesn't support positions. APT will emulate positions focuser.

@ Remember Position

When enabled APT will remember the emulated position value between the session. It is useful for permanent
setup.
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@ Step emulation

Defines how many steps/pulses will correspond to one emulated focuser position.

e Temperature Compensation

Enables the temperature compensation. It helps to compensate the focus point changes cased by the changes in
the ambient temperature. Note that temperature compensations will not be applied when Focusing Aid, Auto Focus
Aid or Bahtinov Aid are open.

a Real-time compensation

Enable this option if you want the temperature compensation to be applied even during image exposures. Disabling
it will apply compensations only when there is no image in progress.

@ Temperature Source

Defines which sensor to use for determining the ambient temperature. Supported are focuser's internal sensor,
external sensor or combination of both. The last option will average the readings of the internal and external
SEnsors.

g Steps per Degree

Define how many steps to change per one degree drop in the temperature. Positive value defines outwards move,
negative defines inwards move. APT works with high precision corrections and support even compensation with
fraction of one position.

@ Reading frequency

Defines the frequency of checking the ambient temperature.

@ Averaging

Defines how many reading to average before calculating the needed temperature compensation. Averaging
helps to avoid short temporary changes caused by wind. Frequency 10 combined with Averaging 60 will make
temperature compensation on every 600s (10x60 = 600s -> 10 minutes). Note that telescopes can't react fast on
the temperature changes, so it not advisable to make corrections in very short intervals.

Filter Wheel
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The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.
The filter wheel settings tab contains options related to filter wheel. Here you can enter the filter names and focus offset for the
filters mounted into your wheel. Describing the names here allows APT to show them in the Plan Editor and in the Camera tab
(the selected plan table) rather than using the filter position number. This tab is required for SBIG and manual wheels, but it
will be more comfortable for you if you enter the information even if you use ASCOM / INDIGO / INDI compatible wheel.

Note that if there are values in this tab APT will ignore the values entered in the properties of the ASCOM driver.

FiIterNamen Focus Offset ] KB (Gain
o

o Clear All 5 N .\o Pause for Manual change

- ™
Moravian Filter Wheel o Check for connection

o Filter Name

Defines the filter name you want to use.

o Focus Offset

Defines the focus offset that you want to apply when this filter is selected. Not all filters are para-focal, so if you
measure the exact difference in the focus between the filters (in steps of your focuser) it can save you the refocusing

on every filter change. To use this feature you need Focuser connection and enabled "Adjust Focuser" in Filter Wheel
section of Gear tab.

The value 0 means that there is no offset.

The focus offset has not thing with the black level/offset.

o Gain
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Defines the gain value that you want to apply when this filter is selected. Empty value means that gain value should
not be changed. This value will be used with priority during imaging plan. During LiveView or Shoot image if the Gain
value in Camera tab is not empty it will be used with priority.

o Clear All

Clears all values entered in Name and Offset fields.

o Moravian Filter Wheel

Enable this setting if you are using filter wheel made by Moravian Instruments.

o Ignore QSI Profiles

When this option is enabled APT uses the names and offsets set in this tab rather than these set in the QSI driver
settings.

o Auto Connect Wheel

When enabled on starting, APT will try to make connection to the last used filter wheel.

o Manual Wheel / Drawer

Allows usage of manual filter wheel or filter drawer. Enable this option, enter the installed filters names (and
offsets), then click on Connect Wheel button in the Gear tab. The main purpose of this feature is to add the right
filter name prefix in the image filenames for easier processing. It also can be used to adjust the focuser position on
filter change using the entered offset.

o Pause for Manual change

When this option is enabled, APT will show dialog box every time there is need to change the filer of manual filter
wheel or drawer during plan execution. Clicking on OK will resume the imaging.

Note: Give few seconds the guiding to settle after filter change.

o Check for connection

When this option is enabled, on plan start APT will check if that plan is configured to use filters and will warn if there
is no active connection to a filter wheel.
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Sound
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.

The sounds settings tab allows configuring the sounds system of APT. Supported are 36 different events that can use
separate sound using WAV or MP3 file. When a sound file is selected APT makes a copy into special folder, so there is no
need to keep the source file.

Sounds Motifications o
Sounds list o

Select button ° [

Import Package °\\ |

/ ' '. AN

@ o O @ [oLS

Select Existing Female Voice Play Reset All

Export Package e Male Voice o,

o Sounds Notifications

Enables/Disables sound notification for 36 events like device connection/disconnection, plan end and etc.

o Sounds list

List of all supported events, short description and currently selected sounds. To edit an event select the
corresponding line and select a new WAV or MP3 file.

Select button

Opens a dialog box to select a WAV or MP3 file for current event.

Import Package

Opens a dialog box for selection of folder where is stored/downloaded the sounds package you want to import. The
import will copy all sounds to special APT folder, so there is no need to keep permanently the source folder.
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Export Package

Exports the current sounds settings as sounds package for backup or sharing.

Male Voice

Imports a copy of the predefined male voice sounds package. You can use this copy as base of your own package.

Select Existing

Use this list to attach already selected sound to the current event.

Female Voice

Imports a copy of the predefined female voice sounds package. You can use this copy as base of your own
package.

Play

Plays the sound of the currently selected event.

Reset

Resets the sound of the currently selected event. If the attached sound is not used for other event, it will be deleted
from the special APT folder.

Reset All

Resets the sounds of all events. It also deletes the sound files from the special APT folder.

Planetarium
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.
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The planetarium settings tab contains the options related to the integration with the planetarium application you use. This
integration can be used in PointCraft, Object Browser and Gear Tab.

For more information about the integration with planetarium applications see the Planetarium in APT Features section.

o None

No integration will be used.

o Cartes Du Ciel

Connect to and communicate with Cartes du Ciel - CdC (https://www.ap-i.net/skychart/en/start). If CdC is installed

on the local machine enter for IP address 127.0.0.1 and leave the Port to 0. If CdC is on a remote machine set the
IP and Port used there.

Before making a connection, go to CdC -> Setup -> All Configuration Options -> Genera -> Server, enable the options
"Use TCP/IP server" and "Keep client connection active".

Op
Connect to and communicate with Computer Aided Astronomy - C2A (http://www.astrosurf.com/c2a/english/). If

C2A is installed on the local machine enter for IP address 127.0.0.1. The default Port is 5876. If C2A is on a remote
machine set the IP and Port used there.

o SkytechX

Connect to and communicate with SkytechX (http://skytechx.eu/). If SkytechX is installed on the local machine

enter for IP address 127.0.0.1. The default Port is 2055. If SkytechX is on a remote machine set the IP and Port
used there.
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Before making a connection, go to SkytechX -> File -> Setting -> Server tab, enable the option "Run server on startup"
and click on "Start Server".

o HNSKY

Connect to and communicate with Hallo Northern SKY - HNSKY (http://www.hnsky.org/software.htm). If HNSKY
is installed on the local machine enter for IP address 127.0.0.1. The default Port is 7700. If HNSKY is on a remote
machine set the IP and Port used there.

Before making a connection, go to HNSKY -> File -> Setting -> TCP/IP Server tab and enable the option "Use TCP/
IP server".

o Stellarium

Connect to and communicate with Stellarium 0.17 or newer (http://stellarium.org/). If Stellarium is installed on the
local machine enter for IP address 127.0.0.1. The default Port is 8090. If Stellarium is on a remote machine set the
IP and Port used there.

Before making a connection there is need to make some configurations in Stellarium:

1. In Configurations -> Plugins make sure that "Remote Control" plug-in is configured as "Load at startup” (restart
Stellarium after enabling). After that click on "configure" and enable the options "Server enabled" and "Enable
automatically on startup”

2. In Configurations -> Plugins make sure that "Oculars" plug-in is configured as "Load at startup” (restart Stellarium
after enabling).

3. In "Oculars" configuration go to "Sensors" tab and define a new sensor or edit one of the existing. All the needed
data can be found in the Object Calculator (for CCD/CMOS a connection is needed in order to determine the pixels
count). Enter the number of the sensor in the APT settings. The first sensor is 0, the second 1 and so on (the index
is zero based).

4. In "Oculars" configuration go to "Telescope" tab and define a new sensor or edit one of the existing. Enter the
number of the telescope in the APT settings. The first scope is 0, the second 1 and so on (the index is zero based).

Advanced
The APT Settings dialog box is accessible from Tools tab or with Alt+S shortcut.

The advanced settings tab contains the options that are not changed very frequently, but in the same time allow to configure
important or handy features on APT.
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o Plans Start Delay

Defines how many seconds to wait after click on the Start button, before plan execution begins.

o LV Stack Count

Defines how many images to be used in LV Stack.

o Camera Low Space

Defines when to notify you about low camera card free space. 0 disables this notification. The notification is flashing
icon in the Status panel.

o Camera Low Battery

Defines when to notify you about low Camera battery. 0 disables this notification. The natification is flashing icon
in the Status panel.

o PC Low Battery

Defines when to notify you about low PC battery. 0 disables this notification. The notification is flashing icon in the
Status panel.

o Buila Trigger Delay
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Defines the delay to be used for exposure end when the audio trigger is used. The value depends on the cable
implementation. For more information see EOS Shutter Cables.

o Extreme EOS Shutter Delay

Defines the delay needed to store an image on the memory card in Extreme EOS Shutter mode. For more details
see Extreme EOS Shutter mode

o AT ISO

Defines what ISO to be used for the images taken through AstroTortilla. 0 means to use the maximum supported value.

o Histogram Auto-Stretch

Defines the factor that is used by the Automatic Histogram stretching in EOS Histogram mode. The values are between
0.00 and 1.00. The bigger value means more aggressive stretching. Default value - 0.65

o Change folder after midnight

On session start APT creates a folder for the current date and stores all the images in this folder or in sub folders
(depending on the selected grouping options). If you want to keep the images strictly separated by date, enable this
option to create a new folder after midnight.

o Change folder after midday

If enabled an images storing folder for new date will be created after midday. Helps to separate correctly the
images from sequenced nights. For example the nights Fri-Sat, Sat-Sun, Sun-Mon will have overlapping dates mix
the images from the previous and next nights. Enabling the option will generate 3 corresponding folders for the
nights separated by the midday of Saturday and Sunday.

e Bigger Ul Fonts

Defines to use bigger fonts for most of APT interface. This can be handy on notebooks with big screen resolution
and small display.

o Advanced Flat/Bias plans

When selected you will be able to define the duration for exposures in Flat and Bias plans. When it is unchecked,
In EOS mode the Flat plans will use the AV dial mode and will leave the camera to select the exposure; Bias plans
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will use the shortest supported by the camera exposure. In CCD/CMOS mode the Bias plans will use the shortest
supported by the camera exposure.

0 Auto Connect Camera

When enabled upon starting APT will try to make connection to Canon EOS or Nikon camera (if it is in DSLR mode).
Disable this if you want to manage the connection to the camera manually.

@ Remember Effects

When enabled APT will keep the selected Preview Effects between the restarts.

o CR2/NEF to TiFF

When enabled APT will make on fly conversion of the EOS raw files into TIFF format. The original file will not be
deleted. The TIFF file is without ICC profile and compression.

o Don't remember Object Name

When enabled APT will not store the object name (entered in Camera tab) between the sessions.

o Ask for Object Name

When enabled APT will ask to enter Object Name on every start of an imaging plan. It is useful reminder when
object name is part of the file naming or grouping.

Note: Do not use this option of you use the #NextPlan command or your automation will not work unattended!

@ No Camera Clock Sync

When disabled APT will synchronize the Canon EOS or Nikon camera clock with PC clock on camera connection.

@ RDP mouse fix

If you have problems with the mouse cursor when you are using Remote Desktop, enable this option.
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a Determine Lens Focal Length

When enabled APT will try to determine the focal length of the attached to the Canon EOS or Nikon camera lens. If
focal length is found it will be stored in Tools tab Focal Length field for automatic usage from PointCraft and Object
Calculator.

Disable it if you are getting false readings when the camera is attached to a telescope.

a Disable Nikon Dial Check

Use this option if your Nikon camera reports wrong dial mode when lens is detached.

g Broadcasting to GNS

Enables/Disables the broadcasting APT status to Linatico's GNS - Good Night System in order to track the events
on your smart phone and get alarm if something goes wrong.

a Keys Thingy

Allows disabling the Keys Thingy.

Darkness Clock

The Darkness Clock is visible in the Status panel of the Main Screen.

The Darkness Clock shows in real time what the “status” of the sky darkness is. It is focused on nights so it starts from the
today's noon and ends in the tomorrow's noon in order to show all events during the full night.

Double click on the Darkness Clock opens the Deep Sky Darkness calculator.

Take a look on the free (yes, free - no ads or marketing) Androind and iOS versions of the Deep Sky Darkness Calculator -
Darkness Clock
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Astronomical twilight Sunrise to Moon

Moon to Sunset

Mautical twilight

Full darkness

Noon to Sunset

This is the time between midday and sunset.

Nautical twilight

This zone combines the Civil and Nautical twilight.

Astronomical twilight

This is the Astronomical twilight.

Full darkness

If there is no Moon this is the time of the full darkness suitable for imaging deep sky objects.

o Pointer

A pointer that shows the current moment. It will start blinking 15 minutes before a zone change.

o Sunrise to Noon

This is the time between sunrise and midday.

Moon

Shows when the Moon is above the horizon.

Deep Sky Darkness calculator

To open the Deep Sky Darkness calculator double click on Darkness Clock
located in the Status panel of the Main Screen or with Alt+D shortcut.
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The Deep Sky Darkness (DSD) calculator gives possibility to see details for different events in the current or selected night.
Maybe the most important feature of imaging night is time of complete darkness that can be used for collecting data for deep
sky objects. This calculator is mainly focused on this and calls it - Deep Sky Darkness Time (DSD Time). To have DSD the
Moon has to be below the horizon and the astronomical twilight should be already ended or not started yet. The calculator
also allows searching for a night with desired DSD Time.

If narrow-band filters are used, it is possible to gather good signal even when the Moon is above the horizon. Narrow-Band
(NB) section show how much time can be used for imaging between the evening and morning astronomical twilights.

Take a look on the free (yes, free - no ads or marketing) Androind and iOS versions of the Deep Sky Darkness Calculator -

Darkness Clock
Might dates o

Might Bar e
Evening - Moming e-_____
The Moan n

e,
e

Darkness a

e

The total dark time e -
Marrow-band Darkness o’"___

The total Narrow-band dark time e -

-

-

.-"-I-"
Change Might o
ey
coanion @

o Night dates

The dates of the night that is currently displayed. It can be the current or selected night.

o Night Bar

The night bar shows the events in the selected night and the Moon phase. Used is the same events coding as in
Darkness Clock.

o Evening - Morning

111


https://ideiki.com/astro/MobileApps.aspx

In the left column are the selected evening events - time of the sunset, the end of the nautical twilight and the end
of the astronomical twilight which is the actual start of the night.

In the right column are the selected morning events - the start of the astronomical twilight which is the actual end of
the night, the start of the nautical twilight and the time of sunrise.

o The Moon

Here are the Moon events.

* The first line shows the moon rising and setting times in the selected night.

* lllu Range - shows the illumination percent in Moon rise and set moments in the selected night.
» Age Range - shows the age in Moon rise and set moments in the selected night.

* Current lllu - shows the illumination percent in the current moment (uses the computer clock)
» Current Age - shows the age in the current moment (uses the computer clock)

o Darkness

Shows when the when starts/ends the time suitable for imaging of deep sky objects - Deep Sky Darkness (DSD) in
the selected night. DSD = No Moon and twilight.

o The total dark time

Shows how long Deep Sky Darkness (DSD) will be in the selected night. DSD = No Moon and twilight.

o Narrow-band Darkness

Shows when the when starts/ends the time suitable for imaging of deep sky objects using narrow-band filters -
Narrow-Band (NB) in the selected night. NB = No twilight (the Moon is ignored).

o The total Narrow-band dark time

Shows how long Narrow-Band (NB) will be in the selected night. NB = No twilight (the Moon is ignored)

o Change Night

Allows to change the night which events are loaded. The Prev/Next buttons change the date with one day. You can
also enter particular date and press the Enter key to recalculate.

If you press the Enter key on empty edit box, APT will use the current date.
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o Find Night

You can search for the closest night which has Deep Sky Darkness (DSD) Time equal or more to the entered one.
The value is in hours and accepts decimal numbers like 6.5

Object Browser

The Object Browser is accessible from Tools tab,
with Alt+O shortcut and from PointCraft.

The Object Browser can be used to review various information about objects and it is also deeply integrated with PointCraft,
Object Calculator, Command Editor, Planetarium and planning applications

It is separated in several tabs:
» Deep Sky - two fixed lists of deep sky objects - 545 in the short list and 19 596 in the extended list compiled by
Andrew Knight
« Stars - fixed list 78 alignment stars
* Maps - 2 celestial maps
* Custom - user defined or imported objects
» ToDo - a second tab of user defined or imported objects dedicated to keep a shorter list of the planned targets

You can easily search for information in the tabs Deep Sky, Stars and Custom. Just enter the word you are looking for in the
top right corner and click on “Search/Next” to find the next line below the current one that contains the searched word. If the
cursor is still in the input box then pressing Enter key is same as clicking on “Search/Next”.

Double click with left mouse button on an object or selecting a row and click on OK button has different behavior in the following
cases:

« If the Object browser is opened from Gear tab or from Object Calculator the object coordinates will loaded in the
Gear tab - GoTo Ra/Dec, if the object has defined size it will be populated in the Object Calculator and calculation
will be executed. Also the object name will be populated in the Camera tab and depending on the Name Parts / File
Grouping set in Main settings tab, this name can be used for the images naming/storing.

« If Object browser is opened from PointCraft, the object coordinates will be populated in Approximate RA/Dec or
in GoTo++ Ra/Dec

 If Object browser is opened from Command Editor the object coordinates will be populated in RA/Dec fields of
#GoTo command

See the tabs description for more information about the corresponding features.
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Deep Sky

The Object Browser is accessible from Tools tab,
with Alt+O shortcut and from PointCraft.

The Deep Sky tab contains information about 545 deep sky objects - the Messier Catalog, Herschel 400 Catalog, and most
of Caldwell and Hidden Treasures catalogs.

Selecting an object will display information like Name, Constellation, Magnitude, Size and interesting facts about it. The last
column - Size (px) contains the calculated size in pixels for your camera/telescope setup. It will be populated when camera
and focal length are defined in the Object Calculator.

The main sources for interesting facts about the Messier objects are “http://wikipedia.org” and “http://seds.org/messier”/. The
facts for the other objects and all audio recordings are compiled and recorded by Jeff Seivert.

To install the audio extension, download the desired package from the Download page of the APT's site. After that in the folder
where APT is installed create a sub-folder named "ObjectBrowserAudio" and extract the audio package there. The button
"Play" in Object Browser will be available for all objects with audio information.

Enabling the option "Show the extended list" will show 21 198 objects in the list. (Great thanks to Andrew Knight for compiling
it!). Note that on slow computers it cloud take some time to load especially if next option is also enabled.

The option "Show only the visible objects" determines which objects from the list are visible in the current moment. In order
the calculation to be correct you have to enter your observing site coordinates in Location settings tab.

The button "Add in ToDo" adds the selected object in the ToDo tab.

To change the list order click on the column you want to define the order.
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Tips&Tricks Shift+Click on OK button will but in the clipboard the command #GoTo with the RA/Dec of the selected object.

Stars
The Object Browser is accessible from Tools tab,
with Alt+O shortcut and from PointCraft.

The Stars tab contains list of the 78 most popular alignment starts . In Hint column there is short information on how to find
the star in the sky. If you select a star and switch to Maps tab, APT will automatically select the map that contains the star.

You can use these stars to make GoTo aliment. Here is the procedure.

* Make connection to the mount

* Select a star from the list

» Use the Cross and LiveView to center the star
* Click Sync in Gear tab

The option "Show only the visible stars" determines which stars from the list are visible in the current moment. In order the
calculation to be correct you have to enter your observing site coordinates in Location settings tab.

To change the list order click on the column you want to define the order.
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Maps

The Object Browser is accessible from Tools tab,
with Alt+O shortcut and from PointCrafft.

The Maps tab contains two maps with the constellations in both celestial hemispheres and the names of all stars listed in the
Stars tab. To switch the maps use the buttons North/South or select a star from Stars tab.
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Custom

The Object Browser is accessible from Tools tab,
with Alt+O shortcut and from PointCrafft.

The Custom tab gives possibility to enter additional objects as well as importing objects saved by other users or exported by
other applications. Here the columns are similar to these in Deep Sky tab. The last column - Size (px) contains the calculated
size in pixel for your camera/telescope setup. It will be populated when the camera and focal length are defined in the Object
Calculator.

The option "Show only the visible objects" determines which objects from the list are visible in the current moment. In order
the calculation to be correct you have to enter your observing site coordinates in Location settings tab.

To change the list order click on the column you want to define the order.
The interface is intuitive, but let give some hints and information:

- You can use Shift+Click or Ctrl+Click to select multiple lines for deletion.

- Show button shows the selected object in the planetarium application.

- "Add in ToDo" button adds the selected object in the ToDo tab.

- If Camera Angle is populated and there is connection to a Rotator, on OK the value will be populated in the Gear tab.
- The button Export saves all the objects in a file that can be used as backup or to share with friends.

- The Import button can be used to import objects saved in several file formats:

* APT Native format - data exported by other APT users or from the following applications:

1. Mosaic plans created by Asimoplan (mosaic planning software - www.asimoplan.com). Each panel of the
mosaic creates a separate object. When using Asimoplan select the “Application Specific” page in the “Export
Frame Coordinates” window and check the “Astro Photography Tool — APT” check box before clicking the
“Export” button. Once imported each frame's object contains that frame's central RA and Dec coordinates.
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Double-clicking any listed frame transfers those coordinates to the Gear tab or in PointCraft GoTo++ where
they can be used to slew the connected telescope into position for imaging.

2. Lists from AstroPlanner (http://www.astroplanner.net/). In AstroPlanner go to “File” menu then “Export” and
select “APT Obiject List...” option.

3. Lists from Deep-Sky Planner (http://www.knightware.biz/) In Deep-Sky Planner go to “File” menu then
“Export” and select “Export APT...” option.

4. For Object lists shared by APT users check the following topic in APT forum - http://aptforum.com/phpbb/
viewtopic.php?f=19&t=147

* Telescopius/DSO-Browser format - data downloaded from the site www.telescopius.com / www.dso-browser.com

* Lists in .COS and .C2A formats saved from Computer Aided Astronomy- C2A (http://www.astrosurf.com/c2a/
english/).

* Observing lists from Cartes du Ciel - CdC (https://www.ap-i.net/skychart/en/start)

* Frames lists from Cartes du Ciel - CdC (https://www.ap-i.net/skychart/en/start). This allows creating mosaics frames,
for more information see http://aptforum.com/phpbb/viewtopic.php?f=17&t=1958

* Direct import of multiple frames / mosaic from Hallo Northern SKY - HNSKY (http://www.hnsky.org/software.htm)

* Direct import of mosaic frames from Cartes du Ciel - CdC (https://www.ap-i.net/skychart/en/start) while the Mosaic
tool is open

Tips&Tricks Shift+Click on OK button will but in the clipboard the command #GoTo with the RA/Dec of the selected object.

118


http://www.astroplanner.net/
http://www.knightware.biz/
http://aptforum.com/phpbb/viewtopic.php?f=19&t=147
http://aptforum.com/phpbb/viewtopic.php?f=19&t=147
https://www.telescopius.com
http://www.dso-browser.com
http://www.astrosurf.com/c2a/english/
http://www.astrosurf.com/c2a/english/
https://www.ap-i.net/skychart/en/start
https://www.ap-i.net/skychart/en/start
http://aptforum.com/phpbb/viewtopic.php?f=17&t=1958
http://www.hnsky.org/software.htm
https://www.ap-i.net/skychart/en/start

When "Add New" or "Edit" is clicked the section "Object Details" becomes like the one on the next screenshot.

Here are some useful features:
« If you have used the Store button in PointCraft, the RA, Dec and Camera angle fields will be populated with the
results from the last plate-solving.
« If you are creating a new object and there is connection to the telescope, you can use the button "Get Scope Ra/

Dec" to populate the Ra/Dec with the current telescope position.
« If there is connection to your planetarium application, you can use the button "Catch RA/Dec/Angle" to populate
the Ra/Dec (and if it is possible the Angle) from the planetarium.

ToDo

The Object Browser is accessible from Tools tab,
with Alt+O shortcut and from PointCraft.

The ToDo tab gives possibility to define second list of objects different from the one in Custom tab. It was built as place to the
objects planned for imaging in the next sessions.

The look and the behavior is the same as Custom tab, so please refer it for details.

Object Calculator
The Object Calculator is accessible from Tools tab.
The Object Calculator is combination of built-in data bases and formulae that allow computing various parameters of your
imaging setup (like FOV, size, resolution etc.) without need to enter "hard to find data". It also can help to export the FOV size
to your Planetarium application for easier target selection and frame orientation (see Planetarium section).
APT contains one database with all Canon EOS and Nikon models and their specifications. Also it has database with 545 deep

sky objects in the Object Browser. Combining them it is possible to see what is you Field-Of-View (FOV) size, the size of an
object in pixels or to see how big the object will be into your frame!

/° Recalc

CCD params o
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On camera connection APT will automatically select the Canon EOS or Nikon model (or the option "CCD/CMOS Camera") in
the list box "Camera". Also you can select any model if you want to make a comparison. The other value you have to enter (for
CCD/CMOS there is need to enter the sensor and pixel size one time only) is the telescope or lens focal length.

Click on Recalc button will make the calculations and print the results (and the sensor properties) in the Log panel. If you
select an object from the Object Browser, or if you enter object size in arc-minutes, there will be information about the expected
size in pixels too.

Here is sample with selected M78 (from the Object Browser) for QHY22 CCD camera and focal length 1000mm:

And the same calculation for EOS 6D:

Also in the main screen Preview Area you will see how big the object will be into your image:

o Camera Model

Camera ; CCD Camera

The list of all Canon EOS and Nikon models plus possibility to select a CCD/CMOS. The Canon EOS/Nikon model
or the CCD/CMOS option is automatically selected when connection is established.

o Recalc
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Makes new calculation with the current camera model, focal length and object size.

If you use the Shift+Click on the Recalc button (or Alt+W shortcut), APT will collect information about the FOV size, the
current telescope coordinates (if connected), the rotator position (if connected) and then to send it to the connected
Planetarium application to show you where the telescope is pointed in a bigger context. If there is no telescope or
rotator connection it will still show the FOV size.

o Focal Length

Enter the focal length of your telescope or lens to use for calculating the Field Of View (FOV) and the resolution arc-
second per pixel. If you are using Canon/Nikon lens, APT will read the current lens focal length after each exposure
and will update this value automatically.

The button "..." allows creation/selection of different profiles. When Focal Length control is focused you can use arrow
up/down keyboard keys to scroll through the profiles you have defined.

Profile : Tak 7.7 (1000)

Tak 7.7

1000

o Size
Enter the Object Size that you want to use for the calculations. The values are in arc-minutes. You can enter something
like 10x5 for oval object or just 11 for circular object.
If you enter 12.5x7 it will draw an ellipse tilted by the diagonal "lower left - upper right". If you enter 7x12.5 it will draw
the same ellipse, but tilted by the diagonal "upper left - lower right". In order to see the object outline, you have to
select a camera model, enter focal length, object size and to click on “Recalc” button. If you change any parameter,
click again on the “Recalc” button to recalculate and re-draw the object.

To hide the outline use the Target button in the Main screen.

If you want quickly to change the ellipse orientation double click in the edit box and APT will switch from 7x12.5 to
12.5x7.

o CCD params

These are the CCD/CMOS camera parameters used to calculate the Field Of View (FOV) and the resolution arc-
second per pixel. They are need only when you use CCD/CMOS camera.
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o Object Browser

Opens the Object Browser in order to select an object. On object selection it size will be automatically populated in
the Object Size field.

o CCD Profiles

CCD Profiles allow to store the parameters for two CCD/CMOS cameras and later to switch fast between them. To
store a profile, enter the CCD/CMOS parameters, hold the Shift key and click on the buttons "1" or "2". To load a
profile just click on the desired button. Profile loading also makes automatically the calculations made the Recalc
button.

Ringy Thingy
Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

Planetarium

APT is able to communicate with growing number of planetarium applications. Currently supported are Cartes du Ciel (CdC),
Computer Aided Astronomy (C2A), SkytechX, Hallo Northern SKY (HNSKY) and Stellarium. See the Planetarium settings tab
section for information on how to make connection to the applications.

The integration is in two ways. APT is able export information to planetarium in order to see an object in larger context. This
allows seeing what other objects are nearby and helps to define image framing by optimal way. It is also possible to import
data from planetarium - useful if you want to save a framed target for future use, to help near solving, to make GoTo++ (GoTo
with image confirmation) or regular GoTo when the planetarium is not connected to the mount. The import features can be very
useful when scope without direct support in Stellarium is connected, using APT as ASCOM bridge/proxy for Stellarium.

Export can be made:
* In PointCraft when there is a solved image. Use Show button to see the Field-Of-View (FOV) from the current image
in planetarium.
* In Custom tab of Object Browser. Use Show button to see the saved object in planetarium using the FOV size defined
by Object Calculator.
* In Object Calculator in Tools tab. Use Shift+Click on the Recalc button (or Alt+W shortcut). APT collects the current
telescope coordinates (if connected), the rotator position (if connected) and the current FOV defined by the Object
Browser to see in planetarium where the telescope is pointed. If there is no telescope or rotator connection it will still
show the FOV size.

Import can be made:
* In PointCraft use Shift+Click on Objects to load the current FOV coordinates from the planetarium in Approx Ra/Dec.
Useful to use the planetarium to set the approximate coordinates for near Solving.
* In PointCraft use Shift+Click on Objects to load the current FOV coordinates from the planetarium in GoTo++ Ra/
Dec. Useful to use the planetarium for framing and then to get the coordinates for GoTo++.
* In Gear tab use Shift+Click on Objects to load the current FOV coordinates from the planetarium in GoTo Ra/Dec.
Useful to use the planetarium for framing and then to get the coordinates for regular GoTo.
+ In Custom tab of Object Browser. When an object is added or edited, use the button Catch RA/Dec/Angle to populate
the RA, Dec and Angle (if supported by the planetarium)

Here is a solved image of M78. The data for the detected FOV is sent to the planetariums below.
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This is how Show button interacts with Cartes du Ciel. See the configuration notes. You can use CdC to create a mosaics
frames and then import them for usage in the Object Browser. For more information for to create the frames see - http:/
aptforum.com/phpbb/viewtopic.php?f=17&t=1958
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This is how Show button interacts with Computer Aided Astronomy (C2A).
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This is how Show button interacts with Skytech X. See the configuration notes.
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This is how Show button interacts with Hallo Northern SKY (HNSKY). See the configuration notes. Han Kleijn, the author of
HNSKY have recorded two very interesting clips demonstrating some interesting features including creation of mosaic and
storing the frames in APT

Clip 1 - https://www.youtube.com/watch?v=b1GW1neM3zk&feature=youtu.be
Clip 2 - https://www.youtube.com/watch?v=gj6QUQX1sPc&feature=youtu.be
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on left mouse button.

This is how Show button interacts with Stellarium. See the configuration notes. The coordinates import features can be

very useful when scope without direct support in Stellarium is connected, using APT as ASCOM bridge/proxy for
Stellarium.
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Meridian Flip Clock

The Meridian Flip Clock is visible in the Main APT screen.

The Meridian Flip Clock gives an easy way to monitor the important event for most telescope mounts - the passing through the
celestial meridian. Usually this affects mount tracking because of the gear engagement change. For other setups it is important
to monitor the meridian closing because in some positions the telescope can hit the tripod or pier.

In order to show data the Meridian Flip Clock needs a connection to the mount and also the tracking to be engaged. If there
is no mount or it is not tracking the clock looks like:

E ? W

In some steps during automated meridian flip process the tracking is disabled, but the object position is known so the Meridian
Flip Clock will continue to show accurate calculations of the meridian passing moment.

If the option "Auto-hide Meridian Flip Clock" in Scope & Focuser settings tab is enabled, the clock be invisible when there is
no mount connection.

Few theory notes. The celestial meridian is a whole circle, not only the visible part from horizon to horizon. Every object is
crossing the meridian two times per 24h - once in the highest position (point A) and once in the lowest position (point B) of it
path. For the objects near to the celestial poles is possible both the highest and lowest positions to be above the horizon. Point
A defines the transition from the Easter celestial hemisphere to the Western hemisphere. Point B from Western to Eastern.
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The Meridian Flip Clock shows the time and the minutes to next meridian crossing which can be Point A or B. As soon as
object is in Point A it has exactly 720 minutes (12h) to reach Point B. The amount of time is same from Point B to Point A.

Both sides of the clock shows E or W. The left side shows in which celestial hemisphere the object is in the moment. The
numbers between the two letters show the minutes to next meridian passing the exact time of this moment. The next two
pictures show that the scope is pointing to an object in the Easter celestial hemisphere:

Shows the exact time of the meridian flip

In 19:30 the W will be in left E in right showing that scope is pointing in the Western celestial hemisphere, the minutes will be
720 (12h), the time will be 7:30. This shows when next meridian crossing (in Point B) will happen.

Focusing Aid

The Focusing Aid is accessible from Tools tab
or with Alt+F shortcut.

Focusing Aid allows achieving perfect focus using the HFD (Half Flux Diameter) and/or FWHM (Full Width Half Maximum)
metrics to measure the focus quality. The lowest value is the best one.

Note: In CCD Mode you have to switch to 1:1 Preview Mode in order to use the raw FITS data for calculation of HFD/
FWHM. Using the raw data gives much more accurate focus quality measurements that the values calculated on screen
data.

The Focusing Aid use the common aid behavior in APT- dragging the window and placing the Source frame over the image
part that you want to use.

Focus Quality

Source o

Star Profile o —

Graph 0’ _

o Source
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It is a "transparent” window that shows the image under the Focusing Aid and defines what is the source to be used
in the Aid. It automatically detects the brightest star in the frame and analyze it.

o Star Profile

Shows the star profile.

o Focus Quality

In left are the FWHM and HFD values for the current image. In right are the best measured values since last reset.
The best values are reset if Reset Best button is used or when Auto Reset Best is enabled if you move the window.

o Star Quality

Peak shows the brightest pixels value in the selected stars (8bits value). Sat means saturation and shows how
many pixels has the brightest value.

For focusing is good to use stars with saturation 1-2 and peak bigger than 40.

o Reset Best

Reset the best values for FWHM, HFD and clears the graph.

o Auto Reset Best

When enabled moving the Focus Aid window makes the same as clicking on Reset Best button.

o LiveView Stacking
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Used in EOS mode when LiveView is activated. Defines how many images from the LiveView stream to stack
before the star quality analysis. Bigger value reduces the influence of the atmosphere turbulence and the image
noise, but requires giving time after focus change before you can see the actual effect - stacking leads to less "live"
image.

o Graph

Shows graph of the FWHM or HFD value changes. It is valuable to see if you are tuning the focus in the right
direction or if the focus point is passed. Lowering graph means that you are moving in the right direction.

Double click on the graph to switch between FWHM or HFD metrics.

Auto Focusing Aid
The Auto Focusing Aid is accessible from Tools tab
or with Alt+A shortcut.

The automated focusing requires some initial preparation and measurements in order to provide best results. Please read this
section before you start using it.

Hardware requirements
* Focuser with stepper motor and ASCOM / INDIGO / INDI driver (or enable emulation of position focuser, see Scope
& Focuser settings tab)
* Measure and set into your controller or ASCOM / INDIGO / INDI driver settings the backlash (see Backlash Aid) of
the motor and the focuser. This is important in order to get repeatable position values.

Settings
Use the button Settings to open the dialog box and tune the options related to auto-focusing.

The settings Threshold, Coarse/Fine Step (see the explanations below) and the backlash compensation are the things that
affect the quality and success of the auto focus. Usually these parameters are set one time only.

Here are two scenarios how to use the automated focusing:

Auto-Focusing with Images
» Make connection to the focuser from the Gear Tab
» Go to Camera tab. Tune Exposure/ISO/Bin and take a picture with Shoot button
* Set the preview mode to 1:1 and scroll to the star that will be used
* Open Focus-Aid and frame the star
* Open Auto-Focus Aid and click on Run
* Wait till the process completes

Auto-Focusing with LiveView (supported for DSLRs)
» Make connection to the focuser from the Gear Tab
« Start LiveView. If there is need from Camera tab tune Exposure/ISO to get good image of the star. It is better to use
x5 Zoom for Canon EOS or Zoom 100% for Nikon cameras
* Open_Focus-Aid and frame the star
* Open Auto-Focus Aid and click on Run
* Wait till the process completes
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The Auto-Focusing Aid is designed to collect data that at later stage can be used to calculate the temperature compensation.
When “Record results” is enabled APT will store data for every successful focusing. If you want to make deep study of the
focus change during the night you can leave APT to make continuous re-focusing by enabling “Loop focusing”.

The collected data will be analyzed in the Analyzer which is expected to be ready in one of the next versions. Meanwhile you
can use the Analyzer button to export the data in a file that to be opened with MS Excel or similar application.

Tips&Tricks. Closer to the focus point you start Auto-Focusing faster APT will finish.

Status @/ e
Settings e
Analyzer 0/

o Ringy Thingy

Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

o Threshold
0.08

This is the focus value tolerance. Usually because of the atmosphere turbulence the FWHM (Full Width Half
Maximum) / HFD (Half Flux Diameter) readings are changing even when there is no focuser move. Threshold is here
to ignore these changes. It is important to measure it well. If it is too big the focusing will be inaccurate, if it is too
small the Auto-Focus Aid will take the turbulence for focus change and will make wrong moves. So make the focus
manually using Focus Aid on a star, then:

* If you use EOS LiveView increase the stack count to get more stable readings of FWHM / HFD. Leave it
for few seconds and mark what is the scale of the changes. Enter for Threshold a bit bigger value than the
observed one. For example if you see that FWHM is changing in the range 3.78 - 3.76 set the Threshold
to 0.03 or 0.04.

* If you use focusing with images, it is better to use exposures with duration enough to eliminate the turbulence
usually 2-5s is enough. However we suggest to execute an "Focusing/Framing" type plan to determine the
threshold value. As for LiveView see the scale of FWHM / HFD changes and set a bit bigger value.

Note: The Threshold can be different for FWHM and HFD, so inspect the readings changes for the metrics that you
will use for auto-focusing!
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o Fine Step

This is the step for the fine focusing. Defines how many steps are needed to make in order to see change in FWHM/
HFD (change that is bigger than the Threshold). It depends on how the motor is installed, the f-ratio of the scope, how
fine the steps are and so on. The idea is that there is no need to make 5 moves if the FWHM/HFD will not change
at all for less than 5 focuser steps. So in this case the Fine Step has to be 5 and APT will make 5 stapes every time
when there is need to change the focuser position.

o Coarse Step

APT makes the focusing into two passes. The first one is to find the range where is the focus point using bigger steps
and then find the exact point using fine steps. Use the controller or APT to move to focuser and find how many steps
make a noticeable change in the FWHM/HFD readings. The change should bigger than Threshold*2. Don't set too
very big step because the second pass will be very long. Also don't set too small value because APT can miss the
FWHM/HFD change.

o Max moves

Defines the upper limit of the focuser moves that to make in trying to find the focus. When reached the aid will report
and error and stop.

o Pause after move

Defines how many second to wait after focuser move is finished before taking another image. The default value is
1.

1. Focusing source

Defines what to use for focusing - Images or LiveView (LiveView is supported only for DSLRs).

o Focusing Method

Defines which metrics to use for Auto-Focusing - FWHM (Full Width Half Maximum) or HFD (Half Flux Diameter).

This setting is also used by the EOS Lens auto-focusing.

0g
When enabled the Auto-focusing will make continuing focusing till it is manually stopped. Use this option if you want

to collect data and study how the focus changes with the temperature changes.
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o Record

When enabled will store information for every successful focusing. Useful when calculating a temperature
compensation value.

Run | Stop

Starts/Stops the auto-focusing.

@ Status

Shows the current status of Auto-Focusing Aid.

@ Settings

Opens the settings dialog box.

Analyzer

In one of the next versions it will open a dialog box for analysis of the stored focusing data and temperature
compensation calculation. Meanwhile you can use it to export the data in a file that to be opened with MS Excel or
similar application

Bahtinov Aid
The Bahtinov Aid is accessible from Tools tab
or with Alt+B shortcut.

The Bahtinov Aid uses licensed technology developed by Neils Noordhoek - the very same technology built into the famous
Bahtinov Grabber. It allows achieving precise focus using a Bahtinov mask making sub-pixel analysis of the spikes.

In order to get accurate calculations you have to enter the pixel size (for DSLRs it is automatically determined), the focal length
and aperture of the telescope. Drag the panel over the preview area to frame the star that you want to use. Use the Cross
mode to center the star in “Focusing Region”. After that click on Recalc button. You will see two graphical interpretations of the
results “Lines” — the usual Bahtinov pattern and “Circles”. To make the focus perfect join the two circles. Also you can see the
focus error/distance in pixels. Try to get the lowest possible reading. Usually the atmosphere turbulence is makes the distance
to jump all the time. Empirically is found that when there is good focus, without changing the focuser position, the aid starts
to give equal values, but with different signs (for example -0.12 then +0.12). In the bottom of the aid you can see a graph of
the values since the last reset (recalc).

In the Canon EOS LiveView mode is recommended to use x5 Zoom to get pixel resolution close to 1:1, in Nikon use zoom
100% or bit less to fit the spikes. This will give more accurate calculation of the focus error. Also for DSLR LiveView you can
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use a stacking algorithm in order to lower the influence of the atmosphere turbulence which makes the measurements more
accurate, so after every focus change wait a second or two. You can control the number of the stacked images with the + / -
buttons. When you are focusing with images you can increase the exposure to get more stable readings.

If the star is very bright, the spikes will be very big and in some cases the Bahtinov Aid will not detect them correctly. You
have control by several ways:

* For both DSLR and CCD/CMOS modes use the Histogram move the black point to make the image darker

* If you use EOS camera, lower the ISO and/or the exposure

* If you use CCD/CMOS camera, lower the exposure

After focusing is complete it is good to double check the focus using a short exposure.

Focusing Region o o Focus errar - Circles

p Detected Spikes

/
/

Recalc

Focus Error n

Focal length a N
'\_\\\\

,

Pixel size o_ —_—
Graph 0

Here is a screenshot of Bahtinov Aid when Cross mode is activated. Place the cross in the center of the star and click on
Recalc to make spikes detection again.
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o Focusing Region

Itis a "transparent” window that shows the image under the Bahtinov Aid and defines what is the source to be used
in the Aid

e Focus error - Circles

Shows the error as distance between the centers of two circles. Join the circles to get perfect focus.

e Detected Spikes
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Shows the position of the detected spikes.

o Recalc

Forces the Bahtinov Aid to make a new spikes detection. Sometimes the aid make false detection. If this happens
use the Cross mode, center the star again and click Recalc.

o Cross

Enables the Cross mode. Shows a small cross in the Focusing Region in order to achieve better centering of the
star.

See the screenshot above.

o Focus Error

Shows the focus error in pixels and with text interpretation.

o Focal length

Defines the telescope focal length. If there is value in the Object Calculator it will be automatically used. This values
is needed for accurate sub-pixel calculation of focus error.

o Telescope diameter

Defines the telescope diameter. This values is needed for accurate sub-pixel calculation of focus error.

o Pixel size

Defines the pixel size of the camera sensor. If there is value in the Object Calculator it will be automatically used.
This values is needed for accurate sub-pixel calculation of focus error.
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For DSLR cameras this parameter is populated automatically using the internal database for all Canon EOS and
Nikon models.

0 Stacking Pause

Pauses/Resumes the DSLR LiveView stream stacking.

o Stack count

Defines how many frames from the DSLR LiveView stream to stack. Bigger value lowers more influence of the
atmosphere turbulence, but needs more time to build an image and to show the effect from the focus tuning.

e Graph

Shows graph of the values changes. The Recalc button resets it.

Magnifier

The Magnifier Aid is accessible from Tools tab
or with Alt+M shortcut.

Magnifier Aid allows applying software zoom over an image part. It also can work in combination with Focusing Aid in order to
inspect closer the star used for focusing. Some imagers investigate the aberrations in stars during the focusing.

The Magnifier Aid use the common aid behavior in APT- dragging the window and placing the Source frame over the image
part that you want to use.

Binder e—

Source
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o Source

It is a "transparent” window that shows the image under the Magnifier Aid and defines what is the source to be
used in the Aid.

e Magnified

Shows the image in the Source magnified by the selected factor.

o Binder

When selected the Source will be automatically populated with image in Focusing Aid Source frame. If Focus Aid is
not available Magnifier acts like this option is disabled.

0

Makes x3 software magnification/zoom.

0

Makes x5 software magnification/zoom.

0

Makes x10 software magnification/zoom.
L

Makes x15 software magnification/zoom.
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Framing Masks

The Framing Masks Panel is accessible from Tools tab
or with Alt+K shortcut.

Framing Masks Aid helps in framing object by same way during different nights or after a meridian flip. It is an alternative to
PointCraft when there is no telescope/mount connection.

To create a new mask, select "Add New Mask" from the Mask list box, give a name of the mask. After that click with the left
mouse button on few stars in the image that you can easily locate to put markers (second click in the same place removes
the maker).

Later you can select the same mask from the list and to see the marker positions, then move the mount and rotate focuser till
the reference stars match to the markers pattern. To see the new position you can enable the LiveView or to start a Frame/
Focus imaging plan.

If the mask is created when the object was from the other side of the meridian, select the "Meridian Flip" option and APT
will orient the markers in way that corresponds to the current object position. Don't be afraid that image will be rotated, your
stacking program will handle this without any problems.

It is possible the create a mask using image from previous imaging session in order to frame the object by the same way. To
do that use the image browser - Img Tab to load the image and mark the stars you want to use as markers.

To hide a mask, just close the aid.

Here is Framing Masks Aid in action.

.Hasal-: :MT8

o o 0

Selected star Save

This is how the mask is displayed with Meridian Flip is activated. It places the marks on the place where they are in the
flipped image.
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‘ :

- Mask : M78

o Select / Add mask
[ Mask : M78

List with the saved masks. To create a new mask select the option "Add New Mask".

o Mask name

Defines the mask name.

o Meridian flip

Enables mask orientation for the position of the object when it is from the opposite site of the celestial meridian.

o Save

Saves the markers and the mask name.

o Delete

Deletes the current mask.
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o Selected star

This a marker placed over a reference star.

o Settings
 settios:

Opens the Framing masks Settings dialog box to define the radius and thickness of the markers. It is possible to
use the Ringy Thingy to change the values.

Collimation Aid

The Collimation Aid is accessible from Tools tab.
The Collimation Aid is used to create and place a reticle over LiveView or image in order to inspect and tune the telescope
collimation. Define the pattern for the reticle and simply drag it to the place of the diffraction rings. The using the fine moving
buttons you can adjust the position with pixel resolution.

The aid allows store up to four predefined reticles.

.,
.,

\o Fine moving

Reticle
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o Ringy Thingy

Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

Circle Size
o cirle size: (=) I (%)

Defines the diameter of the most outer circle.

Circle Count

Defines the count of the inner circles.

o Distance

Defines the distance between the circles starting from the most outer circle.

o Apply

Applies the entered reticle changes in the size, count and distance. Use it when you have changed the values
without the +/- buttons.

o Fine moving

Moves the reticle with one pixel step in the desired direction.

Profiles
| DO

Use Shift+Click to save the current size, count and distance on the wanted position. To load saved profile just click
on a number.

o Reticle
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This is how the reticle looks applied over an image.

Crosshair

The Crosshair mode can be activated form the Target button in
the main APT screen or with Alt+T shortcut.

Combined with LiveView or taken image the Crosshair mode can help in alignment tasks like: Drift Alignment, GoTo Alignment,
Precise mode checks for Meade mounts and everything that needs a benchmark.

Here are some key combination that gives more control over the Crosshair:
* Hold the Shift + Left Mouse Button and move mouse to change the place of the cross center.
* Hold the Control + Left Mouse Button and move the mouse horizontally to rotate the cross.

« Shift or Control + Double Click with the left mouse button will restore the initial centered cross position.

Centered cross:

Moved cross:
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Rotated cross:

Graphs

The Graphs Aid is accessible from Tools tab
or with Alt+G shortcut.

Graphs Aid displays various data collected during the current imaging session - since the APT start. You can switch to
different graphs by clicking the corresponding button. If you are using double click in the graph section APT will cycle
through the graphs. Hold the Control key and double click in the visualization area to reset the collected data for the selected

graph.
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Reading EXIF T® Humidity

Graph Guide CCDT

0,

Shows graph of the ambient temperature data collected through External Sensors during the imaging session.

o Humidity

Shows graph of the humidity data collected through External Sensors during the imaging session.

o EXIF
Shows graph of the EOS sensor temperature values stored in the EXIF section in Raw files taken during this
session.

o Dew Point

Shows graph of the dew point data collected through External Sensors during the imaging session.

o CCDT
=

Shows graph of the CCD/CMOS sensor temperature changes during the imaging session.
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o CCD Power

Shows graph of the CCD/CMOS cooling power loading changes during the imaging session.

o Guide

Shows graph of the distance to the guiding star reported by the connected guiding program/device.

o Sky Q

Shows graph of the sky quality data collected by the Sky Quality Meters during the imaging session.

o Reading

When the mouse pointer is out of the graph section, this shows the last logged value/ time for the current data type.
If you place the mouse in the graph then the reading displays the value / time that correspond to this point of the
graph.

m Graph

The graph that corresponds to the logged data.

EOS Lens Control and Auto-Focus

The Lens Control is accessible from Tools tab.

APT can control Canon compatible lens when they are attached to Digic Il or latter camera. Lens "Auto Focus" (AF) must be
set to ON and you have to be in LiveView mode. Don't forget to set your lens in manual focus (MF) mode before plan
execution!

Note: Some lens could be still controlled in MF mode. Give a try with ours to see it works. Start the LiveView and use
the buttons <<< and >>> to see if the the lens supports control in MF mode.

APT has its own automatic lens focusing that uses the Focusing Aid and FWHM (Full Width Half Maximum) or HFD (Half
Flux Diameter) metrics to achieve better focus than the camera built-in automatic focusing which is not optimized for astro
photography. The selection between FWHM and HFD is made from the Auto Focusing Aid panel. In the next few versions the
Lens Auto-Focus will be fully integrated with Auto Focusing Aid.

To use Lens Auto-Focus, Turn ON the Lens control, turn ON Focusing Aid panel, make a rough focusing using the lens drive
buttons and frame a star in the Focusing Aid panel. After that click on the “Start Auto Focus” button. The precision of the
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focusing depends on the precision of your lens drive. If you are not satisfied by the focus precision you can run auto focusing
for second time or to try with manual control of the lens. It is recommended to use the LiveView Zoom x5 option.

Here is the usual scenario:

Set the lens in AF mode

Start LiveView, Focus Aid and Lens Control
Frame a bright star with saturation 1 or 2
Make rough focus

Start Auto focus

Set the lens in MF mode

ook wn =

e,

ﬂo Start Auto Focus

In

Drives the lens in "In" direction with three different step sizes. "<" is the smallest supported by the lens, "<<<" is the
biggest supported.

2
Drives the lens in "Out" direction with three different step sizes. ">" is the smallest supported by the lens, ">>>" is
the biggest supported.

o Start Auto Focus

Starts the APT lens focusing using FWHM (Full Width Half Maximum) or HFD (Half Flux Diameter) metrics.

CCD Flats Aid

The CCD Flats Aid is accessible from Tools tab.

CCD Flats Aid is made to help determining the right exposure time when making flat frames with CCD/CMOS camera. As the

name shows currently it is not working with DSLRs - in most cases you can use the AV dial mode to make good flat frames
with DSLR.

This aid provides some advanced features like evaluating several filters at once and automatically creating an imaging plan
with separate line per filter with the found exposure duration. Built-in is logic that minimize the count of the used exposures
during the search of the optimal duration.
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Create plan o»— —
n @

.

Tips&Tricks If you usually taking the flats in similar conditions you can evaluate the created plans and make the range Min/
Max exposure smaller. This will speedup the search process and will lead to fewer count of test exposures. For Min Exp select
few seconds smaller than the smallest value you have got for all filters. For Max Exp enter few seconds more than the longest
exposure you got for all filters.

Ringy Thingy
Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

o Target ADU

Defines the desired ADU value that you want to reach in order to consider that exposure duration is fine. Usually it
is value around 20,000.

o ADU Range

Defines the tolerance range of the ADU value that is acceptable.

o Starting Exp

Defines the starting exposure duration in seconds.
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o Minimal Exp

Defines the shortest exposure that you want to try.

o Maximal Exp

Defines the longest exposure that you want to try.

o Binning

Defines the binning that have to be used.

o Region Of Interest

Defines if you want to Region On Interest. This option will use the center of the CCD/CMOS sensor and speed-ups
the image downloading. Could be valuable options if you are making sky-flats and imaging time is limited.

o Use filters

Defines if you want to determine the exposure time for multiple filters and which filter wheel positions to use.

o Create plan

Defines if you want automatically to create an Flats type imaging plan with the found exposure time(s). It is very
handy option if you use filters. Some flat panels require a longer pause between the exposures, so if there is need
increase the "Exp Pause" field.

0y
Starts the determining of the exposure time(s).

a Abort
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Stops the running process.

Pixel Aid

The Pixel Aid is accessible from Tools tab
or with Alt+X shortcut.

Pixel Aid allows seeing various statistics for a part of the image (or the whole image), like Median, Standard Deviation and
etc. It works in two modes - Bitmap or FITS.

* FITS mode requires loaded FITS file and the Preview Mode to be “On 1:1”. The data is in ADU.
+ Bitmap mode is used for the other image types or when Preview Mode is other. In this mode the statistics is calculated
for the screen black & white data.

The Pixel Aid use the common aid behavior in APT- dragging the window and placing the Source frame over the image part
that you want to use.

Statistics

One Pixel o\
Whole Image o—

Itis a "transparent” window that shows the image under the Pixel Aid and defines what is the source to be used in
the Aid.

. Mode
2 .

The current mode.

Statistics
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The calculated statistics for the data in the Source.

o One Pixel

Has effect only in FITS mode. When selected Pixel Aid shows the ADU value one pixel rather than calculating
statistical data for Source image. In this mode there is a cross to show the inspected pixel.

Here is how Pixel Aid looks in this mode.

o Whole Image

Has effect only in FITS mode. When selected Pixel Aid shows the calculated statistical data for the whole image.

DARV

The DARYV panel is accessible from Tools tab.

DARYV stands for 'Drift Alignment by Robert Vice method'. The essential idea of the method is to make one long exposure
during the mount is moved on East and then back to West (or in reverse in the southern hemisphere) if the polar alignment
is perfect the result will be a flat line, in other case the track in the image will have the shape of the letter V. So you have to
make corrections till the track becomes a line.
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The scenario is easy to follow:

. Level the mount and make initial polar alignment

. Locate a star in the South close to Declination 0.

. Run DARYV (Align Azimuth button) and wait for routine to complete.

. If the track is not line adjust the Azimuth (left/right).

. If you see V shaped track, repeat the steps 2 and 3 till you get a line.

. Locate a star in the Eastern or Western horizon and close to Declination O.
. Run DARYV (Align Altitude button) and wait for routine to complete.

. If the track is not line adjust the Altitude (up/down).

. If you see V shaped track, repeat the steps 6 and 7 till you get line.

O~NOOOTA,WN-0

This tool is made to take care for exposure and telescope move, so it requires Camera and Telescope connection.

The duration of the drift depends on the focal length of your telescope or lens. Longer it is shorter drift time has to be used.

More information about Robert Vice method can be found here:
http://www.cloudynights.com/page/articles/cat/articles/darv-drift-alignment-by-robert-vice-r2760

Planetary Panel
The Planetary panel is accessible from Tools tab.
The Planetary panel is useful for planetary, Moon, Sun and etc. imaging where the needed frames per second speed is

bigger. Also it saves your shutter from making too many cycles, vibrations and etc. Supported are two modes - DSLR
LiveView and EOS HD Video.
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Multiple Recordings o______
Start / Stop o— S

Status 0"___

Tune m— -—

The LiveView mode allows you to capture the DSLR LiveView stream as series of JPG files and to store it on the PC hard disk.
These JPG files can be easily be used in Registax or similar processing application without modifications. In the panel you can
define how many images you want to capture. The most of the EOS cameras gives best image when x5 Zoom is used. For
more information see article "1:1 Pixel Resolution" by Jerry Lodriguss.

If you are wondering why APT saves JPG files instead of AVI, there is simple reason. The DSLR cameras provide a stream
of JPG images, this the "raw" material from the LiveView. APT stores it in the original form and gives to you the option to
process it by the way you like. The AVI building can affect the quality and in addition it is time (and power) consuming operation.
Everybody prefer to gather more data than to make processing in the field.

Tips&Tricks To get bigger frame rate on slower computer, before start recording make the APT window smaller.

The second mode HD Video (available for some EOS models) allows to start/stop the HD Video recording of your Digic IV
camera (if it has such feature). After the video is recorded APT will transfer the MOV file to PC’s hard disk, if Image Destination
is set to “PC” or “Cam+PC” in the Camera tab. Because of limitations set by Canon, it is not possible to use this mode unless
you have T-ring with focus confirmation or attached lens.

Note that the MOV video file has to be converted before it can be used in Registax. There are several freeware options to
make that. Few samples:

* Pazera Free MOV to AVI Converter
http://www.pazera-software.com/products/mov-to-avi-converter

* FFMPeg
http://ffmpeg.org/

» Media File Converter
http://www.erightsoft.com/SUPER.html

Warning: While you installing this program, pay special attention to things that are checked or unchecked. By default
it is configured to install some type of internet tool bar or something like that. Make sure you deactivate anything that
you do not want to be installed.

You can follow these steps when you use that program:

Choose AVI as the Output Container.
Choose RAW Uncompressed as the Video Codex
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Disable AUDIO for Audio Codex or check the Disable box in the Audio specification box below that.
Choose NO CHANGE for Video Scale Size

Choose 30 or 60 Frame/Sec

Choose the highest Bitrate kbps for best quality.

Choose Hi Quality for additional Options

Jerry Lodriguss has published a great book related to planetary imaging named “A Guide to DSLR Planetary Imaging”
that covers every aspect of this type of photography starting from data acquisition to processing. There is special chapter
dedicated to APT. The address Jerry’s site is www.astropix.com

o Ringy Thingy

Ringy Thingy is an innovative way to edit numeric values using only mouse or touch pad. See details and animation
how to use it in the Application Interface notes.

o Frames

Defines how many frames from the EOS LiveView stream you want to record.

o Seconds

Defines how many seconds to record images from the Live View stream.

o Multiple Recordings

Allows automation of the planetary recordings by defining the number of the images sets to be recorded and the
pause between each recording.

o Recordings

Defines how many recordings to make.

o Pause

Defines what pause to make between the recordings. This pause helps the camera sensor to cool-down and to
avoid the camera blocking.

Start | Stop
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Starts/Stops the LiveView recording.

o Status

Shows the status of the Planetary panel. When there is running recording it shows the saved frames or recorded
seconds.

Sample from LiveView recording:

o Movie seconds

Defines how long to be the video recording.

Tune

Reserved for future use (when Canon provide the needed support).

Start | Stop

Starts/Stops video recording.

External Sensors

APT can use different types of external sensors. They are divided in three types - Temperature, Temperature / Humidity and
Sky Quality.

See the sections Temperature / Humidity Sensors and Sky Quality Meters for links about the hardware. Switch between Celsius
and Fahrenheit is possible from Temperature& Sky settings tab.

Here is description how you can use the different types.
Temperature

These are dedicated temperature sensors (different Temper models) or these built-in in the most focusers. In order to use
dedicated sensor you have to select the Temper option in Temperature& Sky settings tab, then restart APT. The focuser sensor
is detected automatically on connection time. If there is available sensor in the top of main screen you will see the temperature
reading ("T") between the APT name and the date, like in the flowing screen shot.
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Here are the features that can use the temperature sensor:
» Temperature graph
» Temperature use for name parts
» Temperature use with script
* Refocus notifications on temperature change (see below)

Temperature / Humidity

These are dedicated devices - different TemperHum models, USB_DewPoint or special focuser models. To use TemperHum
or USB_DewPoint, select the corresponding brand option in Temperature& Sky settings tab, then restart APT. The focuser
sensors are detected automatically on connection time. If there are available sensors in the top of main screen you will see
reading for temperature ("T"), humidity ("Hum") and dew point ("DewP") between the APT name and the date, like in the flowing
screen shot.

Here are the features that can use the temperature & humidity sensors:
» Temperature, Humidity, Dew point graphs
» Temperature, Humidity use for name parts
» Temperature, Humidity, Dew point use with script and commands
* Refocus notifications on temperature change (see below)
» Dew point notifications (see below)

Sky Quality

These are Unihedron and compatible devices. In order to use such sensor you have to enable sky tracking and to select the
model in Temperature& Sky settings tab, then restart APT. In the Status panel located in Main screen you will see the current
value.

Double click on the label opens the Sky Quality Calculator. There you can enter manual values or convert between Mpsas
and Nelm.
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Here are the features that can use the sky quality sensors:
» Sky quality graph
» Sky quality use for name parts
» Sky quality use with script
« automatically stored in FITS file header

Refocus notifications

APT can be configured to remind you that there is need to refocus the telescope/lens because of temperature change. First
set the limit in from "Refocus on every" option in Temperature& Sky settings tab. After that every time when your telescope or
lens is focused, click on the button Set Focus Mark in Tools Tab to set focus mark on the temperature that focus was achieved.
When the temperature is changed by half of the defined limit the "T" reading visible in the main screen will star flashing. When
the temperature change is bigger than the limit, the reading will be printed on bright background and message will be printed
in the Log panel.

For example if the limit is set to 2°, "T" will start flashing when temperature is changed by 1° and will be on bright
background when changed with 2° or more.

Once you refocus use the button Set Focus Mark in Tools Tab in order to start the monitoring for the new focus position. Shift
+Click on Set Focus Mark in Tools Tab will print the last set mark in the Log panel.

Dew point notifications

APT can be also configured to remind you ahead that dew point is closing and you have to turn on your heating solution. Set
the limit in from "Dew point within " option in Temperature& Sky settings tab. When the dew point closes to half of the defined
limit the "DewP" reading visible in the main screen will star flashing. If the dew point is passed the printed on bright background
and message will be printed in the Log panel.

For example if the limit is set to 6°, "DewP" will start flashing when dew point is in 3° or less and will be on bright
background when "T" is lower than "DewP".
Minimized mode

The minimized mode is currently abandoned option. To use it you have to select the option "Old Style Interface" in the
Main settings tab. Note that this option is not compatible with Windows 10.

When APT is minimized small floating window will become visible, you can drag and place where it is comfortable with you.
In this floating window the same messages will be shown as in the status monitor in the main APT screen. This allows seeing
what is the APT status during you use your guiding or other tools. Also you can see the number of the taken images and the
total number in the current plan. If you want to restore APT window, double click with the left mouse button on the floating
window, or use right mouse button over the APT icon in task bar and select “Restore”

The status window will be expanded automatically when the preview option in the main the Camera Tab is ON and will display
the center of the image in the main window. With right mouse button click you can hide/show the small preview area.

Check Lists
The Check Lists aid is accessible from Tools tab.

In the astro photography there are two things that have strong influence - bad weather and lack of free time in the clear nights.
They can lead to long periods without imaging sessions... In other hand imaging process goes in hand with unpacking/packing,
setup, cables, different software applications and various other steps to follow. It is easy to forget something or the right order
after long row of cloudy new moons. Check Lists aid is designed as way to store and refer your lists of steps avoiding the
need to keep everything into your head.

158



Check lists set o -
List: Setup

Check list name o-.___ | .
o Setup steps

Check list content 1

Orient the tripod as close as possible to North or Sout
Note text o' i

The set of the defined Check Lists. To add a new list, just select the option "Add New List".

o Check list name

The name of the current list.

o Delete List

Deletes the currently selected list.

o Check list content
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The current list of notes / steps. You can define the order of the step using the Up/Down buttons.
0,

Deletes the current note.
o Down

Moves the selected note one position down.

Add
Y

Adds a new note.

Up

Moves the selected note one position up.

o Update

Updates / saves the text of the current note.

0 Note text

The text of the currently selected note.

o Open On Start

When enabled, will open the Check Lists aid on APT start.

Backlash Aid

The Backlash Aid is accessible from Settings->Scope & Focuser tab.

Backlash Aid is an experimental tool for measuring the backlash of Crayford / Rack & Pinion focusers. It implements and
interesting idea given by my friend George Novtekov.
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Here is the algorithm workflow:
- Get current focuser position and measure the length of the visible focuser tube
- Move the focuser with round 1/3 of the tube length
- Go to new position and measure the length of the visible focuser tube
- Calculate how many millimeters/inches correspond to one focuser position
- Make a good number of focuser moves in both directions in order to make the backlash easier to be measured
- Measure the length of the visible focuser tube
- Calculate the backlash value and direction

Backlash aid makes the algorithm easy for execution. Follow these steps:
1. Position the focuser in 1/3 of the focuser tube length using Gear tab and click on Position 1 Get button to save the
position
2. Carefully measure the visible part of the focuser tube and enter it in Position 1 section
3. Move the focuser with 1/3 of the focuser tube length using Gear tab and click on Position 2 Get button to save the
position
4. Carefully measure the visible part of the focuser tube and enter it in Position 2 section
5. Click on Calculate to get the millimeters/inches correspond to one focuser position
6. Enter the number of steps and the number of iterations to make in order to generate backlash and click on Start
to begin the moving sequence
7. Carefully measure the visible part of the focuser tube and enter it in the Current Length field
8. Click on Calculate to get the backlash value and direction.

Notes: For measuring the tube length use gauge, micrometer or fine ruler. Make the measurement without applying any
force on the focuser. More precise the measurement are, more precise the backlash calculation will be. There is no need
to use large number of the steps for the backlash creation, use a value that gives visible move of the focuser. Use good
number of iterations - 50 or even 100 in order to generate easier to measure influence of the backlash.

Make sure that the scope/focuser is not horizontal. Also make sure that it is loaded with the usual load - camera, filter wheel
and etc.

The calculated backlash can be positive (inwards) or negative (outwards), however when you use the value in the Scope &
Focuser settings tab, enter the value without sign. For example if calculated value is -1 you have to enter 1 in the outwards
field.

Don't forget to share your feedback in the dedicated topic of APT forum - http://aptforum.com/phpbb/viewtopic.php?
f=22&t=1087
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Paosition 1 n____
mmyin per position °
Creation params e
"“—-.._\_\_\_
Status °

Current Length o
e
Backlash value o— -

Reset button

o Position 1

Click on Get to save the current focuser position as first reference point. Measure and enter the length of the visible
focuser tube.

o Position 2

Click on Get to save the current focuser position as second reference point. Measure and enter the length of the
visible focuser tube.

o Calculate

Calculates the mm/in per one position change

o mm/in per position
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Shows the calculated mm/in per one position change.

o Creation params

Defines how many steps to make in both inward and outward direction in order to create backlash. These moves

will be repeated for the defined number of iterations.

Start

Starts the moving sequence.

o Status

Shows how many iterations are executed.

° Current Length

Measure and enter the visible tube length after the moving sequence.

Calculate backlash

Calculates the backlash value.

m Backlash value

Shows the calculated backlash value.

0 Reset button

Resets all values in the Aid.
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Extra Devices
The Extra Devices aid is accessible from Tools tab.

This aid is built to give control over specific devices. In the first section are the parameters for controlling devices for taking
flats - Lacerta's FBC - Flat Box Controller, Pegasus Astro - FlatMaster, ArteSky - Flat Box USB. These settings are used by
CCD Flats Aid and during Flats Type imaging plan execution (in both DSLR and CCD/CMQOS modes) when such device is
available.

The second section allows to talk with a GPS dongle or with smartphone (using an app that forwards the location data via
Bluetooth). The detected coordinates can be used by the mount, for the Darkness Clock and DSD Calculator

Flats device o /o Refresh
Flats device Port 67
Brightness o________

GPS Port e —
Coordinates a— -—
Status a
1“—\-..
.
Set as current a ™

.,

o Flats device

Defines to which device brand to make connection.

o Flats device Port

Defines the COM port on which the flat panel is connected. Once selected APT will make attempt to make
connection and will display the result in the Log panel.
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o Refresh

Refreshes the connection to flat panel.

o Delay
Lacerta FBC is designed to start the flat panel flash after the exposure start in order to avoid artifacts from the
shutter. This delay defines how many milliseconds are needed the camera shutter to open/close fully. APT will
modify the exposure duration automatically to include that delay before and after the flash. If exposure/flash is set
to 1s it will execute 1s and 800ms if the delay is set to 400ms.

For Pegasus Astro - FlatMaster is used the same logic as for Lacerta FBC

ArteSky - Flat Box USB needs some time to stabilize the needed brightness. You can use this setting to give time
the brightness to reach the desired level before taking exposure.

o Brightness

Define the flat panel brightness per filter. If there is no filter wheel connected the first value will be used.

o GPS Port

Define the COM port of the GPS dongle. If smartphone is used (with dedicated app that exports the current location
via Bluetooth), it will be also visible as COM port. Once selected APT will make attempt to make connection and will
display the result in the Log panel.

e Refresh

Refreshes the connection to the GPS dongle or smartphone.

o Coordinates
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Shows the detected coordinates. Keep in mind that it can take several minutes the GPS dongle to detect the
satellites.

o Status

Shows the connection status.

o Set as current

Once coordinates are available you can set them as current location in Settings Location tab and use them for the
mount, for the Darkness Clock and DSD Calculator.

o More

Opens small settings dialog box where you can manage the COM port speed or to enable/disable GPS data
logging. Use logging only in case of problem because the log files could become quite big.

Extreme EOS Shutter mode

Some events can be very demanding requirements for imaging frame rate, for example eclipses, transits, occultations and
etc. To cover these needs APT provides the "Extreme EOS Shutter mode" (EESM) when Canon EOS cameras are used.
Currently this mode is not supported for Nikon cameras.

The "Extreme EOS Shutter mode" uses serial or DSUSB cable to shoot images as fast as possible and allows to boost the
imaging frame rate from 1 image on every 2s to 1-2 images per second (depends on the camera and memory card speed).

To enable EESM there is need to set some settings - the Image Destination in the Camera tab has to be Camera only,
Image Preview has to be Disabled and serial cable or DSUSB has to be used as Long Exp Control. The idea is to store the
images on the camera card and do not waste time to transfer them to the computer for previewing. The Serial/DSUSB cable
provides much faster way to start exposure than the USB communication (limitation of the Canon's communication library).

To get most of EESM make sure that the sounds are disabled, in the plan editor the option "Don't Dither This plan” is better
to be checked. Also make sure that image display is disabled from the camera menu.

Having all that set you have to determine how fast your "camera + card" combo is. Make a plan with 20 exposures (RAW
only image quality is suggested to save space and time) with duration equal to the shortest you will use and pause set to
0Os. Point the camera to some light (darker images are smaller than bright one and take less time to be saved). Repeat the
following test.

. Clear the card

. Execute the plan

. check if you have 20 images in the card

. if you have 20 images lower the value Extreme EOS Shutter delay in Advanced settings tab. Repeat from point 1
. if you have less than 20 image increase the value Extreme EOS Shutter delay. Repeat from point 1

abhwN -

In the end you will know what is the minimum delay that can be used. Now build the Imaging Plan with all exposures you are
planning to execute during the event and make the same test above. The changing of ISO and/or Exposure settings require
time, so most likely you will need a bit longer delay, so you will have to determine the right one.

Now you are ready extreme imaging of the event.. You can combine your plan with execution scheduling.
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USB Monitor

The USB Monitor is accessible from Main Screen tab
or with F10 key.

We all have heard the "unplug" and or "plug" Windows sound during the night wondering which connection was lost... The
USB Monitor comes to keep eye on the connected USB devices and also to show log on the events happening in the course
of the night. It is running all the time no matter if its window is open. The USB events are displayed in the Log Panel, but if
you want to see filtered information or to seem the devices that are discovered click on the USB Monitor button in the top
right corner of the Log Panel.

Devices List n

o Devices List
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List of the most USB devices. Some internal parts of of the computer are also USB devices, so the USB Monitor
tries to show only the devices of interest. If more deep device troubleshooting is needed the Windows Devices
Manager will be always there.

o Events Log

A log of the connection and disconnection events detected since the APT start. It can be use to check what
happened when you heard "the USB sound", is the camera detected and etc. without digging into the Windows
tools with bright white background.

Dithering and Guiding
The Guiding settings are accessible from
Guide button in Gear tab or with F7 Key.

APT can communicate with various guiding programs and devices in order to monitor and control the guiding. Important purpose
of this communication is to provide dithering.

Dithering are gentle random changes of the telescope position between the exposures. By this the celestial objects are placed
on slightly different positions on every image while the sensor defects like hot/cold pixels, dust signs or banding noise remains
on constant or almost constant places. During the images stacking the stars are detected and all frames are aligned by the
found star positions - this means that the objects become constant and while defects become random. All major stacking
applications for image post-processing provide methods based on "sigma clipping" / "kappa-sigma clipping" pixel rejection.
These methods exclude the random data and preserve the constant signal. As a result in the stacked image there will be much
less defects and noise. More images you use in the stack more noise and defects will be removed. In order the sigma clipping
to be effective there is need to use at least 6 light frames.

The author's personal opinion is that good amount of images (10 or more) makes dark frames unnecessary. Making darks is
quite time consuming and very tricky process, especially for DSLRs where the imaging sensor temperature is not accurately
controlled. Also (again personal opinion) darks applying results in loosing the very faint details in the final image.
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No matter if you are applying darks or not, dithering is powerful technology is it is highly recommended to use it. The time
needed to make dithering depends on the mount and the desired distance, but in most cases it takes less than a minute -
quite small price for the benefits it gives.

Usually the dithering is made by your guiding program/device and there is no need to make dedicated connection to the
telescope in APT if you don't want to use other features that require mount control.

APT Dithering is special feature made to provide dithering when there is no guiding because your mount is high-end (ASA,
10Micron and etc.) or when you are using short focal length lens or telescope. APT Dithering uses a mount connection to
make the needed random position changes between the exposures.

APT Pulse Dithering is other special feature made to provide dithering using pulse guiding commands for self guided mounts
like Meade StarlLock, self guiding solutions or mounts like SkyWatcher StarAdventure, AstroTrac and etc. In this case the
Dithering Distance defines the maximum pulse duration in milliseconds. The value is multiplied by 100. For example Dithering
Distance = 5 means up to 500ms pulse.

APT has powerful Dithering System that is able to synchronize exposures and dithering even in multi-camera imaging setups.
See Multi-camera Dithering / Synchronization section.

Supported are the following guiding solutions:
* PHD Guiding (http://www.stark-labs.com/phdguiding.html)
* PHD2 Guiding (http://openphdguiding.org/)
* MegaGuide (http://www.astrogeeks.com/Bliss/MetaGuide/)
* Lacerta MGen v2 self-guider solution
« Lin_Guider (https://sourceforge.net/projects/linguider/)
* AstroArt (http://www.msb-astroart.com/)

Lin_Guider is a Linux based guiding application which can be used on Raspberry Pi or other Linux devices for building small
self-guiding solutions.

PHD and PHD2 has common roots, but now are different projects. Everything in the text below that is related to PHD is
related to PHD2 too.

There are several requirements for the MGen usage with APT:
* The MGen firmware has to be version 2.04 or newer. If it older than 2.04 here is a link for updating:
http://www.teleskop-austria.at/information/ccd-standalone-hu/pdf/Lacerta MGEN_FW204.zip
* There is need to install the D2XX drivers that take care for the USB to MGen communication from here:
http://www.ftdichip.com/Drivers/D2XX.htm
* There is need to enable the “Application Mode” from MGen menus.

Other interesting feature is named "Auto Cancel Exposure" (supported for PHD, Lin_Guider and MGen). APT monitors
the reported distance to the guiding star and if it becomes bigger than a defined limit the running exposure will be stopped
before trails to become visible in the image, or to save imaging time for other exposure. Canceled exposure will not be
counted as finished in plan execution and another will be started on its place.

Follows detailed settings description.
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Guiding Program / Device o

Auto Cancel Exposure 0
Auto Cancel Distance °> -

Multi Camera Dithering o‘
Multi Camera Sync a,-

Stability

Auto Dithering o» —

Dithering Distance °' :
MGen Mode °/

Dither Delay o

Ping Timeout o -
e
-
After GoTo delay a/

Guiding Program / Device

Defines the guiding solution that have to be used, or APT if there is no guiding.

When PHD is used there is need to set it in server mode. Select from menu in PHD 'Tools'->'Enable Server'. For
PHD?2 this option is enabled by default, but check it for sure.
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L PHD Guiding 1.14.2 - www.stark-labs.com
File Mount  Teools  Help Donate!
Manual Guide

Erase Dark Frame
Auto-select Star

Enter calibration data

Flip calibration data

® Mo overlay
Bullseye
Fine Grid
Coarse Grid
RA/Dec

Enable Legging
Enable Star Image logging
+  Enable Server

o Auto Dithering
Auto Dithering : ON

Enables/Disables the dithering.

e Dithering Distance

Dithering Distance : 5

Defines how big to be the move. This is the upper limit. By definition dithering is random by direction and by
distance move.

For PHD(2) if the distance is too small you can use the Brain button (Advanced Parameters) to enter "Dither scale".
For each value, here is how much the dither size would be on the guiding chip (assuming you keep dither scale =

1.0):

Value Guide Camera Pixels
1 0.5

2 1

3 2

4 3

5 5

For PHD2 the distance is in guide camera pixels.
For APT Dithering the value defines the max distance in pixels of the imaging camera
For APT Pulse Dithering the value * 100 gives the max guiding pulse in milliseconds to execute

Supported by PHD, PHD2, MGen, Lin_Guider, APT Dithering, APT Pulse Dithering.
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o MGen Mode

Defines the dithering mode for the MGen device.

o Stability

Defines the acceptable distance from the guiding start that to be considered as dithering end. For PHD, Lin_Guider
the distance is in pixels from 0.00 to 2.55, for PHD2 there is only lower limit 0.00.

PHD and Lin_Guider doesn't report when the action is completed, so APT monitors the distance and when it gets
back to normal decides that dithering is completed.

Supported by PHD, PHD2, Lin_Guider

o Settle Time

Defines how many seconds to wait after dithering completion. This gives time guiding/tracking to settle down.

Supported by PHD, PHD2, MGen, Lin_Guider, APT Dithering, APT Pulse Dithering.

o Timeout

Defines the maximum time for waiting the dithering process to finish. After that time APT will continue with the next
exposure. 0s means that there is no time limit to complete the dithering.

When MetaGuide or AstroArt is used this defines when to resume with next exposure.

o Dither Interval

Defines how many images to take before making dithering. Values 0 or 1 means to make dithering after every
image.

o Dither Delay

Defines how many seconds to wait before sending the Dithering command. Usually there is no need to define such
pause.

m Auto Cancel Exposure

Enables/disables the Auto Canceling. Auto Canceling allows canceling exposure when the distance from the
guiding star becomes greater than a defined value.
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Supported by PHD, PHD2, MGen, Lin_Guider

o Auto Cancel Distance

Defines the maximum acceptable distance from the guiding star. Distance above this limit will force exposure
cancellation. For PHD and Lin_Guider the values are in pixels form 0.00 to 2.55. For PHD2 there are no value
limitations.

o Remote IP

Defines the IP address of the computer that is used for guiding. This feature is useful if you use separate computer
for guiding or self-guiding solution. The default value is 127.0.0.1 which means that same computer is used for
imaging and for guiding.

Supported by PHD, PHD2, Lin_Guider

o Remote Port

Defines which TCP/IP port to be used. This feature is useful if you want to control two or more guiding setups with
one computer or self-guiding solution. The default value for PHD is 4300, for PHD2 is 4400, for Lin_Guider is 5656.

Supported by PHD, PHD2, Lin_Guider

a Multi Camera Dithering

Defines is the role of this APT instance in server-client architecture. If you use only one camera there is no matter
what is selected.

See Multi-camera Dithering / Synchronization section.

@ Multi Camera Sync

Defines synchronization mode in server-client architecture. If you use only one camera there is no matter what is
selected.

See Multi-camera Dithering / Synchronization section.

0 Ping Timeout

Defines how long the server to wait before decides that a client is stopped. Increase this value if you are loosing
connection between the server and a client.

173



o Control Guiding

When enabled APT will stop the guiding in PHD, PHD2 or MGen before making a GoTo, GoTo++ or #GoTo
command and will try to resume the guiding after move is completed. This option has to be enabled for Automated
Meridian Flip.

For PHD2 when guiding is starting a new guiding star will be auto selected. PHD2 decides itself if there is need to
do a calibration. Make sure to apply darks to avoid hot pixel selection.

For PHD when guiding is starting a new guiding star will be auto selected. APT can't get feedback from PHD when
the guiding is started, so give some time the guiding to start and settle. Make sure to apply darks to avoid hot pixel
selection. We suggest migrating from PHD to PHD2.

For MGEN a new star is searched using the exposure/gain from the previous guiding. When the guiding star is
selected, APT will start a calibration and after its end the actual guiding will be started.

m After GoTo delay

Used when Guiding Control is enabled. Defines how many seconds to wait after mount movement is completed,
before sending command for guiding star selection. This delay gives possibility guiding to get image clear of
movement trails. Use delay that is 4-5 times the guiding exposure.

@ Guiding Resume Delay

Used when Guiding Control is enabled. After mount movement is completed, APT will send command for guiding
star selection (defined by "After GoTo delay" ), then will wait N seconds (defined here) in order star selection to
complete and tracking to settle before resuming the guiding. Increase this value if the mount needs more time after
GoTo command.

Multi-camera Dithering / Synchronizing

The Guiding settings are accessible from
Guide button in Gear tab or with F7 shortcut.

APT has powerful Dithering System that allows using dithering in a setup with multiple cameras. When your setup contains
two or more cameras there is need APT to synchronize the moment when dithering will be made in order to be sure that none
of the cameras is taking an exposure in that moment.

This is a short summary of the workflow:

Configuration (one time only)
* In the main APT instance open Guiding and Dithering. After that select "Server Mode" from Multi-Camera Dithering
list box
« If there is need tune dithering parameters
* In the other APT instances open Guiding and Dithering. After that select "Client Mode" from Multi-Camera
Dithering list box

Regular use
» Connect the cameras in all APT instances
« Start the plans in the client APT instances
« Start the plan in the server APT instance
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* The Dithering System will synchronize all exposures and dithering
Here is a detailed explanation.

See Multi-Camera Operation for more information on how to use more than one camera at the same time.

Once you have started the different APT instances you have to setup a Client/Server configuration. In the instance that controls
the main camera use click on the Guide button in Gear tab (or use F7 shortcut) to open the dithering settings dialog and
select from the list Multi-Camera Dithering the option “Server Mode”. After that from the list Multi-Camera Sync select the
synchronization mode. Available are two modes — “Strict” and “Loose”. In the first mode all clients and the server will make
an exposure and then will wait the server to make dithering before continuing with the next exposure. In “Loose” mode, if a
client APT is taking shorter exposures than the server and if there is enough time then, the client will start new exposure. For
example if the server is taking 10 minutes exposure the client has time to make several 2 minutes exposures without waiting
the dithering action.

The server defines the all parameters for the dithering like program, distance, timeout and etc.

Once server is configured, next are the clients. In the other APT instances select from Multi-Camera Dithering the option “Client
mode”. With this configuration is finished. There is no limitation for the number of the clients, but the server can be only one.

The most common workflow is to connect the cameras in all APT instances and to select the plans that will be executed. After
that to start the clients first and the server last. This order allows the Dithering System to synchronize the exposures from
the first one.

If the server is started first then all clients be put in SYNC state till server finish the exposure that is in progress.

The clients <-> server connections and the server <-> guiding program connection are checked and initialized (if there is need)
on every plan start. So you don't need to take any additional actions.

Tips&Tricks If you want to monitor closer the work of the Dithering System use Ctrl+Click on Guide button in Gear tab (or
F8 shortcut) to open the Dithering System Monitor. There you can see the status of the system in current APT instance. The
server monitor can show the status of up to 10 clients.

Tips&Tricks If you don't need dithering you can still use the Dithering System to synchronize the exposures by disabling the
Auto-Dithering.

PointCraft and Plate-Solving
The PointCraft is accessible from Gear tab
or with Alt+P shortcut.

Plate-solving is a image analysis that detects the stars and then tries to identify them using catalogs of know stars. If the
analysis is successful it is possible to calculate the Right Accession (RA) and Declination (Dec) of the image center which tells
where exactly is pointing the telescope, image orientation, resolution and etc. Plate-solving is the engine of many scientific
studies for example comet, asteroid hunting and orbit analysis.

Nowadays we are lucky to have access to many advanced techniques and devices that in the past were available only for the
biggest professional observatories. Plate-solving is one these techniques that makes imaging much productive, accurate and
pleasant. There are two types of solving - Near and Blind. The first one needs to know approximately where "you are" and
solving will tell you exactly where "you are", it is very fast because you already know context . For the second one you don't
need know where "you are" and solving will find the position without knowing the starting position, it is slower because there
is need to match star patterns from all over the sky.

PointCraft can be considered as set of APT features powered by plate-solving technology. The actual solving is made by
external programs then their results are used by APT.
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The key features of PointCraft are:
*» Solve an image.
» Synchronize the telescope coordinates with the image coordinates.
« Store the found RA/DEC for use after meridian flip or in other imaging session.
» Make the perfect framing using Aim mode - determine the coordinates of every point in an image by a mouse click
and use them for GoTo or GoTo++.
» Make GoTo moves with position confirmation using GoTo++.
* To see the Field-Of-View (FOV) of the image into your Planetarium application in order to see what is just around
the corner.

This is PointCraft aid looks like:

Supported are three solving applications. Each has their advantages, so it is recommended to install the three of them in order
to have the full set of options on the field. ASTAP is the most modern solution and unless you find problem you can use only this
application. ASPS is based on Astrometry.net which is classics so it is good to have it in case there is problem to blind solve
a particular image. Giovanni Benintende has made the installation and the configuration very easy. PS2 is great application
too, however it is old one and has problems with solving on computers with non US/UK numeric format, also can have difficult
times when short focal length lens is used.

» Astrometric STAcking Program (ASTAP) made by Han Kleijn. Can be used for fast near solving - requires
approximate coordinates and also can be used for blind solving.

* PlateSolve2 (PS2) made by PlaneWave Instruments. Makes fast near solving - requires approximate coordinates
+ All Sky Plate Solver (ASPS) made by Giovanni Benintende (uses local server of Astrometry.net). Makes blind solving
- can take a bit more time to find the solution.

ASTAP, PS2 and ASPS are not included in the APT installation, so you have to download them separately. Make sure to make
this step when you have access to good/cheap internet connection.

ASTAP Installation:
* Download and install/unzip ASTAP from http://www.hnsky.org/astap.htm
» Download and install one of the available star databases V17, V16 or Hyperleda
* In PointCraft Settings select the folder where ASTAP is installed
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PS2 Installation:
» Download PlateSolve2 version 2.28 from http://planewave.com/downloads/software/
* Download the UCAC3 catalog
« Extract the both ZIP files where you like (under Windows 10 it is better not to be in the "C:\Program Files" and
"C:\Program Files (x86)" folders)
« Start PS2. From “File->Configure Catalog Directories” select the folder where the UCAC3 catalog is.
* In PointCraft Settings select the folder where PS2 is installed

ASPS Installation:
» Download 'All Sky Plate Solver' installer from http://www.astrogb.com/astrogb/All_Sky Plate Solver.html
« Start the installer. It will download and setup a local Astrometry.net server. No complicated configurations!
« After that it will open the index files downloader which will get only the data you need
* If you are using DSLR select your model from Camera list and all need data for the ASPS index wizard will be
displayed in the Log panel
* In PointCraft Settings select the folder where ASPS is installed

You need at least one of ASTAP, PS2 or ASPS. After their installation go to PointCaft Settings to select the application folders.

Some notes about the installations:
« If usually you are starting APT using "Run As Administrator" option, then start PS2 with the same option when you
configure the catalog folder
« If you want to share the Astrometry.Net index files between ASPS and AstroTortilla check this topic in the APT forum
- http://aptforum.com/phpbb/viewtopic.php?f=24&t=619

The next topics are explaining the PointCraft features in details.

PointCraft

The PointCraft is accessible from Gear tab
or with Alt+P shortcut.

PointCraft is set of APT features powered by the plate-solving technology. Before the detailed information lets give some
usage scenarios in order to show what it is possible to do. Aim mode and GoTo++ are described better in dedicated section
- Aim and GoTo++

1. Telescope alignment (Near solving)
* Click on Objects in 'Current Image' section and pickup a star from Object Browser - Stars tab
* Center the selected start in the finder
» Use the Shoot button to take an image
* Click on Solve
* Wait solving to finish
* Click on Sync button and you are ready to go for a target

2. Telescope alignment (Blind solving)
» Use the Shoot button to take an image
* Click on Blind
* Wait solving to finish
* Click on Sync button and you are ready to go for a target

3. Frame an object
* Go to the object
+ Take an image with exposure that can show its position
* Solve the image
* Click on Aim button
* Click in the image to define the point that you want to be in the image center
* Click on GoTo++ button or on GoTo button in Gear tab
« If GoTo++ is used after completion you can Store the framing for future use (after meridian flip or in other night)

4. Go to saved position
» Use Object Browser (the Objects button the “Center FOV at position” section) to populate the GoTo++ RA/Dec
coordinates with a saved object.
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* Click on GoTo++ button

5. Use an old image
* Load an old image with the Image browser - Img Tab (if it is FITS with stored coordinates Approx Ra/Dec will be
populated)
* Solve the image (Solve button needs Approx Ra/Dec)
* Click on Solved button
* Click on GoTo++ button or on GoTo button in Gear tab

The scenario possibilities for framing and GoTo++ can be extended by the Planetarium applications integration. The
Planetarium gives you way to see what is the image context and to change your framing in order to include nearby objects
that currently are out of the image borders.

The PointCraft dialog box is separated in three sections described in details by the text below:
* Current Image - defines the input data and shows the solving status
* Plate-solving results - shows the result an gives options to use them
» Center FOV - defines the position you want to put in the center of the Field-Of-View

Objects

A RAD
PRrox o Scope Position

-
,/’ff}
~ o Blind
Status o____ -
- -
=
-
-
i "-'
Auto e‘ B _~

Results G -
GoTos+ RADec ()

GoTo++ a""_____

“BEA Settings

Here is how looks a solved image. The center and north position are marked in the image. The coordinates and the other data
are populated in the Results section.
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Contains the approximate coordinates of the current image. They are needed when Solve button is used. If Blind is
used you can leave them empty.

Accepted is any RA/Dec format. You can use the Objects and Scope Pos buttons to populate them.

o Objects

Opens the Object Browser in order to populate the Approx Ra/Dec by selecting an object.

Shift+Click takes the current FOV coordinates from the Planetarium application.

e Scope Position

Populates Approx Ra/Dec with the coordinates of the connected telescope.

o Solve

Makes near solving by using ASTAP or PlateSolve2 (PS2).
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This feature needs populated Approx Ra/Dec. The Object Calculator section also has to be populated in order the
pass correct the FOV (Field-Of-View) size to ASTAP or PS2. Note that if you are using Canon lens, APT will read
the current lens focal length after each exposure and will update the focal length field in Object Calculator providing
the value for usage in PointCraft.

If you want to use custom FOV use Shift+Click to on Solve button, enter the size in arc-minutes and click Go to
start the solving.

In case of problems with near solving check the following topic in the APT forum. It contains discussion on the PS2
settings that have effect on the solving.
http://aptforum.com/phpbb/viewtopic.php?f=24&t=474

o Blind

Makes blind solving by using ASTAP or All Sky Plate Solver (ASPS). The Object Calculator section has to be
populated in order the pass correct focal length and pixel size to ASTAP or ASPS.

In case of problems with blind solving check the following topic in the APT forum. It contains discussion on the ASPS
settings that have effect on the solving.
http://aptforum.com/phpbb/viewtopic.php?f=24&{=618

o Auto

Makes the following sequence of actions: Shoot -> Get Scope Pos -> Solve -> Sync

If there is no defined exposure duration in PointCraft Settings, then is used the one in Camera tab.

If only one solving application it installed it will be used. If there are solving application for both Near and Blind solving,
the solving method is defined by the selected method in the setting, PointCraft can use Near Solving, Blind Solving
or to ask which to use on every Auto usage.

You can use Ctri+Click on Auto button to force Near solving and Shift+Click for Blind solving overriding the selected
method in the setting for the current execution of the procedure.

o Status

Shows the status of the current solving process.
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Results

Shows the results from the last solving:
* RA/Dec of the image center (marked in the image with two small circles)
* Image resolution - in arc-seconds per image pixel
* Angle - the frame rotation from celestial North. There are two values. The one detected in the image and the
the corresponding angle from the other side of the meridian. Any of these can be used in multi-night sessions
in order to rotate the camera properly and avoid data loss.

Sync

Synchronizes the connected telescope with the solved coordinates of the image center. This is the equivalent of "One
star GoTo alignment" provided by most telescope handsets.

A message will be printed in the Log panel when command is completed.

Store

Opens the Custom tab of Object Browser in "Add new" mode then populates the found RA, Dec and angle from the
last solving. You can enter additional data like name, type, etc. and save the position for future use - after meridian
flip or in other imaging session.

Show

Shows the FOV detected by the last solving into your Planetarium application. Gives a view to the celestial context
of the displayed image.

GoTo++ RA/Dec

Defines the coordinates to be used for GoTo++. This is GoTo with image confirmation of the position.

Works nice in combination with Aim mode. Both described in Aim and GoTo++ section.

Objects
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Opens the Object Browser in order to load the GoTo++ Ra/Dec coordinates with an object - for example saved by
Store button position of previous framing.

Shift+Click takes the current FOV coordinates from the Planetarium application.

0 Solved

Populates the GoTo++ Ra/Dec and Ra/Dec in Gear Tab with the coordinates from the last solved image. Useful when
you have solved an old image loaded with the Image Browser - Img Tab.

15 I
When enabled allows finding the celestial coordinates of any point in the solved image. Click with the left mouse

button in the image visible in the LiveView / Preview panel and the coordinates will be populated into both GoTo++
RA/Dec and regular GoTo Ra/Dec in Gear tab.

Works nice in combination with GoTo++. Both described in Aim and GoTo++ section.

o GoTo++

Starts a GoTo++ sequence. This is a GoTo with image confirmation of the position.

For the confirmation images, if there is no defined exposure duration in PointCraft Settings, is used the one in Camera
tab.

See Aim and GoTo++ section.

o Settings

Opens the settings related it PointCraft.

See the PointCraft Settings section.

Settings

The PointCraft Settings is accessible from
Settings button in PointCraft dialog box.

These is the PointCraft Settings dialog box which defines parameters used only by PointCraft.

It is accessible from the PointCraft window.
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o ASTAP Settings

Defines the path to Astrometric STAking Program (ASTAP) application. Use the "..." button to open the folder selection
dialog box. The download button navigates the web page for ASTAP downloading.

When "ASTAP for Blind Solving" is selected PointCraft will use ASTAP for blind solving instead of ASPS. In such
case there is no need to install PS2 and ASPS.

o PS2 Settings

Defines the path to PlateSlove2 (PS2) application. Use the "..." button to open the folder selection dialog box. The
download button navigates the web page for PS2 downloading.
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If ASTAP is configured it is default solving program for Near solving. If you want to use PS2 instead of ASTAP enable
the option "Use PS2 for Near Solving".

o ASPS Path

Defines the path to All Sky Plate Solver (ASPS) application. Use the "..." button to open the folder selection dialog
box. The download button navigates the web page for ASPS downloading.

o Flip Directions

Enable this option only if Aim mode calculates wrong coordinated or GoTo++ make moves in opposite direction.

o Solving Timeout

Defines how long to wait ASTAP, PS2 or ASPS for solving results.

GoTo++ Attempts

Defines how many times the GoTo++ will try to center the desired target.

o GoTo++ Error

Defines how many pixels are an acceptable error for GoTo++.

o GoTo++ Pause

Defines how many seconds to wait after GoTo++ before taking the next image for position confirmation. Some mounts
can require time to settle down after a movement.

o Relative GoTo++

When enabled the GoTo++ will use the current telescope position and the calculated position error to find the
coordinates for the next attempt to center the desired coordinates. It is recommended to enable this option.

When disabled the GoTo++ will make direct attempt to center the desired coordinates. Disable this option if your
telescope is able to make very precise movements. When this option is disabled it is recommended to uncheck the
"No Auto Sync" option too.
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o DSLR crop

Enable this option only if ASTAP or PS2 can't solve an image taken with Canon EOS or Nikon camera because of
wrong FOV size.

o No Sync

When enabled PointCraft will not send Sync command on every GoTo++. It is recommended to leave this unchecked
when Relative GoTo++ is also unchecked.

If your telescope is using internal pointing model, unexpected Sync commands can be unwanted so uncheck this
option. In such case enable this option.

e Default Exposure

Defines how long to be the imaging exposure for GoTo++, Auto, and Automated Meridian Flip. If this option is empty
or set to Os then will be used the exposure duration set in the Camera tab.

o Default Filter

Defines what filter to use for GoTo++. The previous filter wheel position will be restored when GoTo++ finish.

Leave it blank if you don't want GoTo++ to change the filter.

0 Default Binning

Defines what Binning to use for GoTo++. The previous value will be restored when GoTo++ finish.

Leave it blank if you don't want GoTo++ to change the binning.

@ Image Quality

When enabled, GoTo++ and Auto will use 'L' quality type no matter what is set in the Camera tab. This option is used
only for DSLR cameras.

o DSLR JPG fix

Enable this option if you want to blind solve JPG files in S1, M, S quality formats.
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e Use un-stretched images

When enabled PointCraft will solve the un-stretched version of current image. This option has effect only in DSLR
mode. Histogram stretching can make DSLR images harder or impossible to be solved.

o Default ISO

Defines what ISO to use for GoTo++. The previous value will be restored when GoTo++ finish.

Leave it blank if you don't want GoTo++ to change the ISO.

@ Solving Method for Auto

Defines what solving method to use when Auto button is used. 'Always Ask' gives possibility to select the method
on every use of Auto. It is also possible force using Near or Blind solving without asking.

Aim and GoTo++

The PointCraft is accessible from Gear tab
or with Alt+P shortcut.

When the image on screen is solved you can use the Aim button to activate the Aim mode. It allows determining the celestial

coordinates of every point in the current image. Just click in the image with the left mouse button and PointCraft will calculate

the RA/Dec of the point (and will mark it with four small circles). The main purpose of the Aim mode is to define the point that
you want to be the center of your image. This is very easy way to frame the target object. Using the GoTo++ or regular GoTo,
APT will move the telescope to the desired position.

Every time you select a point the coordinates are populated in the 'Center FOV at Position" section (RA/Dec fields) for usage
with GoTo++ and also in Gear tab (GoTo Ra/Dec) for usage with regular GoTo.

Here is a screenshot of activated Aim mode and the calculated coordinates of the selected point (marked with four circles).
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The GoTo++ is PointCraft feature that makes GoTo with image confirmation of the position. It makes several iterations of the
following automatic steps:

* Make a GoTo

+ Take an image (the exposure is defined in PointCraft Settings or in Camera tab)
* Solve the image

« Evaluate the error

If the error (the distance between the desired and the image coordinates) is smaller than the one defined in PointCraft
Settings the GoTo++ is considered as successful. If found error is bigger a new attempt is made till the limit defined in
PointCraft Settings is reached.

SessionCraft and Meridian Flip
The SessionCraft is accessible from Tools tab
or with F9 key.

Session Craft is designed to monitor various events and to control imaging session. It works even when the window is
closed. The first feature from this tool is "Automated Meridian Flip" (AMF). APT can be configured to track the object
position during the imaging and when it closes the celestial meridian passing to flip telescope position to prevent physical
damage or bad guiding. After that flip the imaging process continues from the interruption moment, aiming to the exact same
place of the sky.

To achieve this goal of Automated and Unattended Meridian Flip (AMF), APT follows the next scenario:

1. If there is running plan, before every exposure is checked if there is enough time take a new image before the need
to make flip. If there is no running plan the check is running in real-time

2. If the "Flip Moment" occurs or there is no enough time to take another exposure, Session Craft determines the
exact position of the current target via PointCraft taking a short exposure

3. Pauses for user defined time, disables the tracking and guiding giving time the object to pass the meridian or the
scope position to be safe after flipping the pier/tripod side

4. Once pause is elapsed, it enables the tracking and flips the scope position

5. Makes GoTo++ to the target in order to frame the object by the very same way as before the flip

6. Enables the guiding by selecting a new guiding star and making re-calibration if needed

7. Resumes the imaging plan
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Because these operations could be dangerous for your setup, in case of smallest problem for security reasons APT
leaves the scope with disabled tracking, disabled guiding and stops the imaging plan. In every moment you can
press the Stop button in Session Craft, the Stop button in Gear Tab or by pressing F12 key to stop all movements
and actions.

The default Meridian Flip settings should work out of the box for virtually every setup. It will stop 5 minutes before the
celestial meridian passing, will wait 5 minutes after the actual passing through the meridian (total pause of 10 minutes) and
after that will flip the scope position. Every step of the process is logged in the Log panel. During the flip the SessionCraft
windows will be displayed automatically if it was closed.

However you must to prepare your setup, learn its behavior and observe the first few flips to be sure that everything is fine
and safe. We do provide the automation, but you are using it by your own decision and you are taking the whole
care for your scope! Keep eye on your setup during the first few flips!!!

Here are the most important checks to make before enabling Make Automatic Flip:

1. After preparing your setup and connecting all cables make "dry" manual flips moving the scope by hand from the both
sides of the pier/tripod to make sure that all cables are free. Make these checks near the Zenith, but also above South and
North points of horizon. It is very important! Short cables or short cable travel can cause serious damages to connectors,
ports or to pull computer form table!!!

2. If you are using CCD/CMOS and usually there is needing Histogram stretching in order to solve the images keep the
Histogram open.

3. Make sure that you have configured PointCraft correctly. It is used to determine the exact position before the flip and to
reach the same position after the flip. We suggest to configure both PS2 and ASPS and for the first flips to use blind solving
for target centering. We also suggest to define Default exposure in PointCraft Settings which is long enough to get few stars
with all of your filters. If defined by Blind solving ASPS will be used only for the first step of the GoTo++

4. Check the usual time PS2 takes to solve an image from your scope. If it is more that 1-2 minutes increase the Flip
Moment.

5. Make sure that you are using PHD2 or MGen for guiding and that Control Guiding is enabled. Meridian flip is also possible
when your mount doesn't need guiding.

6. Make sure that you are using dark frames in PHD2 to avoid selection of hot pixels during guiding star auto-selection.

7. It is advisable to confirm the limits of your setup. Once the scope is aligned move it to position East from celestial meridian
near Zenith via the handset, control panel of your driver or Gear Tab. Start making fine movements towards meridian and
keep an eye on Meridian Flip Clock. See if the default limit of 5 minutes before meridian passing is safe for your kit. If not
increase Flip Moment to a value that fits better. Move the scope from the other side of the tripod/pier and close it to meridian.
Meridian Flip Clock will show values close to 720 minutes (this is the time of next meridian passing - the lowest object
position). If the position that shows 715 is not safe see the value that fits better and subtract it from 720, set the result as
Delay Flip Move. For example if the safe position is 713 minutes the needed delay is 720-713 = 7 minutes.

The points 1 and 2 have to be checked on every session. The other point are needed in the first time or after scope change.
You can skip point 7 only if you are trying the default settings and you are keeping an eye on the process!!!

Note: If AMF happens during execution of Flat, Bias, Dark or Dark Flat plan APT will stop the tracking and guiding and will
continue with the imaging plan.

Note: Some mounts/drivers support command to change the scope side according the tripod/pier side. If the execution of
this command fails enable the option Flip via GoTo.
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o Status

This area show the Session Craft status. If Make Automatic Flip is unchecked Session Craft will not make any

actions. During the flip process it shows the current step or the remaining time of pause defined by Delay Flip
Move.

o Flip / Stop / Reset

When Session Craft is in "Monitoring" status you can use the Flip button to start the process manually.

If automatic meridian flip is in progress this button becomes Stop that will immediately stop all movements,
tracking, guiding, solving and imaging.

If the last automatic meridian flip process failed or Stop button is clicked this button becomes Reset that can clear

all errors and flip process can be restarted. Note that you will have to start the scope tracking manually by Tracking
in Gear Tab.

o Make Automatic Flip

Enables/Disables making the automatic meridian flip (AMF). On enabling SessionCraft will check the settings
and will give an error message in case of problem. Once you enable this option APT will check all the required
parameters for unsupported combinations. To change the settings below, you must uncheck this option.

When AMF is enabled a small blinking indicator will be displayed in the upper left corner of the Status panel to
show that SessionCraft is monitoring when flip has to be made.
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Flip Moment

Defines how many minutes before the celestial meridian passing to start the preparations for flipping the mount. On
process start it will determine the current position via taking a short image and plate solving it in PointCraft. It will
stop the tracking and guiding once the position is determined.

If an imaging plan is in progress and there is no time to take the next exposure before the flip moment occurring,
the imaging will be paused earlier and the additional time will not be counted as delay - it is an extra pause to
prevent collisions.

Flip Moment works in combination with Delay Flip Move and Delay is counted after meridian. See the notes.

If this value is negative this means that process will start after meridian passing. We suggest to investigate very
carefully the behavior of your mount before using negative values! Delay is counted after meridian passing
has to be unchecked.

Delay Flip Move

Defines how many minutes to wait before executing the actual scope move that will flip its position according to
the pier/tripod side. This delay can be counted from two moments - from the object passing through the celestial
meridian (Delay is counted after meridian is checked) or from the "Flip Moment" (Delay is counted after meridian is
unchecked).

During this delay the mount tracking and guiding are disabled. It gives time the object to move away from the
positions where scope can hit the pier/tripod or/and to guide poorly.

Example: Let have an object that will pass through celestial meridian in 22:15. Let have Flip Moment set to 5
minutes and Delay Flip Move set to 7 minutes.

No matter if Delay is counted after meridian is checked or not, Session Craft will stop the guiding and tracking in
22:10 (or earlier if there is no time to take scheduled image, but for simplicity we will ignore that extra pause). This
happens because we have set to stop 5 minutes before meridian reaching. Here are the two options depending on
Delay is counted after meridian state:

1. If Delay is counted after meridian is checked - Session Craft will wait 5 minutes the object to pass the
meridian in 22:15 after that will wait another 7 minutes and then will make the flip move. Total pause
5+7=12 minutes.

2. If Delay is counted after meridian is unchecked - Session Craft will wait 7 minutes after 22:10 and will
make the flip move. Meridian passing is in 22:15, so the move will happen just 2 minutes after the passing.
Total pause 7 minutes.

If we have running plan and there is extra pause, consider that Session Craft will be idle for X minutes till 22:10 is
reached then the above calculation will be applied.

We suggest to use Option 1 because it is easier to predict the flip move and measure the scope position limits. Be
careful, not all mounts can flip the scope pier/tripod position before object passing through the meridian! If the flip
move is started too early is possible to be ighored by the mount and to leave the scope from the old side
leading to crash! Option 1 ensures that object will be on position that can be safely used by all mounts and flip will
happens!

Option 2 gives possibility for optimizing the flip process and to take the maximum of your mount, but requires very
careful measurements of the Flip moment (positive or negative) and the needed delay. Also needs knowing if it

is possible to make flip move before meridian. Make experiments in various parts of the celestial meridian - from
Zenith to South and from Zenith to North keeping an close eye on the mount and in the messages in the Log panel.

In every moment you can press the Stop button in Session Craft, the Stop button in Gear Tab or press F12
key to stop all movements and actions.
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o Delay is after meridian passing

Defines how the pre-flip delay is measured. When checked the delay is measured from the object passing through

the celestial meridian. When unchecked the delay is measured from the Flip moment. See the Delay Flip Move
notes!

o Blind Solve

Defines what solving method to use for the first GoTo++ step after flipping the pier/tripod scope position. When
checked the first solving will be blind solving via ASPS. All other GoTo++ steps will use near solving via PS2. When
unchecked only PS2 will be used.

o Recalibrate

When checked will force PHD2 recalibration after the flip before guiding star. MGen does recalibration
unconditionally.

o Min Flip Duration

Defines the minimum time in seconds that your mount needs to change the pier/tripod side during usual meridian
flip. Shorter time will be considered as indicator of problem with flip and SessionCraft will stop all movements in
order to prevent damages.

Multi-Camera Operation

The APT installation creates in Windows Start menu 3 icons “APT”, “APT Camera 17, “APT Camera 2”. The first two can be used
if you have one camera. The last one is used when you want to use second camera. There is no limitation for cameras number
you can use. If you want more, create more shortcuts to APT.EXE and put the corresponding number as start parameter in the
"Target" field. The sample below shows the "Properties" of a shortcut and the number is set to 2
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For each camera APT will create folder “Camera X” into the Images Path folder set in Main settings tab. This will be root for
the image taken with this camera. Depending on the settings of Files Grouping other sub-folbers could be created.

Every APT instance has its own configuration. This means that you can have one set of settings for CCD/CMOS, other for
Canon EOS and third for Nikon camera, including different skins for easier camera management.

See the Select Camera Types section about details how to define the camera connections. When you are using multiple
cameras at the same time you can configure the APT Dithering System to synchronize the exposures and the dithering. See
Multi-camera Dithering / Synchronization section.

Tips & Tricks. Every time, turn ON your DSLR cameras in same sequence. The first turned on camera will be found from APT
as Camera 1, second will be found as Camera 2 and so on.

INDIGO / INDI and RaspberryPi (RPi)

Let start with the question "What are INDIGO and INDI?" They are platforms for controlling various astro gear under Linux and
MacOS like ASCOM is for Windows. Unlike ASCOM in INDIGO / INDI there is a server that communicates with the hardware
and client applications that connect to the server in order to use the hardware. The ideology is distributed by design which
means that server and client can be on different machines and can talk each other though internet or network.

INDIGO and INDI are independent open source projects developed by different teams, however currently they have good level
of compatibility, so application that can talk INDIGO protocol can connect to INDI server and the reverse. Each project has its
own advantages, but the most important is that they give another option for remote control of astro gear.

The next logical question is "Why INDIGO / INDI could be interesting for the Windows users?" The answer is the
RaspberryPi computer - small and cheap device that can run Linux, has small power consumption and can be used as INDIGO /
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INDI server. There are commercial devices based on RPi like ZWO ASIAir, QHYCCD StarMaster, StellarMate which are more
or less stock RPi computers with added additional software. However every RaspberryPi 3 Model B+ or newer, bought from
your favorite store will do the job!

So far so good, one can say :) "But I'm an Windows user and don't want to struggle with Linux!" Here come two solutions
- easy to install and pre-configured packages which give you INDIGO or INDI servers running out of the box - INDIGO Sky
and Astroberry. The instructions how to flash the images on SD card and to how make the device visible into your network are
really simple. If you have a commercial device and want to give a try of INDIGO Sky you can flash a new SD card.

Of course a more advanced user can configure and run INDIGO / INDI server on any Linux or MacOS machine, APT will not
see any difference!

Connecting to INDIGO / INDI Server

Once an INDIGO / INDI server is visible in the network you can make connection to it in APT via the INDIGO / INDI button in
Tools tab. Required is just to enter the server address, port and to click on the Connect button. See below for more information
on the other available configuration options.

Having a connection to the server you can access the available devices using Shift+Click on the corresponding "Connect"
button in the Camera or Gear tabs. APT will remember your selections and in next session you have just click on Connect.
There is no difference in device use via ASCOM or via INDIGO / INDI. You have the same features set available, same look
and feel!

Note: APT can connect to the INDI server of a ZWO ASIAir, QHYCCD StarMaster or StellarMate device, but an INDIGO server
can give better performance. Experiment and find which solution works best with your setup.

Status o

Enable connection o T
Mavigate Semver e
Enable Logging e o

o Status

Shows the status of the connection to INDIGO / INDI server.

o Enable connection

When enabled APT will try to make connection INDIGO / INDI server on APT starting.

o Address
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Defines the INDIGO / INDI server address. In could be and IP address or machine name like "indigosky" or
"astroberry".

o Port
Defines the INDIGO / INDI server port. The default value is 7624.

Nawgate Server

This button currently works when the connection is to INDIGO server. It navigates the INDIGO web interface for
managing the server. There you can load drivers, update the server, change exotic properties and more. Required
is installed browser Chrome or Chromium.

ConnectlDlsconnect

Connects/Disconnects APT to an INDIGO / INDI server. Detailed information about the process is displayed in the
Log panel. Once you see that "server is ready to use" you can connect to the available devices.

o Enable Logging

When enabled the INDIGO / INDI communication library will create a detailed log file (separate from the APT log)
per every session. Use this only in case of problem because the log files could become quite big.

Go to Logs

Opens the folder where the INDIGO / INDI logs are stored.

Keyboard shortcuts

Here is the list of the keyboard shortcuts defined in APT.

Alt+Space - Shoot Alt+S - Settings

Alt+H - Histogram Alt+G - Graphs

Alt+F - Focus Aid Alt+B - Bahtinov Aid

Alt+A - Auto Focus Aid Alt+M - Magnifier

Alt+K - Framing Masks Alt+X - Pixel Aid

Alt+0 - Object Browser Alt+l - FITS Headers

Alt+P - PointCraft Alt+V - Advanced GoTo

Alt+D - DSD Calculator Alt+Q - Sky Quality

Alt+L - LiveView AIt+E - Preview Effects

Alt+T - Cross Alt+W - Show in Map (Shift+Click on Recalc)
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F1 - Camera Tab F2 - Gear Tab

F3 - Tools Tab F4 - Img Tab
F5 - Plan Start/Stop F8 - Dithering Monitor
F7 - Dithering Settings F9 - Session Craft

F10 - USB Monitor

F12 - Stop GoTo, Automated Meridian Flip, Focuser,
Wheel and Rotator moves

Supported Hardware

There are no special requirements for the computer that can be used to run APT. Every computer that can run any version of
Microsoft Windows (XP or newer) is fine.

In the following sections are described the different hardware devices that APT can control.

Canon EOS Cameras
APT can control seven generations of Canon EOS cameras:
» Cameras with Digic 2 processor requires additional cable to control the shutter
» Cameras with Digic 3 processor requires additional cable only if there is need to make native mirror locking

» Cameras with Digic 4 and newer processor do not requires additional cable

Various information about the Canon EOS models including the built-in processor can be found in the Canon EOS Matrix
page on the APT site.

See Starting APT or Select Camera Type sections for details how to connect the camera.

Nikon Cameras
APT can control most of the Nikon DSLRs (except the models 3xxxx):
» The cameras D5000, D5100, D7000, D700, D300(S), D90, D80, D60, D40 require additional cable to control the
shutter/bulb exposure.
» The cameras D200, D80, D60, D40, D3S require APT to be started in Windows Vista SP2 compatibility mode.
To that right click on the APT icon, select Properties and go to Compatibility tab.
» The other Nikon models have no special requirements.

Various information about the supported Nikon models can be found in the Nikon Matrix page on the APT site.

See Starting APT or Select Camera Type sections for details how to connect the camera.

CCD/CMOS Cameras

APT can control several types of CCD/CMOS cameras:

* ASCOM Comepatible

* QSI cameras and wheels

* SBIG cameras and wheels

* Altair Astro cameras

» cameras connected to INDIGO / INDI server running on RaspberryPi, ASIAir, StarMaster, StellarMate, or Linux/
MacOS computer

See Starting APT or Select Camera Type sections for details how to connect the camera.
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Mounts
APT is able to control telescopes via ASCOM drivers and INDIGO / INDI. There is still no full native support for LX200 compatible
mounts (take a look on this ASCOM driver for LX200 mounts), but APT is able to send most of the LX200 commands through
the ASCOM connection which can be used to get better performance form the mount.

In order to use INDIGO / INDI is needed connection to server running on RaspberryPi, ASIAir, StarMaster, StellarMate, or
Linux/MacOS computer.

For information about mounts control see the Telescope section in Gear tab.

Meade mounts with AutoStar controller are automatically detected and additional control is provided by Meade section in Gear
tab.

If "LX200 compatible mount" option is enabled in Scope & Focuser settings tab APT will use the LX200 protocol through the
ASCOM connection.

The mount connection is used or can be used by the following APT features:
* PointCraft
« Dithering - direct mount control when there is no guiding - APT Dithering
» Meridian Flip Clock
+ Imaging plans - Scripts and Commands
* Use current position to create Custom item in Object Browser.

Focusers
APT is able to control focusers via ASCOM drivers, INDIGO / INDI as well as Meade focusers.

In order to use INDIGO / INDI is needed connection to server running on RaspberryPi, ASIAir, StarMaster, StellarMate, or
Linux/MacOS computer.

For information about focusers control see the Focuser section in Gear tab.

1000

For Meade focuser see "Meade Focuser" option in Scope & Focuser settings tab and Meade section in Gear tab.
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The focuser connection is used or can be used by the following APT features:
* Auto Focusing Aid
* Filter Wheel - Adjust Focuser
« Imaging plans (Scripts and Commands)

Filter Wheels / Drawer

APT is able to control filter wheels via ASCOM drivers, INDIGO / INDI as well as QS| and SBIG filter wheels through their
native interfaces. Also it is possible to track the usage of manual filter wheel or filter drawer.

In order to use INDIGO / INDI is needed connection to server running on RaspberryPi, ASIAir, StarMaster, StellarMate, or
Linux/MacOS computer.

See the following sections:
» To connect ASCOM filter wheel - Filter Wheel section in Gear tab.
» To connect SBIG filter wheel - Select Camera Type.
+ To describe the filters, offsets, gains - Filter Wheel settings tab.

Note: The QSI internal wheel is connected automatically on camera connection.

Note: For manual wheel or drawer there is need to switch the filter in the Gear tab once filter is manually changed. You can
configure APT to show reminder when filter has to be changed via Filter Wheel settings tab.

APT supports the usage of the focus offset and gain per filter. If offsets are entered, there is connection to a Focuser and
"Adjust Focuser" in Gear tab is enabled, the focuser position will be tuned on every filter change. If gain value is entered it
will be used when the filter is in front of the camera.

Note: It is recommended to describe the filters in the Filter Wheel settings tab rather than in the ASCOM / INDIGO / INDI driver
in order to get better behavior and experience!

The filter wheel connection is used or can be used by the following APT features:
* Imaging plans

« Imaging plans (Scripts and Commands)
* CCD Flats Aid

Rotators

APT is able to control rotators that have ASCOM drivers.

See the Rotator section in Gear tab.
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The rotator connection is used or can be used by the following APT features:
* Object Browser
+ Object Calculator
* PointCraft
* Planetarium

Temperature / Humidity Sensors
APT is able to use various external temperature and humidity sensors.
Here are the main types:
» Temper and TemperHum sensors made by PCSensor.com
» USB DewPoint made by usb-foc.us

* Any ASCOM / INDIGO / INDI compatible focuser with temperature sensor
» The AstroHub and JoloFocuser open source projects - support for both temperature and humidity.

The usage of the first two types should be configured in Temperature & Sky settings tab. The other two option are
automatically detected and used on focuser connection.

See the section External Sensors for more information on how to use the temperature and humidity readings.

The sensors are used or can be used by the following APT features:
» Temperature/Humidity/Dew Point displaying
» Temperature/Humidity/Dew Point graphs
» Temperature/Humidity use for name parts
» Refocus notifications on temperature change
» Dew Point closing notifications

Sky Quality Meters

APT is able use external sensors to measure the sky quality. Supported are Unihedron and compatible Sky Quality Meter
devices.

See the section External Sensors for more information on how to use the sky quality readings.

There is need to configure your device from the Temperature & Sky settings tab.

Canon/Nikon Shutter Cables

The shutter cables are additional PC operated devices. They are needed for Canon EOS cameras with Digic 3 processor in
order use mirror lock feature. For Digic 2 camera such cable is need to make both - to use mirror lock feature and to control
the shutter. Also some Nikon models need such cable to control bulb exposure.

There are three main types of shutter cables and they are supported by APT:
Shoestring Astronomy DSUSB/DSUSB2 - Canon and Nikon
Shoestring Astronomy DSUSB/DSUSB2 long exposure shutter controller. Once a DSUSB or DSUSB2 option is

selected from the “Long exposure control” list, APT will try to make a connection to the controller. More information
about DSUSB/DSUSB2 can be found on http://store.shoestringastronomy.com/products_ds.htm

Serial Cable - Canon

Serial control cable (RS232) connected to COM port or to USB (with appropriate Serial to USB converter). If you don't
want to make such cable yourself, here is a vendor.
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Hap Griffin Astro-Cables - http:/imaginginfinity.com/astrocables.htm

Two links (of course there are more in The Net) with "Do-It-Yourself" instructions:
http://www.beskeen.com/projects/dsir_serial/dsIr_serial.shtml
http://www.covingtoninnovations.com/dslr/CanonRelease.html

Serial Cable - Nikon

Serial control cable (RS232) connected to COM port or to USB (with appropriate Serial to USB converter). Currently
there is no way to buy a ready to use cable for Nikon camera. Here is a discussion how to make it yourself

https://www.cloudynights.com/topic/457536-usb-corded-shutter-control-for-nikon/

Biula Audio trigger - Canon

Biula Audio trigger uses the audio port and special cable control the camera shutter. Instructions how to build this
cable can be found here: http://www.ideiki.com/astro/biula_audio_trigger.pdf
Note - make sure that the audio volume is set to maximum!

KMtronic Cable

Starting from version 3.50, APT supports a new type of Canon/Nikon shutter cable. It is very easy to make, requires

no electronics skills and no soldering! Other advantage is that there is no need of Serial-to-USB adapter, the cable is
connecting directly to an USB port. Once the cable is ready, the option KMTronic based shutter cable in Main Settings tab
has to be enabled and the COM port should be selected in the Long Exposure Control.

You need three main things:

1. KMTronic USB Relay Board (https://www.kmtronic.com/usb-relays.html/usb-relay-controller-one-channel-pcb.html)
2. The cheapest possible shutter control for your camera
3. USB cable

The other things you will use are: something to cut wires, isolation band and a screwdriver.
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Step 1

Cut the remote controller cable near to the button in order to get longer cable attached to the connector. Remove the
isolation from the there wires and connect the cable to the camera. Turn the camera on. Start connecting the wires in a pair
to see which pair will shoot an image (in this case it is the Blue and the White). There is no risk to damage anything! This
is the same what the remote controller does ;)
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Step 2

Cut the unneeded wire and isolate it with some band. You can use the plastic bag - cut one of the ends like on the picture
( smaller cut would be better :) ). If there is need shorten a bit the not isolated parts of the wires and connect the them to
connectors C and NO (leave NC free) using the screwdriver. The green LED will be turned on during exposure so you may
want to be visible...

Nikon specific: The remote controller has 3 wires Yellow, White, Red (R) and two positions - half press to focus and

full press to take image. It makes contact between Yellow and White to focus and all three for image. So the working
configuration is to connect White+Red to C, Yellow to NO. Your remote controller could have other wire colors, but the logic
should be same.
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*  USB Rel ay Board

Step 3

Isolate the board somehow. On the picture is given one option. Other is to use white isolating band (white in order to see the

green LED) and wrap both cables and the board in one package. If you have suitable plastic box, it can do the job...
Do no use metal box!

GPS devices




APT is able talk with various GPS receiver devices sometime called "GPS dongles". All devices that can talk NMEA protocol
and expose a COM port are supported. Also there are various Android and iOS apps than export the smartphone's location
as NMEA device via Bluetooth.

See the section Extra Devices for information how to configure the connection to a GPS dongle.

The coordinates from a GPS dongle is used by by the mount, for the Darkness Clock and DSD Calculator.
Flat Box Controllers / Panels

APT is able control some devices for taking flats

» Lacerta - FBC (Flat Box Controller)
» Pegasus Astro - FlatMaster
* ArteSky - Flat Box USB

See the section Extra Devices for information how to configure the connection to FBC, FlatMaster or FlatBox.

The connection to FBC is used by CCD Flats Aid and during Flats Type imaging plan execution (in both DSLR and CCD/
CMOS modes). APT synchronizes the flat panel flashing with the running exposure.

Old Links

There are several translations of old versions of the User's Guide. They are quite different from this guide, but one can find
them useful.

PwkoBoactBoTo Ha bbunrapcku
APT-Benutzerhandbuch
Guida utente

Guide non officiel en frangais
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